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วิธีการสอน  :  บรรยาย สาธิต และใหฝกปฏิบัต ิ
 
หัวขอสําคัญ :  1) งาน 2D Animation และ ข้ันตอนในการผลิต 

2) หลักการพื้นฐาน 12 ขอ ของการทํา Animation 
3) สิ่งที่ควรพจิารณาในการออกแบบเนื้อเรื่อง 
4) โครงเรื่องและการแบงสวนเนือ้หาของเรือ่ง 
5) พื้นฐานการเขียน Script-Screenplay 
6) ความหมายของคําศัพทพื้นฐานในการเตรียมงานแอนิเมชนั 
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เรียนรูกระบวนการสรางงาน 2D Animation  
 
Animation แอนิเมชั่น 

แอนิเมชัน่ (animation นิยมอานในภาษาไทยวา แอ-น-ิเม-ชั่น) หมายถึง การสรางภาพเคลื่อนไหวโดยการฉาย
ภาพนิ่งหลายๆ ภาพตอเนื่องกันดวยความเร็วสงูการใชคอมพิวเตอรกราฟกสในการคํานวณสรางภาพจะเรียกการสราง
ภาพเคลื่อนไหวดวยคอมพิวเตอรหรือ คอมพิวเตอรแอนเิมชนั หากใชเทคนิคการถายภาพหรือวาดรูป หรือ หรือรูปถายแต
ละขณะของหุนจําลองที่คอย ๆ ขยับ จะเรียกวา ภาพเคลื่อนไหวแบบการเคลือ่นที่หยุด หรือ สตอปโมชัน (stop motion) 
โดยหลกัการแลว ไมวาจะสรางภาพ หรอืเฟรมดวยวิธีใดก็ตาม เมื่อนําภาพดังกลาวมาฉายตอกันดวยความเร็ว ตั้งแต 16 
เฟรมตอวินาทีขึ้นไป 

สรปุ Animation มีความหมายวา “ทําใหมีชีวิต” โดยการสรางสรรค ลายเสนและรปูทรงที่ไมมีชีวิต ใหเคลื่อนไหว
เกิดมีชีวิตข้ึนมาได” 
 
ชนิดของแอนิเมชั่น 

ชนิดของแอนิเมชั่นสามารถแบงออกไดเปน 3 ชนิดคือ  
 
- Drawn Animation คือ แอนิเมชั่นที่เกิดจากการวาดภาพหลายๆพันภาพ  แตการฉายภาพเหลานั้นผานกลอง

อาจใชเวลาไมกี่นาท ี
ขอดีของการทําแอนเิมชั่นชนิดนี้คือ มีความเปนศลิปะ  สวยงาม  นาดูชม   
ขอเสีย คือ ตองใชเวลาในการผลิตมาก  ตองใชแอนิเมเตอร จํานวนมากและตนทุนกส็ูงตามไปดวย  
- Stop Motion หรือเรียกวา Model Animation เปนการถายภาพแตละขณะของหุนจําลองที่คอยๆขยับ 

อาจจะเปนของเลน หรือ อาจจะสรางตัวละครจาก Plasticine วัสดุที่คลายกับดินน้ํามันโดยโมเดลที่สรางขึ้นมาสามารถ
ใชไดอีกหลายครัง้ และยังสามารถผลิตไดหลายตัว ทําใหสามารถถายทําไดหลายฉากในเวลาเดียวกัน  แตการทํา Stop 
Motmotionนั้น ตองอาศัยเวลาและความทุมเทมาก เชน การผลิตภาพยนตรเรื่อง James and the Giant Peach 
สามารถผลิตได 10 วินาทีตอวันเทานั้น วิธีนี้เปนงานที่ตองอาศัยความอดทนมาก 

- Computer Animation ปจจุบันมีซอฟททีส่ามารถชวยใหการทําแอนิเมชั่นงายขึ้น เชน โปรแกรม Maya, 
Macromedia และ 3D Studio Max เปนตน วิธีนี้เปนวิธีทีป่ระหยัดเวลาการผลิตและประหยัดตนทุนเปนอยางมาก เชน 
ภาพยนตรเรือ่ง Toy Story ใชแอนิเมเตอรเพียง 110 คนเทานั้น 
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ขั้นตอนการผลิตการตูน Animation 
 
ขั้นตอนการผลิตงานสําหรับทําการตูนแอนเิมชั่นโดยทั่วไปแลวมีพื้นฐานดังตอไปนี ้
 

1. ไอเดีย ( Idea ) หรือบางคนอาจใชคําวา แรงบันดาลใจ ( Inspiration )ซึ่งจะเปนสิง่แรกที่เราสรางสรรค
จินตนาการและ ความคิด ของเราวาผูชมของเราควรเปนใคร อะไรทีเ่รา ตองการ ใหผูชมทราบ ภายหลงั จากที่ชมไปแลว 
ควรใหเรือ่งทีเ่ราสรางออกมา เปนสไตลไหน ซึง่อาจจะมาจาก ประสบการณ ที่เราไดอานไดพบเห็น และสิ่งตางๆ รอบตวั 
เปนตน 

 
2. โครงเรื่อง ( Story ) โครงเรื่องจะประกอบไปดวยการเลาเรื่องที่บอกถึงเนื้อหาเรื่องราวทกุอยางใน ภาพยนตร

ทั้งตัวละคร ลําดับเหตุการณ ฉาก แนวคิด และที่สําคัญเราควรพิจารณาวาการเลาเรื่องควรจะมกีารหักมุมมากนอยเพียงไร 
สามารถสรางความบันเทิงไดหรือไม และความนาสนใจนีส้ามารถทําใหผูชมรูสึกประทับใจ จนสามารถระลกึในความทรงจํา 
และทําใหคนพูดถงึ ตราบนานเทานานหรือไม  

 
3. สคริปต ( Script ) เปนขั้นตอนในการจับใจ ความสําคัญของเนื้อเรื่องใหออกมาในแตละฉาก พรอมทัง้กําหนด

มุมกลอง เทคนิคพิเศษ รวมถึงระยะเวลาของการเคลือ่นไหวโดยใหรายละเอียดตางๆ เชนผูจัดทําเสียงดนตรี (Musidcians) 
เสียงประกอบ ( Sound Effects ) จิตกรในการวาดหรือนักออกแบบตัวละคร ( Artists ) และแอนเิมเตอร ( Animators ) 
สรางภาพใหกับตัวละคร( Characters Design ) ขั้นตอนนี้เปนการออกแบบและกําหนดลักษณะนิสัย บุคลิกบทบาทตางๆ 
และทาทางการเคลื่อนไหว ใหกับตัวละคร โดยอาศัยองคประกอบพื้นฐานของการออกแบบ ไดแก ขนาด ( Size )  
รูปทรง ( Shape ) และสัดสวน( Proportion ) 

 
4. บอรดภาพน่ิง หรือที่รูจักกันทั่วไปวา สตอรบีอรด ( Storyboards ) เปนการใชภาพในการเลาเรื่องใหได

ครบถวน ทั้งเหตุการณทีเ่กิดข้ึนอารมณในเหตุการณน้ันๆ สหีนา ทาทาง ลักษณะตางๆ ของตัวละครบอกถึงสถานที่ และ
มุมมองของภาพ ซึ่งภาพวาดทั้งหมด จะเรียงตอเนื่องเปนเหตุผลกัน เมื่อดูแลวสามารถเขาใจเรื่องราวที่เกิดขึ้นไดอยาง
ชัดเจน 
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5. บันทึกเสียง ( Sound Recording ) หลังจากที่ไดออกแบบตัวละครและสรางสตอรีบอรดเรียบรอยแลว ก็จะ

เขาสูขั้นตอนของการอัดเสียง ซึ่งเปนสิ่งทีห่ลกีเลี่ยงไมได บางสตูดิโออาจจะเริ่มตนดวยการอัดเสียง Soundtrack กอน ซึ่ง
การอัดเสียงประกอบแอนิเมชันจะแยกออกเปนประเภทของเสียงโดยหลักแลวจะม ีดังนี้คือ   

– เสียงบรรยาย ( Narration ) เปนสวนสําคัญในการสรางความเขาใจ เปนการปูพื้นฐานใหกบัผูชมวาเรื่องเปน
อยางไร และยงัเปนการเชื่อมโยงใหเรื่องราวติดตอกันดวย 

– บทสนทนา ( Dialogue ) เปนหลักการหนึ่งในการสื่อเรือ่งราวตามบทบาทของตัวละคร เปนการสื่อ
ความหมายใหตรง ตามเนื้อเรือ่งทีส่ั้น กระชับ และสัมพันธกบัภาพ 

– เสียงประกอบ ( Sound Effects ) เปนเสียงที่นอกเหนอืจากบรรยาย เสียงสนทนา เสียงประกอบจะทําใหเกิด
รูสึก สมจริงสมจัง มจีินตนาการเชน เสียงระเบิด เสียงฟารอง เปนตน ราวกับไดเขาไปอยูในเหตุการณหรือสถานที่นั้นดวย 

– ดนตรีประกอบ ( Music ) ชวยสรางอารมณของผูชมใหคลอยตามเนือ้หาและปรับอารมณของผูชมระหวางการ
เชื่อมตอของฉากหนึ่งไปยงัอีกฉากหนึ่งไดดวย 

 
6. ตรวจความเรียบรอยของแอนิเมชั่น ( Animatic Checking ) Animatic คือ การนําภาพที่วาดโดยชางศิลป

ตามแนวคิด สรางสรรคมาประกอบกันเขาเปนเรื่องราวพรอมเสียง ประโยชนของการทํา Animatic คือ เวลานําเสนองาน
งานแอนิเมชั่นเบื้องตน จะไมหยาบเกินไปสามารถสือ่แนวคิดหลักใหญๆ  ชวยใหนักสรางสรรคสามารถทบทวนแนวความคิด
กอนที่จะผลิตเปน ภาพยนตรทบทวนกรอบเวลา การดําเนินเรื่องราวเหตุผลทีส่ามารถอธิบายไดอยางตอเนื่อง สามารถ
ปรับแตงเพิม่เติมภาพหรอื ตัดเขาสูฉากอื่นไดทันท ีเพื่อใหไดงานที่มีอารมณจงัหวะ และองคประกอบที่ใกลเคียงกอนการ
ทําแอนิเมชั่น 

 
7. ปรับแตงชิ้นงาน ( Refining the Animation ) หลงัจากที่เราไดทํา Animatic แลวจะตองนําไปปรับปรุง

ตกแตงแกไขสตอรบีอรดและขั้นตอนอื่นๆ โดยละเอียด เชน ลักษณะงานศิลป (Character Art) ฉากหลัง (Background) 
เสียง (Sound) เวลา (Timeing) และสวนประกอบอื่นๆ จนกระทัง่เขาสูการผลิตงานแอนิเมชั่นตอไป โดยการวาดเสนดวย
คอมพิวเตอร การลงสีฉากและตัวละคร ภาพประกอบและเสยีงตอไป (Composting) ซึ่งในอดีตการปรบัเปลี่ยนแผนงาน
การทํา ภาพยนตรการตูน มีคาใชจายสูง แตในปจจบุันนี้ไดนําระบบดิจิตอลคือคอมพิวเตอรนั่นเองเขามาชวยในการ สราง
งานแอนิเมชั่นทําใหประหยัด คาใชจายไดมากข้ึน 
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วิธีการสรางแอนิเมชัน 

ภาพแสดงตัวอยางการเคลือ่นไหวของภาพแอนิเมชัน 

 
 

แบบเฟรมตอเฟรม (Frame By Frame)  
เปนการนําภาพมาใสไวในแตละเฟรมและทําการกําหนดคียเฟรม (คียเฟรม คือ เฟรมที่ถกูกําหนดใหมีการ

เปลี่ยนแปลงของวัตถุเพือ่สรางการเคลื่อนไหว) ถากําหนดคยีเฟรมมีชองวางหางกันเกินไป การเปลี่ยนแปลงของภาพที่
ปรากฏออกมาจากเฟรมหนึ่งไปยงัอีกเฟรมหนึง่ก็จะชาลง การสรางเคลื่อนไหวแบบ Frame By Frame เหมาะสําหรบัภาพ
แอนิเมชั่นที่มกีารเปลี่ยนแปลงแบบรวดเร็ว หรืองานที่ซบัซอนมากๆ 

แบบทวีนแอนิเมชั่น (Tween Animation)  
Tween (ทวีน) ยอมาจากคําวา Between ซึ่งแปลวา “ระหวาง” การสรางภาพแบบ Tween เปนการกําหนดคีย

เฟรมเริ่มตนและคียเฟรมสุดทาย จากนั้นใหโปรแกรมสรางความเปลี่ยนแปลงระหวางเฟรมโดยอัตโนมัติ  แบงออกไดเปน 2 
ประเภท คือ 

Motion Tween หรอื Motion Path เปนการเคลื่อนไหวทีม่ีการกําหนดการเคลือ่นที่ หมุน ยอ หรือขยายไปตาม
เสนที่วาดไว โดยที่รูปทรงวัตถุไมมีการเปลี่ยนแปลง นิยมใชมากที่สุด 

Shape Tween เปนการสรางภาพเคลื่อนไหวที่มีการเปลี่ยนแปลงรูปทรงของวัตถุ จากรปูทรงหนึ่งไปเปนอกี
รูปทรงหนึ่งโดยสามารถกําหนด ตําแหนง ขนาด ทิศทาง และสีของวัตถุในแตละชวงเวลาตามตองการ นิยมใชกับรูปวาด
เทานั้น  การสรางภาพเคลื่อนไหวแบบ Tween ชวยทําใหไฟลมีขนาดเล็กลง และมีการเคลือ่นไหวที่มีความนุมนวล
มากกวาแบบ Frame By Frame 

แบบแอ็คชันสคริปต (Action Script)  
เปนภาษาโปรแกรมที่นํามาใชเพือ่เพิม่ประสทิธิภาพในการทาํงานของระบบ และสามารถโตตอบกับผูใชงานได 

โดย Action Script จะถูกนํามาใชเมื่อมีการกระทําเกิดข้ึน ซึ่งเรียกวา เหตกุารณ (Event) เชน การคลิกเมาส หรือกด
คียบอรด โดยจะนํา Action Script มาใชโตตอบกับ Event นั้น เชน สั่งใหแสดง Movie เปนตน Action Script ไม
สนับสนุนออบเจ็กตบางตัวที่ระบุอยูบน Browser เชน Document, Window, Anchor, Unicode เปนตน 
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หลักพ้ืนฐาน 12  ขอของแอนิเมชั่น 
 

1. Timing and Spacing 
แอนิเมชั่น หมายถึง การสรางภาพเคลื่อนไหวโดยการฉายภาพนิ่งหลายๆ  ภาพตอเนื่องกันดวยความเร็วสงูโดย

หลักการแลว  ไมวาจะสรางภาพ  หรือเฟรมดวยวิธีใดก็ตาม  เมื่อนําภาพดังกลาวมาฉายตอกันดวยความเร็วต้ังแต  
16 เฟรมตอวินาทีขึ้นไป เราจะเห็นเหมือนวา  ภาพดังกลาวเคลื่อนไหวไดตอเนื่องกัน  ทั้งนี้เนื่องจากการเห็นภาพติดตา 
โดยภาพแตละภาพนั้นมีหลักการพื้นฐานอยางนอยสองสวนคือ ระยะหางระหวางภาพตอภาพคือ Spacing และ 
ระยะเวลา Timing 

ตัวอยาง Timing and Spacing 
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2. Squash and Stretch 
Squash  and  Stretch  คือการเปลี่ยนแปลงมวลของ  object  ซึ่งในแอนิเมชั่นน้ันไมไดหมายความวาจะเปลี่ยน

กับของแข็งไมได  เราสามารถใชหลักการ  Squash  และ  Stretch  กับของแข็งไดโดยการเปลี่ยน Pose  และ Acting  ก็
ได  แตใจความสําคัญของการใส Squash และ Stretch ใหกับแอนิเมชั่นนั่น คือ ให “แครูสึกแตอยาใหเห็น” เพื่อผลตอ
งานที่ตองการใหเนน Actionหรือการเคลื่อนไหวในชวงขณะเวลาหนึง่ 

 
ตัวอยาง Squash and Stretch 

 

 
 

 
 
 
 
 
 
 
 

 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

8

8 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ทฤษฎี) 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
หัวขอที่ 1 

 
3. Anticipation 
Anticipation  เรียกกันอยางเขาใจกันเองในภาษาไทยวา “ทาเตรียม” เปนสวนทีส่รางความสัมพันธใหคนดู

ตาม  action  หรือ  pose  ที่เราตองการจะเลาใหทนั  โดยเราตองใส anticipation ไปกอน pose action  ซึ่ง
anticipation อาจจะเปนทาทางที่ชัดเจนอยางการเงื้อไมกอลฟกอนสวิง หรือสิง่เล็กๆ นอยๆ อยางการกระพรบิตากอนหัน
หนาก็ได 

ตัวอยาง Anticipation 
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4. Staging  
Staging คือ การกํากบัภาพอยางไรใหเขาใจ  Idea  ของภาพวาอยูที่ไหนภายใตกรอบสีเ่หลี่ยม pose ของตัว

ละครจะตองชัดเจนใหคนดูรับรู Idea  ในการเลาเรื่องในภาพนั้นใหได สิ่งทีเ่ปนประโยชนในการทํางานในสวนน้ีก็จะมี
หลักการจัดองคประกอบของภาพ (composition) เขามาเกีย่วของดวย 
 

ตัวอยาง Staging  
 

 
 

การกํากับภาพท่ีไมดี                                                   การกํากับภาพท่ีด ี
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5. Follow Through and Overlapping Action 
Follow Through และ Overlapping Action นั้นเราใสไปเพื่อใหแอนเิมชั่นในคัทนั้นๆ เกิดความนาเชื่อถือโดย

วัตถุบางอยางจะมีแรงเฉื่อย + แรงโนมถวงเขามาเกี่ยวของ รวมถึงลําดบัในการเคลื่อนไหวของรางกายทีเ่ริม่และจบไม
พรอมกัน  

Follow Through คือ การเคลื่อนไหวในสวนทีเ่ราไมตัง้ใจใหขยับ เชน ผาคลุม, ผม,หาง, กระเปา 
Overlapping  คือ Action หลกัแตวาแตละสวนของรางกายเริ่ม + จบไมพรอมกันซึง่เปนสวนทีเ่ราตั้งใจ และเปน

หนาที่ของแอนนิเมเตอรตองใสเขาไปดวยตัวเอง 
ตัวอยาง Follow Through and Overlapping Action  
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6. Arcs 
Arcs  คือ เสนทางของ  action  จากจุดหนึง่ไปสูจุดหน่ึงวาไปอยางไร  มีทิศทางอยางไร  ถือวาเปน  เสนทางของ

การเคลื่อนไหวโดยเราจะใหความสําคญักับชวงกลางระหวางจุดสองจุด ของ action นั้น โดยสราง Arcs หรือวิถีโคงใหกบั
เสนทางการเคลือ่นไหว ซึ่งจะทําใหแอนเิมชั่นของเราดลูื่นไหลและเปนธรรมชาตมิากยิง่ขึ้น 
 

ตัวอยาง Arcs 
 

 
 

 
 

เสนทางการเคลือ่นไหวดูไมเปนธรรมชาต ิ                  เสนทางการเคลือ่นไหวดูเปนธรรมชาติ 
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7. Exaggeration  
Exaggeration หลาย ๆ คนอาจจะคิดวา คือ การแสดงที ่over action แตจริง ๆ แลว คือการเนนใหแอนิเมชั่น

ของเราเห็นชัดเจนยิ่งขึ้น ไมวาจะเปนทา pose , อากัปกริยา, หรืออารมณของตัวละคร 
 

ตัวอยาง Exaggeration  
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8. Slow in and Slow out 

 Slow in and Slow out  คือ อัตราเร็ว อัตราเรง เชน ในกฎของฟสิกส เมื่อโยนลูกบอลขึ้นไปในอากาศ จังหวะ
แรกที่ปลอยลูกบอลไป มีอัตราเร็วสูงสุด (ซึ่งลูกบอลยงัไมขึ้นตําแหนงสงูสุด) ลูกบอลจะคอยๆ ลดความเร็ว จนเหลือ
อัตราเร็วเปนศูนย (ซึ่งก็คือ ลูกบอลอยูสูงสุด) จากนั้นลูกบอลกจ็ะตกลงมา โดยแรงโนมถวง จะเห็นไดวา ชวงจังหวะที่ลูก
บอลวิ่งขึ้นไปบนอากาศ แตละวินาทีที่ผานไป จะวิ่งไปในระยะทางที่ไมเทากัน หรือ ถาใหใกลตัวหนอย ก็สังเกตแขนของคน
ที่เดินไปมา จังหวะที่แขนเคลื่อนที่ไปขางหนาสุด หรือขางหลังสุด แขนจะเคลื่อนที่ชาลง เรือ่งของ Slow in และ 
Slow out  จะชวยอยางมากในเรือ่งของการบอกน้ําหนักของสวนตางๆ หรือเรื่องของแรงเหวี่ยง  

 
ตัวอยาง Slow in and Slow out 
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9. Secondary Action 
สวนที่แสดงเขาไปเสรมิการแสดงหลัก เพื่อใหงานดูมีชีวิตแตการเลาเรื่องตองไมเปลี่ยนไปอยางเชนนักแสดงกําลงั

อานหนังสือพิมพแตก็ดื่มกาแฟไปดวย การอานหนงัสือพิมพ คือ primary action สวนการดืม่กาแฟคือการแสดงรอง
หรือ secondary action นั่นเอง 

 
ตัวอยาง Secondary Action 
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10. Solid Drawing   
หลักการในขอนี้มพีื้นฐานมาจาก  traditional  2D animation  โดยกอนที่ศิลปนจะลงสีใหกับภาพแตละภาพ

จะตองมีการตัดเสนกอนเพือ่ใหไดเสน  outline  ที่สวยงามชดัเจน  ในข้ันตอนน้ีจําเปนตองอาศัยทักษะหรือฝมอืของศิลปน
เปนอยางมาก  แตที่สําคัญยิง่ไปกวานั้นก็คือไมวาจะใชศิลปนกี่คนก็ตาม  ก็ตองพยามสรางงานทีม่ีลายเสนที่ตอเนื่องและคง
คุณภาพใหเหมือนกันตลอดทั้งเรื่องเสมือนเปนภาพวาดจากคน ๆ เดียว      

 
ตัวอยาง Solid Drawing 
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11. Straight Ahead and Pose to Pose  
ในการวาดภาพแตละภาพ เฟรมแตละเฟรม เพื่อนํามาเรียงตอกันแลวใหเกิดเปนภาพเคลื่อนไหวนั้นจะมีวิธีการ

ทํางานอยูสองวิธีคือ Straight Ahead กับ Pose to Pose ซึ่งมีการทํางานที่แตกตางกันดงันี ้
Straight Ahead จะเปนการวาดภาพจาก เฟรมหนึง่ไปอีกเฟรมหนึ่งโดยเรียงจากภาพเริ่มตนไปจนจบ 
Pose to Pose จะเปนการวาดเฉพาะคีย Pose หลักเปนชวง ๆ ใหเสรจ็เรียบรอยกอน จากนั้นจงึคอยมาวาดภาพ

ที่อยูระหวางคีย Pose หลัก ทีหลังหรอืที่เรียกกันวา in between นั่นเอง  
การทํางานแบบ Pose to Pose นิยมนํามาใชกับcomputer animationเพราะทําใหงายตอการแกไขและชวยลด

เวลาในการทํางานในบางสวนเนือ่งจากคอมพิวเตอรจะชวยคํานวณ ภาพ in between โดยอัตโนมัต ิ
ตัวอยาง Straight Ahead and Pose to Pose 
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12. Appeal  
Appeal หมายถึง รสนิยม, เสนห หรือความหลงทีเ่มื่อดูแลวทําใหเชื่อนั่นเอง ซึง่อาจจะเริ่มตัง้แต การออกแบบ 

ตัวละคร,นิสัย,ลักษณะทาทาง,บุคลิกทีส่ื่อออกมาใหเราไดรูสกึคลอยตามหรือเชื่อวาตัวละครนั้นมอียูจริง  
 

ตัวอยาง Appeal  
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สรุปหลักพ้ืนฐาน 12 ขอของแอนิเมชั่น จากที่อธิบายมากอนหนานีส้ามารถสรุปหลกัพื้นฐานและแสดงภาพประกอบได
ดังตอไปนี ้
 

1) Timing and Spacing:  
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2) Squash and Stretch:  

 
 

3) Anticipation:  

 
 

4) Staging:  
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5) Follow through and Overlapping action:  
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6) Arcs: 
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6) Arcs: 
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7) Exaggeration:  
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8) Slow in and Slow out:  

 

 
 

 

 
 
 
 
 
 
 

 
 
 
 

 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

23

23 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ทฤษฎี) 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
หัวขอที่ 1 

 
8) Slow in and Slow out:  

 

 
 

 

 
 
 
 
 
 
 

 
 
 
 

 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

24

24 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ทฤษฎี) 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
หัวขอที่ 1 

 
9) Secondary Action:  
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10) Pose to Pose and Straight ahead action:  
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10) Pose to Pose and Straight ahead action:  
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11) Solid Drawing:  

 

 
 

12) Appeal:  
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การเขียน Script เบือ้งตน  
 
สิ่งที่ควรรูกอนเริ่มคิดเน้ือเรื่อง 

กอนที่จะลงมือสรางการตูนแอนเิมชัน่สกัเรื่องหนึ่ง สิง่ทีส่ําคญัคือ การหาเนื้อหาเรือ่งราวที่สามารถดึงดูดจิตใจของ
ผูชมใหเกิดคําถามขึ้นใจใจวา “อะไร ? อะไรละที่จะเกิดข้ึนตอไป?” หลายคนมักสงสัยและถามวา เราจะหาเนื้อเรือ่งมาจาก
ไหนด.ี.. 

คําตอบมีอยู 2 ขอ คือ 
- จากประสบการณที่เราพบเห็นในชีวิตประจําวัน 
- จากแรงบันดาลใจและไอเดีย 
 

          เน้ือเรื่องจากประสบการณในชีวิตประจําวัน 
          เนื้อเรื่องจากประสบการณในชีวิตประจําวัน สามารถหาไดจากประสบการณที่เราพบเห็นในชีวิตประจําวัน 
อยางเชน การอานหนังสือ ชมภาพยนตร ดูรายการโทรทัศนตางๆ หรอืแมกระทัง่การฟงดนตรกี็ชวยใหเราถายทอด
จินตนาการตางๆ ออกมาได ไมมีสิ่งใดทีม่ีคามากไปกวาความคิดเริ่มแรกที่นกึถึง ทันทีที่ไดไอเดียแลวใหรีบขีดเขียนลงบน
กระดาษทันท ีเพราะจะชวยใหจินตนาการของเราสามารถดําเนินตอไปไดอยางงายดาย 
          ตรงนี้ถาสงัเกตกันดีๆ แลวกจ็ะเห็นวา เนื้อเรื่องแบบที่กลาวไววา “จากประสบการณในชีวิตประจําวัน” มีมานาน
มากแลว คือ ไมวาอะไรก็เปนเนื้อเรื่องไดทั้งนั้นยกตัวอยางตัง้แตสมัยไมมีตัวหนังสือ อยางพวกการเลาเรื่องดวยภาพตาม
หลุมศพฟาโรห หรือการเลาดวยภาพในผนังถ้ําที่ถูกคนพบมามากมาย โดยการเลาเรื่องพวกนี้อาจจะเปนแคกจิกรรมเล็กๆ 
อะไรสกัอยาง เชน พิธีศพ ไปจนถึงการเขียนเปนตํานานหรือพงศาวดาร ลงในหนงัสอืเกบ็ไวใหคนรุนหลงัไดเอาไวอานและ
ศึกษากัน นี่ก็เปนเนือ้เรื่องไดแลว ใชไหมละครับ 
 
         เน้ือเรื่องจากแรงบันดาลใจและไอเดยี 

เนื้อเรื่องจากแรงบันดาลใจและไอเดีย   ไอเดีย หรือ แนวความคิด (Concept) เปนการสรางจินตนาการที่ขึ้นอยูกับ
ประสบการณรอบๆ ตัวเราสามารถหาแนวคิดของการเขียนเนื้อเรื่องไดจากการอานหนังสือ ดูภาพยนตร ดูทีว ีหรือ
แมกระทั่งการฟงดนตร ีซึ่งจะทําใหเราไดเริม่ตนความคิดสรางสรรคตางๆ จากการชมและการฟงมากๆ เมื่อไรที่เริ่มคิดไม
ออกใหเราลองปรบัเปลี่ยนเรื่องราวแบบธรรมดาๆ หรือเปรียบเทียบจากแนวคิดเดิมๆ ของภาพยนตรที่ชมก็ได 
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สิ่งที่ควรพิจารณาในการออกแบบเน้ือเรือ่ง 

 
1. จะสื่อสารแบบไหน   
เราควรรูวาเรื่องทีเ่ขียนข้ึนตองสือ่สารใหผูชมรบัรูไดวาจะออกมาในรูปแบบใด เพื่อเปนการกําหนดอารมณของ

ผูชม และกําหนดทิศทางความคิดของเรา เชน ถาเราจะเขียนบทในแนวตลกขบขัน เรื่องนั้นควรประกอบดวยเหตุการณ
ใดบาง ในแนวสืบสวนควรจะมีความลกึลบัซบัซอนอยางไรด ี

สําหรับการกําหนดรปูแบบหรอืสไตลของภาพยนตรตางๆ มักอาศัยเกณฑทางดานการนําเสนอเนื้อหาและอารมณ
เปนตัวกําหนด โดยแบงออกเปนประเภทตางๆ หลกัๆ ไดดังนี ้
Action movie (ภาพยนตรแอคชั่น) 

Action หมายถึง ภาพยนตรแบบบู แอ็กชั่น ยิง ตอสู ระทึกใจ เหมาะสําหรบัคนชอบความแข็งแรงและศลิปะการ
ตอสู ในภาพยนตรแนวน้ีจะมีฉากยงิ ระเบิด เผาสิ่งตางๆ ทีเ่ราอาจจะหาดูไดยาก ฉะนั้นคนที่ชอบหนังประเภทนี้ไมใช
เพราะชอบความรุนแรง แตจะหมายถึงคนที่ชอบที่จะสมัผสักับสิง่ทีห่าดูไมไดในชีวิตประจําวันและชอบความตื่นเตนอยูดวย 
ปจจุบันภาพยนตรประเภทนี้ มีออกมาฉายกันมากไมเคยขาดและไดรับการตอบกลับอยางดี แตก็ตองมเีนื้อหาสาระและ
มุมมองของการออกแบบฉากไดอยางลงตัวและสมจริงดวย อยางองคบากทั้งสองภาคก็ขายความแอคช่ันเปนจุดสําคัญ และ
อื่นๆ อีกมากมาย 
Adventure (ภาพยนตรผจญภยั) 

Adventure หมายถึง ภาพยนตร แนวผจญภัย เขาปาฝาดง เจอปญหาอุปสรรคมากมาย และตองมีการแกไข 
ปญหาสถานการณ หนงัแบบนี้ก็เหมาะสมหรบัผูชมที่ชื่นชอบการผจญภัย เชน เขาไปในปาที่ยังไมรูจกัวามีอะไรบางทีร่อ
การเขาไปคนหาจากเรา 
Animation (ภาพยนตรการตูน) 

Animation หมายถึงภาพยนตรการตูน ซึ่งปจจบุันกําลังมาแรง เชน finding nemo เปนตน ปจจุบันมกีารผลิต
ออกมาไดนาดูและแนบเนียนข้ึน ประเทศไทยเองก็มีออกมาหลายเรื่องและไดรับการตอนรบัมากโดยเฉพาะเด็กๆ ที่ขาดกัน
ไมได 
Comedy (ภาพยนตรตลก) 

Comedy ภาพยนตรตลก เบาสมอง เหมาะกบัคนที่ตองการดูเพื่อการพักผอน ไมตองคิดอะไรมาก 
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Crime (ภาพยนตรอาชญากรรม) 

Crime ภาพยนตรอาชญากรรม แนวการแกไข ตอสูกับคดีตางๆ ของตํารวจ 
Documentaries (ภาพยนตรสารคด)ี 

Documentary ภาพยนตรแนวสารคดีที่ดูไปดวย ไดสาระไปดวย 
Drama Movies (ภาพยนตรดรามา) 

Drama ภาพยนตรชีวิต ที่จะไดความรูสกึซึ้งเศรา เคลาน้ําตา ทําใหนึกถึงชีวิตคนจริงๆ บางเรื่องดูแลวเครียด บาง
เรื่องก็เศรามากๆ แตพอหนังจบก็โลงหัว 
Erotic (ภาพยนตรผูใหญ) 

Erotic เปนภาพยนตรที่ไมเหมาะกบัผูที่มีอายุไมถึง 18 ป เพราะเปนเรื่องเกี่ยวกับเพศ ในประเทศไทยไมมีเพราะ
ทําออกมาก็ไมผานการเซ็นเซอร 
Family (ภาพยนตรครอบครัว) 

Family เปนภาพยนตรที่คนทุกคนในครอบครัวดูได สวนใหญเปนภาพยนตรที่มเีนื้อหาเกี่ยวกบัความผูกพัน ของ
คนในครอบครัว สวนใหญก็จะแฝงแงคิดเอาไวและเดินเรือ่งแบบเรียบงาย เนนความรักกันของคนในครอบครัว 
Fantasy (ภาพยนตรผสมจินตนาการ) 

Fantasy ภาพยนตรที่มีการผสมจินตนาการแบบที่เราๆ ไมคอยเห็นในชีวิต จะเรียกวา เหนือจริงก็ได เด็กๆ หลาย
คนชอบจนถึงขั้นติดเลย 
Musicals Movies (ภาพยนตรเพลง) 

Musical ภาพยนตรเพลง เชน ชิคาโก ประเทศไทยยงัไมมีใหเห็นเปนเรื่องเปนราวสักเรื่อง แตก็ยากที่จะทําใหมี
รายไดเพราะความนิยมของคนแนวนี้ไมมาก 
Romance (ภาพยนตรโรแมนติก) 

Romance ภาพยนตรแนวรักโรแมนตกิ เหมาะกับคูหนุมสาวและผูทีก่ําลงัมีความรักทั้งหลายหรอืคนที่กําลงั
อยากจะรักใคร ชมไวเปนแนวทางในการทําตนเมื่อมีคนรัก จะไดความรูสกึมากขึ้นหากเราเคยมปีระสบการณและ
ความรูสึกเหมือนในภาพยนตร จึงไมแปลกใจทีห่ลายคนรองไหกับหนัง แตอีกหลายคนอาจจะมองวามันซึง้ตรงไหน ไมผดิ 
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Sci-Fi Movies (ภาพยนตรวิทยาศาสตร) 

Sci-Fi ภาพยนตรที่มเีนื้อหาอางองิวิทยาศาสตร แตทําออกมาใหนาสนใจอาจจะผสมจินตนาการเขาไปดวย แต
หลายคนบอกวาไมชอบเพราะดูไมรูเรื่อง ซึ่งกเ็ปนความจริงเพราะบางเรื่องก็ตองอาศัยความรูพื้นฐานเปนเดิมพันบาง แตถา
หากชมบอยๆ ก็จะเริม่รูเรือ่งและกลายเปนคนชอบหนังประเภทนี้ก็ได หนังแนวนี้สามารถตอจินตนาการใหเราได เผลอๆ 
คนที่ดูอาจจะคิดอะไรดีๆ ออกมาสรางประโยชนใหกบัคนรอบขางได และแนวคิดของหนังแนวนี้กเ็ปนแรงกระตุนให
นักวิทยาศาสตรพยายามทําใหไดแบบในหนัง 

 
Thriller Movies (ภาพยนตรระทึกขวัญ) 

Thriller ภาพยนตรแนวสืบสวนสอบสวน ที่มีการผูกเรื่องเพือ่ใหผูชมลุนไปดวยวาผลสุดทายจะออกมาในแนวใด 
เหมาะกับผูที่ชอบการสืบ นักสืบนอยทั้งหลาย มันมีเสนหตรงทําใหผูชมตองติดตามตลอดทัง้เรื่อง ดังนั้นหากเรื่องไหนทําให
เกิดปมชา ก็ทําใหหนงันาเบือ่ และตอนจบและแนวเรือ่งตองมีความแปลกใหม 

 
War (ภาพยนตรสงคราม) 

War หนังสงคราม ที่มีการอางองิเหตุการณสงครามทีเ่คยเกดิข้ึนในอดีต เนนจุดๆ หนึ่งในสงครามนั้นๆ ก็อาจจะ
นําไปใชสอนเด็กนักเรียนได แตก็อาจจะไมเหมาะในบางเรื่อง เชน ความรุนแรงหรือความปาเถื่อนอะไรประมาณนี ้ผม
สังเกตวาถาคนที่ไมใชคอหนังสงครามจรงิๆ เขาอาจจะไมอยากดูเลยดวยซ้ํา แตคนที่ชอบดูก็จัดไดวาคลั่งหนงัสงครามไป
เลย สวนทีเ่หลือกเ็ปนการชอบดเูปนชวงๆ ระยะเวลาใดเวลาหนึ่ง 

 
Western (ภาพยนตรตะวันตก) 

Western หนังคาวบอยตะวันตก ปจจุบันอาจจะดูไมคอยไดรับความนิยมเทาไรเพราะความแปลกใหมในการ
นําเสนอหายากขึ้นและเสี่ยงมากที่จะทําออกมา 
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2. ใครคือผูชมของเรา 
เนื้อเรื่องหลกัหรือเรื่องราวของภาพยนตรควรบอกไดวา เปนภาพยนตรเกี่ยวกับอะไร และสามารถสะทอนอารมณ

ออกมาใหผูชมเขาใจได การผูกเรื่องเกี่ยวของและคลองจองกันอยางไร ตองการถายทอดใหใครเปนกลุมเปาหมายหลัก
เชน ตัวละครสําหรบัเด็ก จะมีการออกแบบในลักษณะใชรูปรางพื้นฐาน ใชสีสวาง   

 
3. อะไรบางที่สามารถสรางความขบขันได 
ความขบขัน ควรคิดวาอะไรบางที่ดูเหลือเชื่อ สนุกสนาน โดยที่ไมสรางอารมณขันแบบคนตางชาติถาหากผูชมเปน

คนไทย เพราะเขาจะไมเขาใจความขบขันนั้น กอนที่เราจะแนใจอารมณขันของเรา ควรจะทดลองกับเพื่อนๆ หรือใหคน
ทั่วๆ ไปที่เราไมรูจักลองชมกอน ซึ่งการแสดงออกของตัวละครในเรื่องของอารมณตางๆ จะทําใหตัวละครดูสมจรงิมาก
ขึ้น  ซึ่งสิง่เหลานี้ข้ึนอยูกับบุคลิกลักษณะตัวละครที่คุณออกแบบ โดยอารมณตางๆของตัวละคร สามารถเปนไปในแนวทาง
ตางๆ เชน เงียบและขบขัน หรือ เกินจรงิมากๆ ตัวอยางที่มีใหเห็นอยางมาก เชน  ในตัวละครหมาปา  เวลาที่หมาปาตกใจ
จะมีอาการตาโปนออกมานอกเบาอยางเห็นไดชัด  หรือแมกระทั่งตัวละครหนาตาย  ซึ่งจะมีสหีนาไรอารมณไมวาจะอยูใน
อารมณแบบไหน 

 
4. อะไรบางที่ดูแลวนาเบ่ือ 
ไมมีอะไรที่ดูแลวรายมากกวาความนาเบื่อเมื่อเราชมภาพยนตรแลวไมสามารถเขาถึงได เราอาจจะงงรูสึกเบื่อ 

หงุดหงิด และหัวเสีย และเมือ่ไรทีผู่ชมของเราเสียความรูสึกมากขึ้นจนรบัไมได นั่นหมายความถึง ความพยายามของเรานั้น
ลมเหลว ดังนั้น เราควรสือ่ความหมายอยางเปนเหตุเปนผล เพื่อใหแนใจวาอารมณของภาพยนตรสามารถสรางความเขาใจ
และความบนัเทิงใหกับผูชมได 
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โครงเรื่องและการแบงสวนเน้ือหาของเรื่อง 

ฉากแตละฉากในภาพยนตรสวนใหญ จะพัฒนาจากบทประพันธของนักเขียนเปนสวนใหญจงึตองอาศัยความรูใน
การถายทอดจากภาษาเขียน เหลานั้นเปนภาษาภาพที่ใหผูชมไดเขาใจ โดยปราศจากเสียงใดๆ เราควรพจิารณาคําและ
ความหมายตางๆ ของบทประพันธใหชัดเจน ทําความเขาใจใหกระจางชัด ดูวาตัวละครควรเปนอยางไร และเปนใครกัน
บาง 

การเขียนโครงเรื่อง เปนการขยายแนวคิด ซึ่งอาจเปนเพียงบนัทึกยอ 2-3 ประโยคของสถานการณบางอยาง หรือ
เรื่องอยางยอๆ โดยอาศัยการดงึใจความสําคัญออกเปนประเด็นตางๆ ออกมาใหเขาใจงายขึ้น ที่สําคัญตองรักษาความ
สมบรูณของเนื้อเรื่องใหครบถวน 

การเขียนโครงเรื่องสวนใหญจะแบงเนื้อหาของเรื่อง โดยใชโครงสรางแบบสามองค เปนการแบงเรือ่งออกเปนสาม
สวนใหญๆ แตละสวนเราจะเรียกวา องค ไดแก 
           สวนของการเปดเรื่อง (Beginning) 

เปนการเริ่มตนของการกําหนดฉากและแนะนําตัวละคร ซึ่งเราจะดงึดูดความสนใจของผูชมเอาไวใหได อาจจะใช
จุดดึงดูดจากตัวละครซึ่งจะนําไปสูการแสดงในเนือ้เรื่อง 
          ชวงนี้มีจุดประสงคตรงที่อยากใหคนดูรูทีม่าคราวๆ วาตัวละครเปนอยางไร มีนสิัยอยางไร มีปมดอยหรอืจุดเดน
ตรงไหน แลวก็บรรยากาศรวมๆ ของสถานที่วาเปนที่ไหนอยางไร ยกตัวอยาง เชน ในเรื่องกระตายกับเตา เตาจะมนีิสัย
ทะนงตัวและชอบเอาชนะจึงเปนทีม่าของการแขงขันที่นาติดตาม 
           สวนของการดําเนินเรื่อง (Middle) 

ชวงกลางเรื่องจะเปนการแสดงออกในลักษณะตางๆ ของตัวละคร เปนการสรางอารมณใหผูชมผจญกับเหตุการณ
ตางๆ ซึ่งจะนําไปสูจุดสนใจของเรื่อง เปนชวงที่เรื่องราวตางๆ ซึ่งจะนําไปสูจุดสนใจของเรื่องเปนชวงที่เรื่องราวตางๆ 
เกิดข้ึนมากมาย อปุสรรค เริ่มมา ปริศนาเริ่มเกิดขึ้น อะไรๆ ก็ดูจะไมเขาใจ ชีวิตมันดูมีอุปสรรคเต็มไปหมด 
          ถาตองการเขียนเนื้อเรื่องในภาพยนตรที่มีความยาวมากๆ ตรงจุดนี้เองจะตองพฒันาลักษณะนิสัยตางๆ ของตัว
ละคร  และกําหนดเคาโครงเรื่อง (Plot) ใหนาสนใจ 
           สวนของการปดเรื่อง (End) 

บทสรุปของเรื่องควรมีเนื้อหาทีก่ลาวถึงชวงกอนหนาประมาณ 2-3 ซีน ถาเราสรางภาพยนตรสกัเรื่อง บทสรุปของ
เรื่องจะสนับสนุนความเขมแข็งของเรื่องใหดีขึ้น บทสรปุที่ดจีะชวยสรางการจดจํา และดึงดูดใหผูชมกลับมาดอูีกครัง้ และที่
สําคัญ สวนนีเ้ปนสวนทีม่ี Climax ของเรื่องรวมอยูดวย ดังนัน้ จะจบแบบไหน อยางไร ตรงนีเ้ปนจุดที่ตองดึงดูดอารมณคน
ดูออกมาใหไดอยางที่ตองการมากทีสุ่ด 
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ตัวอยางการแบงสวนเน้ือเรื่องของ “กระตายกับเตา 2010”  
          สวนของการเปดเรือ่ง : กาลครั้งหนึง่นานมาแลว นานจนจําไมได อะลอเลน มีเตานอยผูเยอหยิ่งทะนงตนตัวหนึง่
กําลังขับรถเลนอยูในเมืองทันทีทีส่ัญญาณไฟเปลี่ยนเปนสีแดงจึงไดพบกับกระตายนอย “คิคุจัง” กําลังขับรถมาเที่ยวพอด ี
 
         สวนของการดําเนินเรื่อง : ดวยความอวดเกงของ เจาเตา “เทอรโบ” จึงไดเบิล้เครือ่งใส กระตายนอย “คิคุจัง” 
พรอมกับเชิดหนาดวยความกระหยิ่มยิ้มยองในใจวา รถเตางามหรูนีส้ามารถเอาชนะกระตายนอย “คิคุจัง” ไดอยางสบายๆ 
โดยที่ยังไมรูตัววาอะไรจะเกิดขึ้น ทันทีทีส่ัญญาณเปลี่ยนเปนไฟเขียว เจาเตา “เทอรโบ” ก็ออกรถแบบสุดตัวคิดวากระตาย
นอยไมสามารถตามทันได 
 
          สวนปดเรื่อง : กระตายนอย “คิคุจัง” นิ่งสงบอยางใจเย็น เลื่อนมือไปเปดอุปกรณพิเศษในรถ จากนั้นก็ออกตัวดวย
ความเร็วที่เหนือกวา วิ่งแซงเจาเตา “เทอรโบ” ผูหลงในความมั่นใจของตนเองเสียจนหมดทาไปเลย 
 
ปจจัยสําคัญในโครงสรางบท 

1. แนะนํา (INTRODUCTION) คือ การแนะนําเหตุการณ สถานการณ สถานที ่ตัวละครสิง่แวดลอม และเวลา 
2. สรางเง่ือนไข (SUSPENSE) คือ การกระตุนใหเนือ้เรื่องดําเนินไปอยางลึกลับมเีงื่อนไข มีปมผกูมัด ความ

ขัดแยง ทําใหผูชมเกิดความสงสัยและสนใจในเหตุการณ 
3. สรางวิกฤตกาล (CRISIS) คือ การเผชิญปญหา วิเคราะหปญหาของตัวละคร และหาทางแกไข หาทางออก 

หากตัวละครวนเวียนอยูกับปญหานานมากจะทําใหผูชมรูสกึหนักและเบือ่ขึ้นได ควรที่จะมีการกระตุนจากเหตุการณอื่นมา
แทรกดวย 

4. จุดวิกฤตสูงสุด (CLIMAX) เปนชวงเผชิญหนากับปญหาครั้งสุดทายที่ถูกบบีกดดันสูงสุด ทําใหมกีาร
ตัดสินใจอยางเด็ดขาด 

5. ผลสรุป (CONCLUSION) คือ ทางออก ขอสรปุ ทําใหเกิดความกระจาง ภาพยนตรบางเรื่องอาจไมมี
บทสรุป กเ็พื่อใหผูชมนํากลับไปคิดเอง 
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ขั้นตอนในการเขียนบท 

 
1. การคนควาหาขอมูล (research) เปนขั้นตอนการเขียนบทอันดับแรกที่ตองทําถือเปนสิง่สําคัญหลังจาก 

พบประเด็นของเรื่องแลว จึงลงมอืคนควาหาขอมูลเพื่อเสริมรายละเอียดเรื่องราวที่ถูกตอง จรงิ ชัดเจน และมีมิติมากขึ้น 
คุณภาพของภาพยนตรจะดีหรือไมจึงอยูที่การคนควาหาขอมูล ไมวาภาพยนตรนั้นจะมีเนื้อหาใดก็ตาม 
 

2. การเขียนเรื่องยอ (synopsis) คือ เรื่องยอขนาดสั้น ที่สามารถจบลงได 3-4 บรรทัด หรือหนึ่งยอหนา หรือ 
อาจเขียนเปน story outline เปนรางหลังจากที่เราคนควาหาขอมูลแลวกอนเขียนเปนโครงเรื่องขยาย (treatment) 
 

3. การเขียนโครงเรื่องขยาย (treatment) เปนการเขียนคําอธิบายของโครงเรื่อง (plot) ในรูปแบบของ 
เรื่องสั้น โครงเรื่องขยายอาจใชสําหรับเปนแนวทางในการเขยีนบททีส่มบูรณ บางครั้งอาจใชยื่นของบประมาณไดดวยและ
การเขียนโครงเรื่องขยายที่ดีตองมีประโยคหลักสําคัญ (premise) ที่งาย ๆ นาสนใจ 
 

4. บท (screenplay) คือ บทที่มีโครงเรื่อง บทพูด แตมีความสมบูรณนอยกวาบทถายทํา (shooting script) 
เปนการเลาเรื่องที่ไดพัฒนามาแลวอยางมีขั้นตอน ประกอบ ดวยตัวละครหลักบทพูด ฉาก แอ็คชั่น ซีเควนส มีรูปแบบการ
เขียนที่ถูกตอง เชน บทสนทนาอยูกึ่งกลางหนากระดาษฉาก เวลา สถานที่ อยูชิดขอบหนาซายกระดาษ ไมมีตัวเลข
กํากับช็อต และโดยหลักทั่วไปบทหนึ่งหนามีความยาวหนึ่งนาท ี

 
5. บทถายทํา (shooting script) ไดแก ตําแหนงกลอง การเช่ือมช็อต เชน คัท (cut) การเลอืนภาพ (fade) 

การละลายภาพ หรือการจางซอนภาพ (dissolve) การกวาดภาพ (wipe) ตลอดจนการใชภาพพิเศษ (effect) อื่นๆ 
นอกจากนี้ยงัมีเลขลําดบัช็อตกํากบัเรียงตามลําดับตั้งแตช็อตแรกจนกระทั่งจบเรื่อง 
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6. บทภาพ (story board)  คือ บทประเภทหนึ่งที่อธบิายดวยภาพ คลายหนังสือการตูน ใหเห็นความตอเนื่อง

ของช็อตตลอดทัง้ซเีควนสหรือทัง้เรื่องมีคําอธิบายภาพประกอบ เสียงตาง ๆ เชน เสียงดนตรี เสียงประกอบฉาก และ
เสียงพูด เปนตน ใชเปนแนวทางสําหรบัการถายทํา หรือใชเปนวิธีการคาดคะเนภาพลวงหนา (pre-visualizing) กอนการ
ถายทําวา เมื่อถายทําสําเร็จแลว หนังจะมรีูปรางหนาตาเปนอยางไร ซึ่งบริษัทของ Walt Disney นํามาใชกับการผลิต
ภาพยนตรการตูนของบริษทัเปนครั้งแรก โดยเขียนภาพ เหตุการณของแอ็คช่ันเรียงติดตอกันบนบอรด เพื่อใหคนดูเขาใจ
และมองเห็นเรื่องราวลวงหนาไดกอนลงมือเขียนภาพ สวนใหญบทภาพจะมีเลขที่ลําดบัช็อตกํากบัไว คําบรรยายเหตุการณ 
มุมกลอง และอาจมเีสียงประกอบดวย  โดยสตอรีบ่อรดจะประกอบไปดวยรายละเอียดดงันี ้

 
• ตัวละครอะไรบางอยูในซีน ตัวละครหรอืวัตถุเคลื่อนไหวอยางไร 
• ตัวละครมบีทสนทนาอะไรกันบาง 
• ใชเวลาเทาไหรระหวางซีนที่แลวถึงซีนปจจบุัน 
• ใชมุมกลอง ใชกลองอะไรบางในซีนนั้นๆ ใกลหรือไกล หรอืใชมุมอะไร 
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พื้นฐานการเขียน Script-Screenplay 

 
หลงัจากไดเรื่องราวคราวๆ มาแลว ขั้นตอนตอไป ก็คือ จัดการทําเรื่องราวที่ไดมาใหมีรายละเอียดเปนรูปเปนราง

มากขึ้น ดวยการเริม่จาก Screenplay หรอืการเขียนบทนั่นเอง 
การเขียนบท คือ การเขียนออกมาวา ใครทําอะไร ที่ไหน อยางไร และตองสื่อความหมายออกมาเปนภาพ โดยใช

ภาพเปนตัวสื่อความหมาย เปนการเขียนอธิบายรายละเอียดเรื่องราว เมื่อไดโครงสรางเรื่องที่ชัดเจนแลวจงึนําเหตุการณมา
แตกขยายเปนฉากๆ ลงรายละเอียดยอยๆ ใสสถานการณ ชวงเวลา สถานที่ ตัวละคร บทสนทนา บางครั้งอาจกําหนดมมุ
กลองหรือ ขนาดภาพ ใหชัดเจนเลยก็ได 

 
องคประกอบของการเขียนบทภาพยนตร 
 

1. เรื่อง (story) หมายถึงเหตุการณหรือเรื่องราวที่เกิดข้ึน โดยมีจุดเริ่มตนและดําเนินไปสูจุดสิ้นสุด เรื่องอาจจะ
สั้นเพียงไมกี่นาท ีอาจยาวนานเปนป หรือไมรูจบ (infinity) ก็ได สิ่งสําคัญในการดําเนินเรื่อง คือปมความขัดแยง 
(conflict) ซึ่งกอใหเกิดการกระทํา สงผลใหเกิดเปนเรือ่งราว 

 
2. แนวความคิด (concept) เรือ่งทีจ่ะนําเสนอมีแนวความคิด (Idea) อะไรทีจ่ะสื่อใหผูชมรบัรู 
 
3. แกนเรื่อง (theme) คือประเด็นเนือ้หาสําคัญหรือแกนหลัก (Main theme) ของเรื่องทีจ่ะนําเสนอ ซึ่งอาจ

ประกอบดวยประเด็นรองๆ (sub theme) อีกก็ได แตตองไมออกนอกแนวความคิดหลัก 
 
4. เรื่องยอ (Plot) เปนจุดเริ่มตนของภาพยนตร ไมวาจะเปนเรื่องที่คิดขึ้นมาใหม เรื่องที่นํามาจากเหตุการณจริง 

เรื่องที่ดัดแปลงมาจากวรรณกรรม หรือแมแตเรือ่งทีล่อกเลียนแบบมาจากภาพยนตรอื่น สิ่งแรกนั้นเรื่องตองมีความ
นาสนใจ มีใจความสําคัญชัดเจน ตองมีการมีการตั้งคําถามวา จะมีอะไรเกิดข้ึน (What...if...?) กับเรื่องที่คิดมา และ
สามารถพฒันาขยายเปนโครงเรือ่งใหญได 
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5. โครงเรื่อง (treatment) เปนการเลาเรื่องลําดับเหตกุารณอยางมีเหตุผล เหตกุารณทกุเหตุการณจะตอง

สงเสริมประเด็นหลักของเรือ่งไดชัดเจน ไมใหหลงประเด็น โครงเรื่องจะประกอบดวยเหตุการณหลัก (main plot) และ
เหตุการณรอง (sub plot) ซึ่งเหตุการณรองที่ใสเขาไป ตองผสมกลมกลืนเปนเหตุเปนผลกับเหตกุารณหลัก 
 

6. ตัวละคร (character) มีหนาที่ดําเนินเหตุการณจากจุดเริม่ตนไปสูจุดสิ้นสุดของเรื่อง ตัวละครอาจเปนคน 
สัตว สิ่งของ หรือเปนนามธรรมไมมีตัวตนก็ได การสรางตัวละครขึ้นมาตองคํานึงถงึภูมิหลังพื้นฐาน ทีม่าที่ไป บุคลิกนสิัย 
ความตองการ อันกอใหเกิดพฤติกรรมตางๆ ของตัวละครนั้นๆ ตัวละครแบงออกเปนตัวแสดงหลักหรือตัวแสดงนํา และตวั
แสดงสมทบหรือตัวแสดงประกอบ ทุกตัวละครจะตองมสีงผลตอเหตุการณนั้นๆ มากนอยตามแตบทบาทของตน ตัวเอก
ยอมมีความสําคัญมากกวาตัวรองเสมอ 

 
7. บทสนทนา (dialogue) เปนถอยคําที่กําหนดใหแตละตัวละครไดใชแสดงโตตอบกัน ใชบอกถงึอารมณ 

ดําเนินเรือ่ง และสื่อสารกบัผูชม ภาพยนตรที่ดีจะสื่อความหมายดวยภาพมากกวาคําพูด การประหยัดถอยคําจงึเปนสิง่ที่
ควรทํา ความหมายหรืออารมณบางครั้งอาจจําเปนตองใชถอยคํามาชวยเสรมิใหดูดียิ่ง ข้ึนก็ได 
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5. โครงเรื่อง (treatment) เปนการเลาเรื่องลําดับเหตกุารณอยางมีเหตุผล เหตกุารณทกุเหตุการณจะตอง

สงเสริมประเด็นหลักของเรือ่งไดชัดเจน ไมใหหลงประเด็น โครงเรื่องจะประกอบดวยเหตุการณหลัก (main plot) และ
เหตุการณรอง (sub plot) ซึ่งเหตุการณรองที่ใสเขาไป ตองผสมกลมกลืนเปนเหตุเปนผลกับเหตกุารณหลัก 
 

6. ตัวละคร (character) มีหนาที่ดําเนินเหตุการณจากจุดเริม่ตนไปสูจุดสิ้นสุดของเรื่อง ตัวละครอาจเปนคน 
สัตว สิ่งของ หรือเปนนามธรรมไมมีตัวตนก็ได การสรางตัวละครขึ้นมาตองคํานึงถงึภูมิหลังพื้นฐาน ทีม่าที่ไป บุคลิกนสิัย 
ความตองการ อันกอใหเกิดพฤติกรรมตางๆ ของตัวละครนั้นๆ ตัวละครแบงออกเปนตัวแสดงหลักหรือตัวแสดงนํา และตวั
แสดงสมทบหรือตัวแสดงประกอบ ทุกตัวละครจะตองมสีงผลตอเหตุการณนั้นๆ มากนอยตามแตบทบาทของตน ตัวเอก
ยอมมีความสําคัญมากกวาตัวรองเสมอ 

 
7. บทสนทนา (dialogue) เปนถอยคําที่กําหนดใหแตละตัวละครไดใชแสดงโตตอบกัน ใชบอกถงึอารมณ 

ดําเนินเรือ่ง และสื่อสารกบัผูชม ภาพยนตรที่ดีจะสื่อความหมายดวยภาพมากกวาคําพูด การประหยัดถอยคําจงึเปนสิง่ที่
ควรทํา ความหมายหรืออารมณบางครั้งอาจจําเปนตองใชถอยคํามาชวยเสรมิใหดูดียิ่ง ข้ึนก็ได 
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ความหมายของคําศัพทพื้นฐานในการเตรียมงานแอนิเมชั่น 

 
ซ็อต (Shot) คือ การถายภาพยนตรในครัง้หนึง่ที่มีชวงเวลาที่ตอเนื่องโดยไมหยุด จังหวะการทํางานของกลองใน

การถายบันทกึภาพยนตรเปนชวงๆ น้ี ตองการสรางชุดของเนื้อหาความหมายเปนหนวยๆ อาจมีความสัมพันธระหวางกนั 
เชน อยูในสถานที่เดียวกันของเหตกุารณทีเ่กิดข้ึนใหคงความตอเนื่องดวยสถานที่เวลา ในอีกความหมายหนึง่ของซอ็ตคือ 
ระยะหางระหวางกลองถายกับวัตถุในฉากหรือมุมของการวางกลองกบัวัตถุ หรืออีกแบบหนึ่งคือ การถายแตละซ็อตอยาง
แตกตางไมตอเนื่องทั้งสถานที่ เหตุการณ และชวงเวลาก็ได  

 
ฉากหรือซีน (Scene) ในทางการถายภาพยนตรหมายถงึ สถานที่ (Place) หรือฉาก (Set) ที่จัดข้ึนหรอืดัดแปลง

ขึ้น เพื่อใชในการแสดง หรือเพื่อการถายทําภาพยนตร ในการประกอบเรื่องของภาพยนตร ซีนจึงเปนหนวยยอยของเรื่อง
เลาดวยภาพ ซึ่งประกอบดวยซ็อต ทีเ่กิดข้ึนในสถานทีเ่ดียวกนั  

 
ซีเควนซ (Sequence) คือ ตอน หรือชวงเหตุการณหนึ่งของการเลาเรื่องในภาพยนตร ซึ่งเกิดจากซีนหลายๆ 

ซีนมารวมกัน โดยมีความสมบูรณของเนื้อหาที่บอกใหผูชมเขาใจเรื่องราวในชวงเวลา หรือเหตุการณหนึง่ๆ ซีเควนซหนึ่งๆ 
ของภาพยนตรอาจประกอบขึ้นดวยซีนเพียงซีนเดียว หรือเกดิจากซีนหลายๆ ซีนมาประกอบกันขึ้นก็ได และอาจเปนไดที่
ซัเควนซหนึง่ทีส่ามารถเลาเรื่องราวหนึ่งๆ ใหผูชมเขาใจในเหตุการณ หรือความหมายของภาพยนตรชวงนั้นใหเขาใจได
อยางสมบูรณ  

 
สคริปต (Script) เปนขั้นตอนในการจบัใจความสําคัญของเนือ้เรื่องใหออกมาในแตละฉากพรอมทัง้กําหนดมุม

กลอง เทคนิคพิเศษ รวมถึงระยะเวลาของการเคลื่อนไหว ซึ่งจะถูกกําหนดไปดวยขอบเขตของเวลาและสถานที ่
 
 
 
 
 
 
 
 
 
 

 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

39

39 
 

 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบทดสอบ 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
หัวขอที่ 1 

 
   คําช้ีแจง แบบทดสอบมีทั้งหมด 2 ตอน 
   ตอนที่ 1 เขียนเคร่ืองหมาย ลอมรอบตัวอักษรหนาคําตอบที่ถูกตอง 

1. ขอใดคือขอดีของ Drawn Animation 
ก ชวยใหการทําแอนิเมชั่นงายขึ้น 
ข ประหยัดเวลาและประหยัดตนทุน 
ค ถายทําไดหลายฉากในเวลาเดียวกัน 
ง มีความเปนศิลปะ  สวยงาม  นาดูชม   

2. การฉายภาพเพื่อใหเห็นเหมือนวาภาพนั้นเคลื่อนไหวได
ตอเนื่องกนั ตองฉายตอกันดวยความเร็วเทาใดจึงจะ
เหมาะสมที่สุด 

ก 8 เฟรมตอวินาทีขึ้นไป 
ข 16 เฟรมตอวินาทีขึ้นไป 
ค 24 เฟรมตอวินาทีขึน้ไป 
ง 32 เฟรมตอวินาทีขึ้นไป 

3. การเปลี่ยนแปลงมวลของ  object   หมายถึง ขอใด 
ก Squash and Stretch   
ข Timing and Spacing 
ค Slow in and Slow out 
ง Overlapping Action 

4. Anticipation หมายถึง ขอใด 
ก ทิศทาง  ข ทาเตรียม 
ค ระยะหาง  ง  การเคลื่อนไหว 

5. Appeal หมายถึง ขอใด 
ก อารมณ  ข แรงโนมถวง 
ค อากัปกริยา  ง  รสนิยม เสนห 
 

6. สวนที่มี Climax ของเรื่องคือขอใด 
ก สวนของการเปดเรื่อง 
ข สวนของการดําเนินเรื่อง 
ค สวนของการปดเรื่อง 
ง อยูสวนใดของเรื่องก็ได 

7. ขอใดคือ ซ็อต (Shot) 
ก ชวงเวลาที่ตอเนื่องโดยไมหยุด 
ข หนวยยอยของเรื่องเลาดวยภาพ 
ค ขั้นตอนในการจับใจความสําคัญของเนื้อเรื่อง 
ง ที่ที่จัดข้ึนหรือดัดแปลงขึ้น เพื่อใชในการแสดง 

8. ขอใดคือ ซีน (Scene) 
ก ชวงเหตุการณของเรื่อง 
ข สถานที่ (Place) หรือฉาก (Set) 
ค ระยะเวลาของการเคลื่อนไหวและสถานที ่
ง ขั้นตอนในการจบัใจความสําคัญของเนือ้เรื่อง 

9. ขอใดคือ ซีเควนซ (Sequence) 
ก หนวยยอยของเรื่องเลาดวยภาพ 
ข การถายแตละซ็อตอยางแตกตางไมตอเนื่อง 
ค ชวงเหตุการณหนึง่ของการเลาเรื่องในภาพยนตร

 ง  ฉาก มุมกลอง เทคนิคพิเศษ รวมถึงระยะเวลา 
10. ขอใดคือ สคริปต (Script) 

ก ที่ที่จัดข้ึน เพื่อใชในการแสดง 
ข หนวยยอยของเรื่องเลาดวยภาพ 
ค ความสมบูรณของเนื้อหาและเรื่องราว 
ง ใจความของเนื้อเรื่องที่ออกมาในแตละฉาก 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบทดสอบ 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
หัวขอที่ 1 

 
   ตอนที่ 2 กําหนดใหคิดโครงเร่ือง และนําเสนอโดยเลาเรื่องดวยภาพประมาณ 1 นาที 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเฉลยทดสอบ 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
หัวขอที่ 1 

 
1. ขอใดคือขอดีของ Drawn Animation 

ง มีความเปนศิลปะ  สวยงาม  นาดูชม   
2. การฉายภาพเพื่อใหเห็นเหมือนวาภาพนั้นเคลื่อนไหวไดตอเนื่องกัน ตองฉายตอกันดวยความเร็วเทาใดจึงจะ
เหมาะสมที่สุด 

ข 16 เฟรมตอวินาทีขึ้นไป 
3. การเปลี่ยนแปลงมวลของ  object   หมายถึง ขอใด 

ก Squash and Stretch   
4. Anticipation หมายถึง ขอใด 

ข ทาเตรียม 
5. Appeal หมายถึง ขอใด 

ง  รสนิยม เสนห 
6. สวนที่มี Climax ของเรื่องคือขอใด 

ค สวนของการปดเรื่อง 
7. ขอใดคือ ซ็อต (Shot) 

ก ชวงเวลาที่ตอเนื่องโดยไมหยุด 
8. ขอใดคือ ซีน (Scene) 

ข สถานที่ (Place) หรือฉาก (Set) 
9. ขอใดคือ ซีเควนซ (Sequence) 

ค ชวงเหตุการณหนึง่ของการเลาเรื่องในภาพยนตร 
10. ขอใดคือ สคริปต (Script) 

ง ใจความของเนื้อเรื่องที่ออกมาในแตละฉาก 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเฉลยทดสอบ 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
หัวขอที่ 1 

 
ภาพตัวอยาง 

การเลาเร่ืองดวยภาพสั้นๆ (Scrip 1 นาท)ี 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบประเมนิแบบทดสอบ 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
หัวขอที่ 1 

 
เกณฑการประเมิน  :   
 

เกณฑการใหคะแนน ระดับคะแนน 
1. ความเหมาะสมของเนื้อหากับเวลา 25  คะแนน 
2. การออกแบบลักษณะของฉาก ตัวละคร และการเคลือ่นไหว 25  คะแนน 
3. ความคิดสรางสรรค 25  คะแนน 
4. ชิ้นงานมีความสวยงามและเรียบรอย 25  คะแนน 

รวม 100  คะแนน 
 
หมายเหตุ  :       

ระดับคะแนน  90-100 คะแนน หมายถึง ดีเยี่ยม 
ระดับคะแนน  70-89 คะแนน หมายถึง ด ี
ระดับคะแนน  50-69 คะแนน หมายถึง ผานเกณฑ 
ระดับคะแนน  0-49 คะแนน หมายถึง ไมผานเกณฑ 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเตรียมการสอน 
(ปฏิบตัิ) 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
งานที่ 1 เวลา   4  ชั่วโมง 

 
วัตถุประสงค  :  เพื่อใหผูรบัการฝกมีความรู ความสามารถเกี่ยวกับพื้นฐานในการทํางาน 2D Animation 

 
วิธีการสอน  :  บรรยาย สาธิต และใหฝกปฏิบัต ิ
 
  
อุปกรณชวยฝก :   
การมอบหมายงาน  : 
การวัดและประเมินผล  : 
หนังสอือางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครั้งที ่6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศร ี(2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครั้งที ่2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเด้ียนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรีเมียร. 
James D. Foley et., al. (1994).  Introduction to Computer Graphics. USA: Addison-Wesley. 
_________. (2005).  Computer Graphics: principle and practice. (3rd edition). USA: Addison-Wesley. 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
งานที่ 1 

 
ขั้นตอนและกระบวนการสรางงาน 2D Animation 
 

1. พื้นฐาน 12 ขอของแอนิเมชั่น (Animation) 
 

 
 
2. กฎพื้นฐานการวางโครงเรื่องของแอนิเมชั่น (Animation) 
 

“กระตายกบัเตา 2010” 
          สวนของการเปดเรือ่ง : กาลครั้งหนึง่นานมาแลว นานจนจําไมได อะลอเลน มีเตานอยผูเยอหยิ่งทะนงตนตัวหนึง่
กําลังขับรถเลนอยูในเมืองทันทีทีส่ัญญาณไฟเปลี่ยนเปนสีแดงจึงไดพบกับกระตายนอย “คิคุจัง” กําลังขับรถมาเที่ยวพอด ี
         สวนของการดําเนินเรื่อง : ดวยความอวดเกงของ เจาเตา “เทอรโบ” จึงไดเบิล้เครือ่งใส กระตายนอย “คิคุจัง” 
พรอมกับเชิดหนาดวยความกระหยิ่มยิ้มยองในใจวา รถเตางามหรูนีส้ามารถเอาชนะกระตายนอย “คิคุจัง” ไดอยางสบายๆ 
โดยที่ยังไมรูตัววาอะไรจะเกิดขึ้น ทันทีทีส่ัญญาณเปลี่ยนเปนไฟเขียว เจาเตา “เทอรโบ” ก็ออกรถแบบสุดตัวคิดวากระตาย
นอยไมสามารถตามทันได 
          สวนปดเรื่อง : กระตายนอย “คิคุจัง” นิ่งสงบอยางใจเย็น เลื่อนมือไปเปดอุปกรณพิเศษในรถ จากนั้นก็ออกตัวดวย
ความเร็วที่เหนือกวา ว่ิงแซงเจาเตา “เทอรโบ” ผูหลงในความมั่นใจของตนเองเสียจนหมดทาไปเลย 
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แนวการทํา Animation 

1. คิด Theme หลักของเรื่อง Theme หลักของเรือ่งจะเปนแนวคิดที่สั้น ๆ นําเสนอจบในประโยคเดียว  
ยกตัวอยางเชน  "รักแทดแูลไมไดไปขายกลวยแขกดีกวา"      

เมื่อคิดวาดีแลวก็เขาสูขั้นตอนการเขียนเรื่องยอ 
2. เขียนเรื่องยอ เรื่องยอ คือ เรื่องเลายอ ๆ ของทั้งเรื่อง สวนใหญมักจะจบใน 1 หนา A4  

การเขียนเรื่องยอตองเขียนใหชัดเจน 
 3. บท คือ ตัวหนังสือทีเ่ลาเรือ่งราวของการดําเนินเนื้อเรือ่งแบบอานแลวเห็นภาพเปนฉากๆ มีการบอกมมุกลอง 
เทคนิคถายทํา และ บทพูดไวอยางชัดเจน 

ตัวอยางบทจากหนงัสือเรือ่ง "ลมหลง" ของ คุณชาติ  กอบจติต ิ
SEQ ไตเติ้ล  ภายใน  ผับแหงหนึง่  กลางคืน 

1. ใกลมาก 
ในความมืด ตัวอักษรชื่อเรื่อง ลมหลง คอยปรากฏขึ้นสกัครูตัวอักษรเลือนหายไป เหลือไวแตความมืด   เสียงผูคน

ในผับคอยดังขึ้น เปนเสียงสรวลเสเฮฮา มีเสียงดนตรีแววผสมเปนเสียงแซ็กโซโฟน (ทวงทํานองโหยเศรา- ใชเปนเพลง
ประกอบหลกัของภาพยนตรเรื่องนี้) 

------------------------------------------------------------------------------------------------------------------------ 
2.  แทนสายตา (กลองหนัง 16 มม. มีเสียงกลองทํางานตลอด) 
ในความมืด  ไมขีดไฟถูกจุดข้ึน แสงสวางของมันทําใหเห็นเสลด (ปายบอกชื่อเรื่อง, ฉาก, คัต เปนหนังของสายลม-

สเลตของเขาเขียนแตเพียงวา "ในผบั 1" ) สักครูภาพดับวบูไป ทิ้งไวแตความมืด 
ตัวอักษรผูแสดงปรากฏขึ้น เสียงผูคนและเสียงแซก็โซโฟนดังตอเนื่อง- ตัวอักษรเลือนออก 
------------------------------------------------------------------------------------------------------------------------ 
3. ใกลมาก  
ภาพเลื่อนเขาที่แซ็กโซโฟน เห็นนิ้วของนักดนตรีกําลงัไลเรียงไปตามทวงทํานอง ภาพเลือนออกไปเปนความมืด 
ตัวอักษรรายช่ือผูแสดง และผูทีเ่กี่ยวของกับภาพยนตรเรือ่งนี้ขึ้น-ตอเนื่อง ตัวอักษรเลือนออก 
------------------------------------------------------------------------------------------------------------------------ 

จากตัวอยางของบทภาพยนตร 
SEQ ไตเติ้ล ภายใน ผับแหงหนึ่ง กลางคืน หมายความวา สวนไตเติ้ล ถายภายใน (Indoor) สถานที่ทีผ่ับแหง

หนึ่ง เวลากลางคืน จากนั้นก็เปน มุมกลอง และการเคลื่อนกลอง 
"แทนสายตา” หมายความวา ภาพแทนสายตาของกลอง 16 มม. 
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4. เขียน Story board  ซึ่งจะประกอบดวย ดานซายเปนภาพ ดานขวาเปนตัวอักษรอธิบายภาพ และมเีสียง

ประกอบหรือเสียงพูดจากบทดวย การเขียน Storyboard ประกอบโฆษณา 30 วินาที เขียนประมาณ 10-12 รูปเทานั้น  
 

ตัวอยาง Story board   
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5. Shooting Board เมื่อออกแบบ Story board แลว ตอมาจึงแตกเปน shooting board รายละเอียดของ 

Shooting board จะเหมือนกับ Story board แตแตกตางกันที ่shooting board มีความละเอียดสงูกวา มีทุกภาพทีจ่ะ
อยูในหนัง Animation เพื่อจะใหคนทําไดทําอยางถูกตอง  

 
ตัวอยาง Shooting Board 
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6. Animatic เมื่อได Shooting board เรียบรอยแลว กอนจะทําจรงิตองผานการทํา Animatic เสียกอน 

Animatic คือ ภาพเคลื่อนไหวคราวๆ ทําใหเห็นจังหวะของภาพ เห็นการตัดตอ การเคลือ่นของ Animation ปกติจะใส
เสียงไปดวยเลย 
 

7. Refining the Animation  (ปรับแตงชิ้นงาน) หลังจากที่ไดทํา Animatic แลวจะตองนําไปปรับปรงุและ 
ตกแตงแกไขสตอรบีอรด และขั้นตอนอื่นๆ โดยละเอียด เชน ลักษณะงานศิลป ( Character Art )  
ฉากหลงั ( Background ) เสียง( Sound ) เวลา ( Timeing ) และสวนประกอบอื่นๆ จนกระทั่งเขาสูการผลิตงาน 
แอนิเมชั่น 
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ขั้นตอนการปฏิบัติงาน  : ใหผูฝก ฝกปฏิบัติงานในหัวขอท่ี 1  
 

1. ฝกปฏิบัติการการวางโครงเรื่อง 
1.1 ฝกปฏิบัตกิารวางโครงเรื่องของแอนิเมชั่น (Animation) 
 
 
 
 
 
 
 

 
อุปกรณและเครื่องมือ:  1. ไมบรรทัด          

2. กระดาษรองวาด 
3. ตัวหนีบ      
4. มีดคัตเตอร    
 
 
 

 
 
วัสด ุ :                     1. ดินสอเบอร   

2. กระดาษ  
3. ยางลบ      
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1. ฝกปฏบิัตกิารการวางโครงเรื่อง 
1.1 ฝกปฏิบัตกิารวางโครงเรื่องของแอนิเมชั่น (Animation) 

 
ขั้นตอนการวางโครงเรื่องของแอนิเมชั่น (Animation) 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. สวนของการเปดเรื่อง 
(Beginning) 

การเริ่มตนของการกําหนดฉากและแนะนํา
ตัวละคร โดยมีจุดประสงคใหคนดูทราบที่มา 
คราวๆ วาตัวละครเปนอยางไร มีนสิัย
อยางไร มีปมดอยหรือจุดเดนตรงไหน และ
บรรยากาศสถานทีร่วมๆวาเปนที่ไหน
อยางไร 

- 

2. สวนของการดําเนินเรือ่ง 
(Middle) 

แสดงออกในลักษณะตางๆ ของตัวละคร 
เปนการสรางอารมณใหผูชมผจญกับ
เหตุการณตางๆ ซึง่จะนําไปสูจุดสนใจของ
เรื่อง เปนชวงทีเ่รื่องราวตางๆ ซึ่งจะนําไปสู
จุดสนใจของเรื่อง 
 

- 

3. สวนของการปดเรื่อง (End) บทสรุปที่ดีจะชวยสรางการจดจํา และดงึดูด
ใหผูชมกลับมาดูอีกครัง้ สวนนี้เปนสวนที่มี  
Climax ของเรื่องรวมอยูดวย ดังนั้น จะจบ
แบบไหน อยางไร ตรงนี้เปนจุดที่ตองดงึดูด
อารมณคนดูออกมาใหไดอยางที่ตองการ
มากที่สุด 

- 

หมายเหตุ  :      
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   วิทยากร/ครูฝกกําหนดใหผูเขารับการฝกการวาดภาพการเคลื่อนไหว 3 ภาพ โดยใช 

กฎพื้นฐาน 12 ขอของ Animation 
 

ภาพตัวอยาง 
การวาดภาพการเคลื่อนไหวโดยใชกฎพื้นฐาน 12 ขอของ Animation 

 

 
 

 
 
 
ครุภัณฑ/เครื่องมือ/วัสด/ุอุปกรณ  
 

1. ดินสอ  
2. กระดาษ  
3. ยางลบ    
4. ไมบรรทัด    
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ภาพตัวอยาง 
การวาดภาพการเคลื่อนไหวโดยใชกฎพื้นฐาน 12 ขอของ Animation 

 
 
 

 
ครุภัณฑ/เครื่องมือ/วัสด/ุอุปกรณ  
 

1. ดินสอ  
2. กระดาษ  
3. ยางลบ    
4. ไมบรรทัด    
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ใบงาน 
 

หัวขอวิชา ขั้นตอนและกระบวนการ
สรางงาน 2D Animation 
รหัสวิชา 0922124507 
งานที่ 1 

 
   วิทยากร/ครูฝกกําหนดใหผูเขารับการฝกการวาดภาพการเคลื่อนไหว 3 ภาพ โดยใช 

กฎพื้นฐาน 12 ขอของ Animation 
 

ภาพตัวอยาง 
การวาดภาพการเคลื่อนไหวโดยใชกฎพื้นฐาน 12 ขอของ Animation 

 
 
 

 
ครุภัณฑ/เครื่องมือ/วัสด/ุอุปกรณ  

1. ดินสอ  
2. กระดาษ  
3. ยางลบ    
4. ไมบรรทัด    
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   วิทยากร/ครูฝกกําหนดใหผูเขารับการฝกการวาดภาพการเคลื่อนไหว 3 ภาพ โดยใช 

กฎพื้นฐาน 12 ขอของ Animation 
 

ภาพตัวอยาง 
การวาดภาพการเคลื่อนไหวโดยใชกฎพื้นฐาน 12 ขอของ Animation 

 

 
 
 
 
ครุภัณฑ/เครื่องมือ/วัสด/ุอุปกรณ  
 

1. ดินสอ  
2. กระดาษ  
3. ยางลบ    
4. ไมบรรทัด    
 
 
 
 

 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

57

57 
 

 

หลักสตูรการฝกยกระดับฝมือ 
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รหัสหลักสูตร 0920084210102 

ใบเตรียมการสอน 
(ทฤษฎี) 

หัวขอวิชา การพัฒนาบท 
Storyboard การวางมุมกลอง  
การออกแบบฉาก และระยะภาพ 
รหัสวิชา 0922124508 
หัวขอที่ 2 เวลา   2  ชั่วโมง 

วัตถุประสงค  :  เพื่อใหผูรับการฝกมีความรู ความสามารถในการพัฒนาบท Story Board การวางมมุกลอง  
การออกแบบฉาก และระยะภาพ 

วิธีการสอน  :  บรรยาย สาธิต และใหฝกปฏิบัต ิ
หัวขอสําคัญ :  1) การเลาเรือ่งดวยภาพ 

2) ขนาดภาพ 
3) มุมมองของภาพ 
4) การเคลือ่นกลอง 
5) เสียงบรรยาย 
6) บทสนทนา 
7) เสียงประกอบ 
8) ดนตรีประกอบ 

 อุปกรณชวยฝก :   
 
การมอบหมายงาน  : 
 
การวัดและประเมินผล  : 
 
หนังสอือางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครัง้ที่ 6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศร ี(2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชัน่. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครั้งที ่2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเด้ียนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรีเมียร. 
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เรื่องของภาพ  
 
การเลาเรื่องดวยภาพ 

การสือ่ความหมายแทนที่จะบรรยายดวยขอความเรากลบัใชภาพเปนตัวเลาเรือ่ง ดังนั้นการจัดลําดับภาพจะตอง
แสดงใหเห็นถึง ความตอเนือ่งของการกระทํา ( Action Continuity ) ซึ่งมหีลักการพื้นฐานสองขอคือ  

1. ถาวัตถุมีการเคลื่อนไหว จะตองคํานึงถึงความตอเนื่องของการกระทํา ( Action Continuity ) ซึ่งจะทําใหการ
เคลื่อนไหวน้ัน ไมผิดธรรมชาต ิ 

2. ถาวัตถุไมมีการเคลื่อนไหว สามารถนําภาพซึ่งเปนเหตกุารณในเวลาตอมามาใชได 
สมมุตเิหตุการณงายๆ สั้นๆ วา  “ออดไปโรงเรียนหลังจากรบัประทานอาหารเชา”   ดังนี้  
  

 
ใช loose-shot ใหบรรยากาศทั่วไปบนโตะอาหารกอน 

 
 
 
 

 

ออดกําลงัดื่มกาแฟ 
ใน close-up shot จึงไมตอเนือ่ง

กับ shot ขางหนา 

ใน close-up shot 
ตองใหเห็นการกระทําของออด 

ใน loose-shot อีกครั้ง 
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ถวยกาแฟที่วางเปลาถูกวางลงบนโตะ ภาพนิ่งของถวยกาแฟ 
แสดงถึงการลวงเลยของเวลา 

ภาพตอมาอาจเปนภาพออดเดินไป ใช long shot เปนภาพนิ่งใหเห็นประต ู
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ถากลองซูมจากประตูทางเขาโรงเรียนไปทีห่นาตาง 
ภาพของออดเดินไปโรงเรียนอาจตัดขามไป 

ภาพออดกําลังนัง่เรียนหนงัสอืในหองเรียน 
นํามาเชื่อมตอเขาได 

แลวตอดวยภาพครูกําลังสอนหนังสือ 
ซึ่งเปนมุมกลองจากสายตาของออด 
เรียกวา “reaction shot” 
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ขนาดภาพ 

หากเปรียบเทียบภาพที่ไดจากการชมภาพยนตรกับละครนั้นแตกตางกันมากมาย ในละครนั้นขึ้นอยูกบัวาคนดูนั่ง
อยูที่สวนใหญของโรง เชน ดานหนา ดานหลัง ดานขาง หรือดานบน ซึ่งจะใหภาพและมุมมองที่แตกตางกันออกไป ขณะที่
การชมภาพยนตร กลองเปนตัวกําหนดขนาดภาพไดหลายหลาก เชน ภาพระยะไกล (Long Shot) ระยะปานกลาง 
(Medium Shot) และระยะใกล (Close Up) เปนตน  

 
การกําหนดขนาดภาพในแตละช็อตเหลานี้ไมใชเปนเรือ่งงาย ซึ่งตองสอดคลองกับความหมายที่ตอง การสื่อ  

แตอยางไรก็ตาม ความหมายของภาพระยะใกลและระยะไกลของผูกํากบัคนหนึ่ง อาจมีความแตก ตางจากอีกคนหนึง่ 
นอกจากนี ้การใชภาพตองมีความสมัพันธเชื่อมตอกันไดเปนอยางด ีแมแตภาพยนตรกับโทรทัศนยังมีความแตกตาง 
กันอีกดวย  

 
โดยทั่วไปการกําหนดขนาดภาพนั้นไมมีกฎแนนอนที่ตายตัว ในหลักปฏิบัติแลวมกัใช 3 ขนาด คือ ขนาดภาพ

ระยะไกล ระยะปานกลาง และระยะใกล ดังที่ไดกลาวมาแลวเปนขนาดเรียกกวาง ๆ ที่เขียนไวในบทภาพยนตร ซึง่ ใช
รูปรางของคนเปนตัวกําหนดขนาดของภาพ แตอยางไรก็ตาม เราสามารถแบงยอยขนาดของภาพไดอีกและมีชื่อเรียก
ชัดเจนขึ้นดังนี ้

 
1.  ภาพระยะไกลมากหรือระยะไกลสุด (Extreme Long Shot / ELS) ไดแก ภาพที่ถายภายนอกสถานที่โลงแจง 

มักเนนพื้นที่หรือบริเวณที่กวางใหญไพศาล เมื่อเปรียบ เทียบกับสัดสวนของมนุษยที่มีขนาดเล็ก ภาพ ELS สวนใหญใช
สําหรับการเปดฉากเพือ่บอกเวลาและสถานที่ อาจเรียกวา Establishing Shot ก็ได เปนช็อตที่แสดงความยิ่งใหญของฉาก
หลงั หรือแสดงแสนยานุภาพของตัวละครในหนังประเภทสงครามหรือหนงัประวัติศาสตร สวนช็อตที่ใชตามหลงัมักเปน
ภาพระยะไกล (LS) แตในภาพยนตรหลายเรือ่งใชภาพระยะใกล (CU) เปดฉากกอนเพื่อเปนการเนนเรียกจุดสนใจหรือบบี
อารมณคนดูใหสูงขึ้นอยางทันทีทันใด  
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2.  ภาพระยะไกล (Long Shot /LS) ภาพระยะไกล เปนภาพที่คอนขางสบัสนเพราะมีขนาดที่ไมแนนอนตายตวั 

บางครัง้เรียกภาพกวาง (Wide Shot) เวลาใชอาจกินความตัง้แตภาพระยะไกลมาก (ELS) ถึงภาพระยะไกล (LS) ซึ่งเปน
ภาพขนาดกวางแตสามารถเห็นรายละเอียดของฉากหลงัและผูแสดงมากขึ้น เมื่อเปรียบเทียบกบัภาพระยะไกลมาก หรอื
เรียกวา Full Shot เปนภาพกวางเห็นผูแสดงเต็มตวั ตั้งแตศีรษะจนถึงสวนเทา 

ภาพระยะไกล (LS) บางครัง้นําไปใชเปรียบเทียบเหมือนกับขนาดภาพระหวางหนงักับละครที่คนดูมองเปนเทากัน 
คือ สามารถเห็นแอ็คช่ันหรอือากปักริยาของผูแสดงเต็มตัวและชัดเจนพอ ซึ่งเปนที่ทราบกันดีวาหนงัของชารลี แชปลิน 
(Charlie Chaplin) มักใชขนาดภาพนี้กับภาพปานกลาง (MS) ถายทอดอารมณตลกประสบความสําเร็จในหนังเงียบ 
ของเขา  

 
3.  ภาพระยะไกลปานกลาง (Medium Long Shot / MLS) เปนภาพทีเ่ห็นรายละเอียดของผูแสดงมากขึ้นตั้งแต

ศีรษะจนถึงขา หรือหัวเขา ซึง่บางครั้งกเ็รียกวา Knee Shot เปนภาพที่เห็นตัวผูแสดงเคลื่อนไหวสมัพันธกับฉากหลังหรอื
เห็นเฟอรนเิจอรในฉากนั้น  

 
4.  ภาพระยะปานกลาง (Medium Shot /MS) ภาพระยะปานกลาง เปนขนาดทีม่ีความหลากหลายและมีช่ือ

เรียกไดหลายชื่อเชนเดียวกัน แตโดยปกติจะมีขนาดประมาณต้ังแตหนึ่งในสี่ถงึสามในสี่ของรางกาย บางครัง้เรียกวา Mid 
Shot หรือ Waist Shot ก็ได เปนช็อตที่ใชมากสดุอันหนึ่งภาพยนตร  

ภาพระยะปานกลางมักใชเปนฉากสนทนาและเห็นแอ็คชั่นของผูแสดง นิยมใชเชื่อมเพื่อรักษาความตอเนื่องของ
ภาพระยะไกล (LS) กับภาพระยะใกล (CU)  
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5.  ภาพระยะใกลปานกลาง (Medium Close-Up / MCU) เปนภาพแคบ คลอบคลุมบริเวณตั้งแตศีรษะถงึไหล

ของผูแสดง ใชสําหรับในฉากสนทนาทีเ่ห็นอารมณความรูสึกที่ใบหนา ผูแสดงรูสกึเดนในเฟรม บางครัง้เรียกวา Bust Shot 
มีขนาดเทารปูปนครึ่งตัว  

 

 
6.  ภาพระยะใกล (Close-Up / CU) เปนภาพที่เห็นบรเิวณศีรษะและบรเิวณใบหนาของผูแสดง มีรายละเอียด

ชัดเจนขึ้น เชน ริ้วรอยบนใบหนา น้ําตา สวนใหญเนนความรูสึกของผูแสดงที่สายตา แววตา เปนช็อตที่นิง่เงียบมากกวาให
มีบทสนทนา โดยกลองนําคนดูเขาไปสํารวจตัวละครอยางใกลชิด  

 

 
7.  ภาพระยะใกลมาก (Extreme Close-Up /ECU หรือ XCU)  เปนภาพที่เนนสวนใดสวนหนึ่งของรางกาย เชน 

ตา ปาก เทา มือ เปนตน ภาพจะถูกขยายใหญบนจอ เห็นรายละเอียดมาก เปนการเพิ่มการเลาเรื่องในหนังใหไดอารมณ
มากขึ้น เชน ในช็อตของหญิงสาวเดินทางกลบับานคนเดียวในยามวิกาลบนถนน เราอาจใชภาพ ECU ดานหลงัทีหู่ของเธอ
เพื่อเปนการบอกวาเธอไดยินเสียงฝเทาแผว ๆ ที่กําลังติดตามเธอ  จากนั้นอาจใชภาพระยะนี้ที่ตาของเธอเพื่อแสดงความ
หวาด กลัว เปนช็อตที่เราคุนเคยกัน แตอยางไรก็ตาม เราสามารถใชไดในความหมายอื่น ๆ โดยอาศัยแสงและมุมมองเพือ่
หารูปแบบการใชใหหลากหลายออกไป  
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มุมมองของภาพ 

มุมมองภาพ หมายถึง จุดดูภาพทีป่รากฏบนจอภาพยนตรและจอโทรทัศน ผูกํากบัจะกําหนดวาจะเสนอภาพจาก
มุมใด คือใหผูดูมองเห็นภาพจากมุมใดจึงจะนาสนใจและสมจริงกับเรื่องราวทีเ่สนอ มุมมองภาพหรือที่นิยมเรียกวามุมกลอง
โดยทั่วไปจะประกอบดวย 3 มุม ไดแก  

1. มุมสูง (High Angle)  
ตั้งกลองถายภาพยนตรและโทรทัศนไวสูงกวาวัตถุ ถาเปนภาพสถานที่กวางใหญ การถายภาพไกลจากมุมสูงทําให

เห็นภาพไดกวางไกล เปนการเปดฉากแนะนําสถานที่ไดเปนอยางดี แตถาเปนการถายคน จะเปนการเสนอใหเห็นวาคนๆ 
นั้นไมสําคัญ เปนคนต่ําตอย ไมสงาผาเผย  

2. ภาพมุมระดับสายตา (Eye Level Angle)  
เปนภาพที่ตั้งกลองในระดับสายตาของคน หรือของวัตถุที่ถูกถาย ภาพในระดับสายตาเพื่อสื่อความหมายวาภาพที่

ปรากฏจะเปนภาพใหความรูสึกธรรมดา ไมเดนอะไร  
3. ภาพมุมต่ํา (Low Angle)  
เปนภาพที่ตั้งกลองถายในระดบัต่ํากวาคนหรอืวัตถุที่ถูกถาย เปนภาพที่แหงนด ูสื่อความหมายหรือใหเกิด

ความรูสึกวาคนหรือวัตถุที่ถูกถายมีความสําคัญมากกวาปกต ินาเคารพ นับถือ  
 
มุมกลอง  

มุมกลองเกิดข้ึนจากการทีเ่ราวางตําแหนงคนดูใหทํามุมกับตวัละครหรือวัตถ ุทําใหมองเห็นตัวละครในระดบัองศา
ที่แตกตางกัน จงึแบงมุมกลองได 6 ระดับ คือ  

1.  มุมสายตานก (Bird’s-eye view) มุมชนิดน้ีมักเรียกทับศัพททําใหเขาใจมากกวา เปนมุมถายมาจากดานบน
เหนือศรีษะ ทํามุมตั้งฉากเปนแนวดิ่ง 90 องศากับผูแสดง เปนมุมมองทีเ่ราไมคุนเคยในชีวิตประจําวัน จงึเปนมุมที่แปลก 
แทนสายตานกที่อยูบนทองฟาหรือผูกํากบับางคน เชน Alfred Hitchcock ใชแทนความหมายเปนมุมของเทพเจาเบื้องบน
ที่ทรงอํานาจ มองลงมาหาตัวละครที่หอยอยูบนสะพาน ตึก หนาผา เพิม่ความนาหวาดเสียวมากขึ้น มุมกลองที่คลายกบัมุม 
Bird’s-eye view คือ aerial shot ซึ่งถายมาจากเฮลิคอปเตอรหรือเครื่องบินบางก็เรียกวา helicopter shot หรือ 
airplane shot เปนช็อตเคลื่อนไหวถายมาจากดานบนทัง้สิน้  
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2.  มุมสูง (High-angle shot) คือ มุมสงูกลองอยูดานบนหรอืวางไวบนเครน (crane) ถายกดมาทีผู่แสดง แตไม

ตั้งฉากเทา Bird’s-eye view ประมาณ 45 องศา เปนมุมมองที่เห็นผูแสดงหรอืวัตถุอยูตํ่ากวา ใชแสดงแทนสายตามองไป
เบื้องลางที่พื้น ถาใชกับตัวละครจะใหความรูสกึต่ําตอย ไรศักดิ์ศรี ไมมีความสําคัญ หรือเพื่อเผยใหเห็นลักษณะภูมปิระเทศ
หรือความกวางใหญไพศาลของภูมิทัศนเมื่อใชกับภาพระยะไกล (LS) 

 
3.  มุมระดับสายตา (Eye-level shot) เปนมุมทีม่ีความหมายตรงตามชื่อทีเ่รียก คือคนดูถูกวางไวในระดับ

เดียวกับสายตาของตัวละครหรอืระดบัเดียวกบักลองที่วางไวบนไหลของตากลอง โดยผูแสดงไมเหลือบสายตาเขาไปใน
กลองในระหวางการถายทํา มุมระดบัสายตานี้ถึงแมจะเปนมมุที่เราใชมองในชีวิตประจําวัน แตก็ถือวาเปนมมุที่สงูเล็กนอย 
เพราะโดยปกตมิักใชกลองสงูระดับหนาอก ซึ่งเรียกวา a chest high camera angle หรอืเปนมุมปกติ (normal camera 
angle) ไมใชมุมระดับสายตา ซึ่งเปนมุมที่คนดูคุนเคยกบัการดูหนังบนจอใหญที่ถายดาราภาพยนตรใหดูใหญเกินกวาชีวิต
จริง larger-than-life  

ในความหมายอื่นของมมุระดบัสายตาในหนังคาวบอย (Western) หมายถึง เปนมุมของลูกผูชาย (standing 
male adults) จึงวางตําแหนงของผูแสดงที่ดสูงางาม แตผูกาํกับหญิงชาวฝรัง่เศสชื่อ Chantal Akerman เปนคนรปูราง
คอนขางเตี้ย ใชมุมกลองระดับสายตาเดียวกับเธอแทนความเปน “ผูหญงิ” ในมุมมองของกลองถายทําหนังสวนใหญของ
เธอ ในขณะที่ Yasujiro Ozu ผูกํากบัชาวญี่ปุน ปฏิเสธที่จะใชกลองทํามุมกบัผูแสดง แตใชกลองระดบัสายตามีความสูง
ประมาณ 3-4 ฟุต สูงจากพื้นเปนระดบัเดียวกับรูปแบบการนั่งแบบญี่ปุนในบานของตัวละคร Ozu ใหเหตผุลวา “เขา
ตองการใหตัวละครนั้นมีความเทาเทียมกัน เปนแคคนธรรมดาคนหนึ่ง ไมวาจะเปนคนดีหรอืเลว โดยจะใหตัวละครเปดเผย
ตัวเอง ไมใชมุมกลองอธิบายใหรูสึกอยางใดอยางหนึ่งโดยเปนตัวกลาง ไมมีอคต ิเทากบัเปนการใหคนดูไดตัดสินใจเอาเอง
วาตัวละครนั้นเปนคนอยางไรในหนงั”  

4.  มุมต่ํา (Low-angle shot) คือ มุมที่ต่ํากวาระดับสายตาของตัวละคร แลวเงยกลองขึ้นประมาณ 70 องศา ทํา
ใหเกิดผลทางดานความลึกของซบัเจ็คหรือตัวละคร มีลักษณะเปนสามเหลี่ยมรูปทรงเรขาคณิตใหความมั่นคง นาเกรง
ขาม   ทรงพลังอํานาจ ความเปนวีรบรุุษ เชน ช็อตของคิงคอง ยักษ ตึกอาคารสิง่กอสราง สัตวประหลาด พระเอก เปนตน  

ในภาพยนตรเรื่อง Citizen Kane (1941) ที่ตองการเนนความร่ํารวยของ Kane จึงใชกลองมุมต่ําเพื่อใหเห็นพื้น
หลงัที่เปนเพดาน บอกถึงความโออา มั่งคั่งของเจาของคฤหาสถ การถายทําตองรื้อพื้นเอาบางสวนของฉากออกเพื่อ
สามารถวางกลองไดมุมต่ําตามที่ตองการ  
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5.  มุมสายตาหนอน (Worm’s-eye view) คือ มุมที่ตรงขามกับมมุสายตานก (Bird’s-eye view)  กลองเงยตั้ง

ฉาก 90 องศากับตัวละครหรือซับเจ็ค บอกตําแหนงของคนดูอยูตํ่าสุด มองเห็นพื้นหลงัเปนเพดานหรอืทองฟา เห็นตัว
ละครมลีักษณะเดน เปนมมุที่แปลกนอกเหนือจากชีวิตประจาํวันอีกมุมหนึง่  

ลักษณะของมมุนี ้เมื่อใชกบัซบัเจ็คที่ตกลงมาจากทีสู่งสูพื้นดนิ เคลื่อนบงัเฟรม อาจนําไปใชเปนตัวเชื่อมระหวาง
ฉาก (transition) คลายการเฟดมืด (Fade out)  

6.  มุมเอียง (Oblique angle shot) เปนมุมทีม่ีเสนระนาบ (Horizontal line) ของเฟรมไมอยูในระดับสมดลุ 
เอียงไปดานใดดานหนึง่เขาหาเสนตั้งฉาก (Verticle line) ความหมายของมุมชนิดน้ีคือ ความไมสมดุลลาดเอียงของพื้นที่ 
บางสิง่บางอยางที่อยูในสภาพไมดี เชน ในฉากชุลมุนโกลาหล แผนดินไหว ถาใชแทนสายตาตัวละคร หมายถึงคนที่เมา
เหลา หกลม สบัสน ใหความรูสึกที่ตึงเครียด  

มุมเอียงเปนมุมที่ไมคอยใชบอยนัก สวนใหญใชตามความหมายที่อธิบายในภาพยนตรและมีชื่อเรียกหลายอยาง 
เชน Dutch angle, Tilted shot หรือ Canted shot เปนตน  
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นอกจากนี้ยงัมีมมุกลองอื่นที่สําคัญควรทราบดังนี ้ 

1.  มุมเฝามอง (Objective Camera Angle) คือ มุมแอบมองหรือเฝามองตัวละคร แอ็คชั่นและเหตกุารณทีก่ําลัง
เกิดข้ึนในหนัง เปนมมุเดียวกับกลองแตมองไมเห็นคนด ูซึ่งคนดูจะอยูหลังกลองโดยผานสายตาของตากลอง หรอืบางทีเปน
การถายโดยคนแสดงไมรูตัว เรียกวา การแอบถาย (candid camera)  

2.  มุมแทนสายตา (Subjective Camera Angle) เปนมมุมองสวนตัว หรือเรียกวา มุมแทนสายตา ซึ่งเปนการ
นําพาคนดูเขามามีสวนรวมในภาพดวย เชน ผูแสดงมองมาทีก่ลอง ซึ่งจะใหความรูสึกเหมือนมองไปที่คนดหูรือพูดกับกลอง 
เชน การอานขาว การรายงานขาวในทีวี เปนตน ลักษณะของมุมกลองชนิดนี ้เปนความสัมพันธกันระหวางสายตาตอ
สายตา (eye-to-eye relationship)  มุมแทนสายตา แบงเปน 

2.1  แทนสายตาคนด ูเปนการกําหนดตําแหนงคนดูใหเปนสวนหนึ่งของฉากนั้น เชน คนดูถูกพาใหเขาชม
โบราณสถาน พาที่ยว คนดูจะไดเห็นเหตุการณของแตละฉาก หรือกลองอาจถูกทิ้งมาจากทีส่งู แทนสายตามาจากทีสู่ง 
แทนคนดูตกลงมาจากที่สงู ภาพแทนสายตาของนักบิน รถแขง พายเรือ ดําน้ํา สกี รถไฟเหาะตลีังกา  

2.2 กลองแทนสายตาตัวละคร เปนการเปลี่ยนสายตาของคนดูจากการเฝาแอบมองมาเปนแทนสายตาในทันท ีซึ่ง
คนดูก็ไดเห็นรวมกันดับตัวละครหรือผูแสดง เชน ตัวละครมองออกไปนอกกรอบภาพ จากนั้นภาพตัดไปเปนมุมแทนสายตา
ของตัวละคร การแพนช็อตหรอื traveling shot ในภาพยนตรสารคดีสวนใหญ กลองมักทําหนาที่แทนสายตาของคนด ู 

3.  มุมมองใกลชิด (Point-of-view Camera Angles) มุมมองใกลชิดนี้มกัเรียกงาย ๆ วา มุมพีโอวี (POV) เปน
มุมกึ่งระหวาง มุม objective และมุม subjective แตอยางไรก็ตาม เราก็ถือวาเปนมมุ objective หรอืมุมแอบมอง และ
สวนใหญขนาดภาพที่ใชมักเปนภาพระยะใกลกับระยะปานกลาง เพื่อใหสามารถมองเห็นภาพแสดงออกของใบหนาตัว
ละคร เห็นรายละเอียดชัดเจน  

การใชมุมพีโอวีน้ี อาจใชสําหรับกรณีที่ตองการใหคนดูเขาไปมีสวนในเหตกุารณดวย นอกจากนีก้ารใชมุมพีโอวี ยัง
มักตามหลังช็อตผานไหล หรือ over-the-shoulder (OS) คือเมื่อผูแสดงคนหนึ่งจะเห็นดานหลงัเปนพื้นหนา และใบหนา
ของผูแสดงอีกคนหนึ่งอยูพื้นหลังหรืออาจใชกอนมมุแทนสายตาของนัก แสดง เปนตน  

การใชมุมกลองตองคํานึงถึงพื้นที่ (space) และมมุมอง (viewpoint) ซึ่งตําหนงของกลองเปนตัว กําหนดพื้นที่วา
จะมีขอบเขตเพียงใดจากที่ซึง่คนดูมองเห็นเหตุการณ ซึ่งตองสัมพันธกันทัง้หมด ทั้งขนาดภาพ มุมมอง และความสงูของ
กลอง 
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การเคลื่อนกลอง 

การเคลื่อนไหวกลองในระหวางการถายทําจะชวยเพิ่มความนาสนใจและแสดงเรือ่งราว ความหมายไดดี
นอกเหนอืจากตัววัตถุเคลือ่นไหวหรืออาจเคลือ่นไหวทั้ง 2 อยาง พรอมๆ กัน การเคลื่อนไหวของกลองมหีลายแบบ ดังนี ้

 
การแพนกลอง (Panning) หมายถึง การเคลื่อนที่ของกลองตามแนวนอนไปทางซาย (Pan left) หรือไปทางขวา 

(Pan right) เพื่อใหเห็นวัตถุตามแนวกวาง หรือเมื่อตองการนําผูชมไปยังจุดนาสนใจ หรือที่ตองการ 
- เพื่อใหเห็นภาพที่อยูนอกจดภาพในขณะนั้น 
- เพื่อตองการติดตามการเคลื่อนไหววัตถ ุ
- เพื่อใหเห็นปฏิกิริยาตอบโตกัน 
- เพื่อตองการการเปลี่ยนฉาก 
 
 

ภาพตัวอยางแสดงการเคลือ่นของกลอง 
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การทิล้ท (Tilting) หมายถึง การเคลื่อนกลองตามแนวดิ่ง จากลางขึ้นบน (Tilt Up) และจากบนลงลาง  

(Tilt Down) เพื่อใหเห็นวัตถุตามแนวต้ังเชน ภาพอาคารสงู หรือนําผูชมไปยังจุดที่ตองการ 
- เพื่อใหเห็นตําแหนงที่ตั้งของสิ่งตางๆ โดยสมัพันธกัน 
- เพื่อใหเห็นวัตถุที่ยาวหรือสูงเกินรัศม ี
- เพื่อตองการปรบัองคประกอบภาพ 
 

ภาพตัวอยางการเคลื่อนกลองตามแนวดิ่ง 
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การซูม (Zooming) หมายถึง การเปลี่ยนขนาดของวัตถุใหใหญขึ้น (Zoom In) หรือเปลี่ยนขนาดของวัตถุ 

ใหเลก็ลง (Zoom Out)  
- เพื่อตองการเปลี่ยนขนาดของวัตถุอยางชาๆ 
- เมื่อตองการใหผูชมสนใจวัตถุนั้น 
- เมื่อตองการใหเห็นวัตถุอยางชัดเจน 
- เพื่อใหบังเกิดผลที่นาตื่นใจ 
 

ภาพการซูม 
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การดอลลี่ (Dolling) หมายถึง การเคลื่อนกลองติดตาม ความเคลื่อนไหวของสิง่ที่ถาย หรือฉากทีม่ีระยะทางยาว

ในทิศทางตรง หรือทางออมไปรอบๆ การเคลื่อนไหวกลองเขาหาวัตถุ เรียกวา Dolly in และการเคลือ่นไหวกลองออกจาก
วัตถุ เรียกวา Dolly out ผลของการดอลลี่ (Dolly) จะคลายซูม (Zoom) คือขนาดของวัตถุจะเปลี่ยนแปลงไปตาระยะของ
การดอลลี่ แตจะแตกตางกันตรง สวนประกอบตางๆ ในภาพเกี่ยวกับระยะทางระหวางวัตถุกับฉากหนาและฉากหลัง จะ
เปลี่ยนแปลงไปตามการเคลื่อนไหวของกลอง คนดูจะสามารถรูถึงมิติของความลึกมากกวาภาพที่เกิดจากการซูม 

- เพื่อสรางความตื่นเตน 
- เมื่อตองการติดตามการเคลื่อนไหว 
- เพื่อใหมีมมุมองภาพที่หลากหลายแบบ 
- เมื่อตองการปรับเปลี่ยนองคประกอบภาพ 
 

ภาพการเคลือ่นกลองติดตาม ความเคลือ่นไหวของสิ่งที่ถาย 
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การทรัค (Trucking / Tracking ) หมายถึง การเลือ่นไหวกลองไปดานซายใหขนานกบัวัตถุไปทางซาย หรือไป

ทางขวา ซึ่งผลจะคลายกบัการแพน แตการทรัคจะชวยใหเกดิการเปลี่ยนแปลงมิติเรื่องความลึกของ ภาพไดดีกวา คลายๆ 
กับความรูสึกของเราที่มองออกไปนอกหนาตางรถขณะทีเ่คลือ่นที่ไป  
 
 

ภาพการเลื่อนไหวกลองไปดานซายใหขนานกบัวัตถุ 
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การอารค (Arking) หมายถึง การเคลื่อนไหวกลองในแนวเฉียงเปนรูปครึ่งวงกลม ไปทางซาย (Ark left) หรือ ไป

ทางขวา (Ark right) เพื่อเปลี่ยนมุมกลองไปทางดานขางของวัตถุ 
 

ภาพการเคลือ่นไหวกลองในแนวเฉียงเปนรูปครึ่งวงกลม 
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การบมู หรือเครน (Booming / Craning) หมายถึง การถายภาพพรอมกบัขาตั้งกลองในแนวตั้ง เรียกวา ‘บูม’ ถา

เคลื่อนขึ้น เรียกวา Boom Up สวนเลือ่นลง เรียกวา Boom Down และถาเคลือ่นกลองขึ้นลงโดยใชเครน เรียกวา Crane 
Up และ Crane Down เมื่อตองการเคลื่อนกลองลงดวยเครน วัตถุประสงคเพื่อตองการคงมุมกลองที่ตองการจากมมุสงู
และต่ําอยางตอเนื่อง ดังภาพบนที่แสดงการบูม และภาพลางที่แสดงสตลิช็อต 

 
 

สติลช็อต (Still Shot) หมายถึง การถายภาพโดยไมเคลื่อนกลอง ใชมากในการถายทํารายการทั่วไป โดยปกติ
กลองจะโฟกสัอยูบนวัตถุหรือบุคคลที่ตองการออกอากาศมากที่สุด ในการถายแบบนี้จําเปนตองจัดองคประกอบภาพใหด ี
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สื่อสารดวยเสยีง  
 

บันทึกเสียง ( Sound Recording )  
หลงัจากที่เราไดออกแบบตัวละครและสรางสตอรีบอรดเรียบรอยแลว เรากจ็ะเขาสูขั้นตอนของการอัดเสียง ซึง่

เปนสิ่งทีห่ลกีเลี่ยงไมไดอยางยิง่ บางสตูดิโออาจจะเริ่มตนดวยการอัดเสียง Soundtrack กอน ซึ่งการอัดเสียงประกอบ
แอนิเมชันจะแยกออกเปนประเภทของเสียงโดยหลักแลวจะมีดังนี้คือ  
 

เสียงบรรยาย ( Narration )  
เสียงบรรยาย คือ เสียงพูดที่ใชบรรยายประกอบภาพโดยบันทึกเสียงในหองอัดเสียงหรือใชสถานทีเ่งียบๆก็ได 

เสียงประเภทนีผู้ชมจะไดยินเฉพาะเสียงของผูบรรยาย (narrator) หรือผูประกาศ (announcer) โดยไมเห็นหนาอยาง
เสียงพูด/สนทนา เชน การบรรยายสารคดี การบรรยายรายการถายทอดสด และการบรรยายรายการกีฬา เปนตน ถา
ผูหญิงบรรยายจะเขียนในบทวา “เสียงบรรยายหญิง” (female voice-over or FVO) สวนผูชายบรรยายใชคําวา “เสียง
บรรยายชาย” (male voice-over or MVO) 

 
การบรรยายโดยปกติทั่วไป ผูบรรยายมกัไดรับบทมาใหซอมอานกอนลวงหนาเพือ่ทําความเขาใจกับบท เมื่อถงึ

เวลาบันทกึเสียงผูใหเสียงบรรยายก็จะอานขอความไปตามบทที่ไดรับมา เราเรียกการบรรยายทั่วไปในลกัษณะนี้วา การลง
เสียงบรรยายปกติ (narration) เชน การอานบรรยายรายการสารคดีตางๆ แตในกรณีทีเ่ปนการบรรยายแบบไมสามารถทํา
บทลวงหนาไดทั้งหมด ไดแก การบรรยายถายทอดสดงานพระราชพิธี การบรรยายรายการถายทอดสดการแขงขันกีฬา 
ฯลฯ การบรรยายประเภทนี้มกัเรียกวา “การบรรยายสด” หรือ “การบรรยายเหตกุารณสด” (commentary) ซึ่งตอง
อาศัยผูบรรยายทีม่ีประสบการณและความรูความเชี่ยวชาญเฉพาะดานในเรื่องนั้นๆอยางมาก 

 
เสียงบรรยายเปนสวนสําคัญในการสรางความเขาใจ เปนการปูพื้นฐานใหกับผูชมวาเรื่องเปนอยางไร และยังเปน

การเชื่อมโยงใหเรือ่งราวติดตอกันดวย  
 
การบรรยายไมใชการบรรยายภาพ แตเปนการบรรยายเสริมภาพ เนื้อหาของคําบรรยายควรมีความยาวนอยกวา

ความยาวของภาพ และมเีนื้อหาสอดคลองกันทั้งเรื่อง  
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บทสนทนา ( Dialogue ) 
เปนหลักการหนึ่งในการสื่อเรือ่งราวตามบทบาทของตัวละคร เปนการสือ่ความหมายใหตรง ตามเนื้อเรื่องทีส่ั้น 

กระชับ และสัมพันธกับภาพ  
 
- คําสนทนา ถามีความยาว แตมีเนื้อหานาสนใจ ควรหาภาพแทรกระหวางคําสนทนา  
 
- คําสนทนาตองตรงประเด็นเนือ้หาของภาพที่นํามาแทรก  
 
- รายการที่ไมใชรายการสนทนา หรือละคร ควรแบงชวงคําสนทนาออกเปนชวงๆ 
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เสียงประกอบ ( Sound Effects ) 
เปนเสียงที่นอกเหนือจากบรรยาย เสียงสนทนา เสียงประกอบจะทําใหเกิดรูสึก สมจริงสมจัง มจีินตนาการเชน 

เสียงระเบิด เสียงฟารอง เปนตน ราวกับไดเขาไปอยูในเหตุการณหรอืสถานที่นั้นดวย  
 
เสียงประกอบอาจเปนเสียงที่ไปบันทึกมาจากของจริงตามธรรมชาติ หรือใชการประดิษฐเสียงเลียนแบบธรรมชาติ

หรือสรางจินตนาการภายในสตูดิโอเสียงก็ได เสียงประกอบกลุมนี้ ไดแก เสียงปดประตู เสียงกดกริง่ เสียงแมวรอง เสียง
ตอกตะปู เสียงรถแลน เสียงหรีดหริง่เรไร เสียงคนถูกชก และเสียงไฟลามหญาแหง เปนตน โดยสวนใหญมักเลือกใสเสียง
ประกอบเขาไปในจุดตางๆ (spot effect) ใหสอดคลองกบัภาพที่ปรากฏอยู  

 
- เสียงประกอบทีเ่กิดข้ึนจริงตามธรรมชาติขณะถายทํา จะตองทําการบันทกึเสียงนั้นทันทีพรอมกบัภาพ 
 
- เสียงประกอบทีส่รางเลียนแบบเสียงธรรมชาต ิในกรณีทีเ่ราไมสามารถใชเสียงธรรมชาติได เราอาจสรางเสียง

ประกอบขึ้นเองโดยใชอุปกรณทางอิเล็กทรอนกิส  
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ดนตรีประกอบ ( Music ) 
เสียงดนตรีมีแหลงกําเนิดจากเครื่องเลนดนตรีชนิดตางๆเพื่อสรางเปนทวงทํานองตางๆ โดยอาจมเีนื้อเพลงหรือ 

ไมมีก็ได 
 
เสียงดนตรีที่ใชอาจหมายถึง ทัง้ดนตรทีี่มีเนือ้รอง และไมมเีนื้อรอง จะตองเลอืกใหเหมาะสมกับเนื้อหา คือ ให

ดนตรีเพื่อเสริมอารมณของเรือ่ง เพราะเสียงดนตรีจะชวยสรางอารมณของผูชมใหคลอยตามเนื้อหาและปรบัอารมณของ
ผูชมระหวางการเชื่อมตอของฉากหนึ่งไปยงัอีกฉากหนึ่งไดดวย  
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ความรูพื้นฐาน เรื่องการบันทึกเสียง 
 
Digital Audio  

Audio แปลวาการไดยิน เสียงพูด หรือเสียงที่ไดจากการสังเคราะหขึ้นโดยเครื่องดนตร ีคุณสมบัติของเสียง
นั้น ทางฟสิกสถือวาเสียงเปนคลื่น (wave) อันเกิดจาก การเปลี่ยนแปลงความกดดันของอากาศจากการสั่นของ
แหลงกําเนิด 

 
คุณสมบัติของเสียง 

- ความถี ่ (frequency) เชน เสียงสูงหรือเสียงต่ํา  
- ระดับความดัง  (Amplitude)  เชน เสียง เบา - คอย - ดัง - ดังมาก - ดังมากๆ  
- รูปแบบของคลื่น (wave from)  ซึ่งมีหลายรูปแบบขึ้นอยูกับแหลงกําเนิดเสียง ตามรูป 
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คําวา "ดิจิทลั" มาจากภาษาละตินวา  digit  มีความหมายวา นิ้ว ซึ่งหมายถึงการนบันิ้วซึ่งเปนคาที่ไมตอเนื่อง  

เปนระบบที่ใชคาตัวเลขโดยเฉพาะเลขฐานสอง สําหรับการสงผานขอมลู ประมวลผล เก็บขอมูล หรือการแสดงผล โดยคา
ในการจัดเก็บของดิจทิัลจะเก็บเปนคาใดคาหนึ่งในระหวางสองคา คือ คา 1 (คาสัญญาณ) และ คา 0 (คาไมมีสัญญาณ) 
แตกตางกับระบบแอนะล็อกที่ใชคาตอเนือ่งของขอมูลในการทํางาน ขอแตกตางที่เห็นไดชัดของระบบดจิิทลัและ 
ระบบแอนะล็อกสามารถกลาวถึงไดจากการสงผานขอมลูและการจัดเกบ็ขอมลู 
 

คําวาดิจิทัลมักจะใชในทางคอมพิวเตอร และทางอิเล็กทรอนกิส โดยเฉพาะอยางยิ่งการนําคาใด ๆ เก็บเขาสูระบบ
คอมพิวเตอรหรอือิเล็กทรอนกิสในสื่อตางๆ และเมื่อบันทึกเสียงเขาไปจัดเก็บในคอมพิวเตอร มันจึงเปน Digital Audio  
ไปโดยปริยาย 
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การเตรียมอุปกรณสําหรับการบันทึกเสียง 

  
1. เครื่องคอมพิวเตอร  
  
2. ไมโครโฟน  

          
 
3. Line in สําหรบันําเขาเสียงจาก อุปกรณเลนเสียงอื่นๆ เชน  เครื่องเลน mp3  
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การตั้งคาใหระบบคอมพิวเตอร 

1. เริ่มจากการมองหาสัญลักษณน้ี   ที ่Taskbarของวินโดวส และทําการกดดบัเบิล้คลกิ  ซึ่งจะเกิดเปน
หนาตางตามรูปดานลางนี ้ ซึ่งเปนสวนของการปรบั Volume Control  ตามรูป  

 
 

 
 

 
หนาจอสวนที่เห็นนี ้เปนสวนของ กับปรบัสัญญาณ Playback  หรือ การปรบัเสียงที่ออกมาจากเครื่องใหไดยิน 
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2. ลําดับตอไปกเ็ลอืกกดทีเ่มน ูoptions และเลือกที ่Properties แลวปรบัระดบัตางๆ ตามรูป 
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3. ทําการสลับมาปรับสวนของการ Recording โดยเลือกกดที่ Recording แลวเลือก การบันทึกเสียงตามรูป 

โดยหลกัๆ จะม ีStereo Mix , Line in , Microphone , ไมโครโฟนดานหลัง  เปนตน 
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4. ในรูปตัวอยางดานลางนี ้ไดเลือกที่ไมโครโฟนดานหลัง เพราะตอสายสัญญาณไมโครโฟนเขากบัชองตอ

ไมโครโฟนดานหลังไว 
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   คําช้ีแจง แบบทดสอบมีทั้งหมด 2 ตอน 
   ตอนที่ 1 เขียนเคร่ืองหมาย ลอมรอบตัวอักษรหนาคําตอบที่ถูกตอง 

1. การจัดลําดับภาพจะตองแสดงใหเห็นถึงอะไร 
ก ดานหนา หรือ ดานหลัง 
ข ดานขาง หรือ  ดานบน 
ค ความตอเนื่องของการกระทํา 
ง ความหมายของภาพระยะใกลและระยะไกล 

2.  คือระยะภาพตามขอใด 
ก Long Shot /LS 
ข Close-Up / CU 
ค Medium Shot /MS 
ง Extreme Close-Up /ECU 

3.  คือระยะภาพตามขอใด 
ก Close-Up / CU 
ข Medium Shot /MS 
ค Extreme Close-Up /ECU 
ง Medium Long Shot / MLS 

4. มุมกลองโดยทั่วไปจะประกอบดวยทั้งหมดกี่มุม 
ก 3 มุม   ข  4 มุม 
ค 5 มุม   ง  6 มุม 

5. ขอใดเหมาะกบัการเปดฉากแนะนําสถานที่ไดเปนอยางด ี
ก High Angle  ข Low Angle 
ค Eye Level Angle ง  ถูกทุกขอ 
 

6. มุมพีโอวี (POV) เปนมมุกึ่งระหวาง มุมในขอใด 
ก มุม objective และ มุม viewpoint 
ข มุม objective และ มุม subjective 
ค มุม viewpoint และ มุม objective 
ง มุม Point-of-viewและ มุม subjective 

7. ขอใดคือ การแพนกลอง (Panning)  
ก การเปลี่ยนขนาดของวัตถ ุ
ข การเคลื่อนไหวกลองในแนวเฉียง 
ค การเคลื่อนที่ของกลองตามแนวนอน 
ง การเคลื่อนกลองตามแนวดิ่ง จากลางขึ้นบน 

8. ขอใดคือ การทิ้ลท (Tilting) 
ก การเคลือ่นกลองตามแนวกวาง 
ข การเคลื่อนไหวกลองออกจากวัตถุ 
ค การเคลื่อนที่ของกลองตามแนวนอน 
ง การเคลื่อนกลองเพื่อใหเห็นวัตถุตามแนวตั้ง 

9. ขอใดคือ การซมู (Zooming) 
ก การเคลือ่นไหวกลองออกจากวัตถ ุ
ข การเคลื่อนไหวกลองคลายกบัการแพน 
ค การเปลี่ยนขนาดของวัตถุใหเล็ก - ใหญ 
ง การเปลี่ยนมุมกลองไปทางดานขางของวัตถุ 

10. ขอใดคือ การดอลลี่ (Dolling) 
ก การเปลี่ยนขนาดของวัตถ ุ
ข การเคลื่อนไหวกลองในแนวเฉียง 
ค การเคลื่อนไหวกลองในแนวนอน 
ง การเคลื่อนไหวกลองออกจากวัตถ ุ
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   ตอนที่ 2 กําหนดใหเขียนบทนิทานสั้น 1 เร่ือง แลววาด Storyboard การวางมุม

กลองและการกํากับภาพใหถูกตองตามขั้นตอน (ตามหลักทฤษฎ)ี 
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1. การจัดลําดับภาพจะตองแสดงใหเห็นถึงอะไร 

ค ความตอเนื่องของการกระทํา 

2.  คือระยะภาพตามขอใด 
ข Close-Up / CU 

3.  คือระยะภาพตามขอใด 
ง Medium Long Shot / MLS 

4. มุมกลองโดยทั่วไปจะประกอบดวยทั้งหมดกี่มุม 
ก 3 มุม  

5. ขอใดเหมาะกบัการเปดฉากแนะนําสถานที่ไดเปนอยางด ี
ก High Angle  

6. มุมพีโอวี (POV) เปนมมุกึ่งระหวาง มุมในขอใด 
ข มุม objective และ มุม subjective 

7. ขอใดคือ การแพนกลอง (Panning)  
ค การเคลื่อนที่ของกลองตามแนวนอน 

8. ขอใดคือ การทิ้ลท (Tilting) 
ง การเคลื่อนกลองเพื่อใหเห็นวัตถุตามแนวตั้ง 

9. ขอใดคือ การซมู (Zooming) 
ค การเปลี่ยนขนาดของวัตถุใหเล็ก - ใหญ 

10. ขอใดคือ การดอลลี่ (Dolling) 
ง การเคลื่อนไหวกลองออกจากวัตถ ุ
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ภาพตัวอยาง 
Storyboard  
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ภาพตัวอยาง 
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เกณฑการประเมิน  :   
 

เกณฑการใหคะแนน ระดับคะแนน 
1. ความเหมาะสมของการวางมมุกลองกบัเนือ้เรื่อง 25  คะแนน 
2. ความเหมาะสมของการกํากบัภาพกบัเนื้อเรื่อง 25  คะแนน 
3. ความคิดสรางสรรค 25  คะแนน 
4. ชิ้นงานมีความสวยงามและเรียบรอย 25  คะแนน 

รวม 100  คะแนน 
 
หมายเหตุ  :       

ระดับคะแนน  90-100 คะแนน หมายถึง ดีเยี่ยม 
ระดับคะแนน  70-89 คะแนน หมายถึง ด ี
ระดับคะแนน  50-69 คะแนน หมายถึง ผานเกณฑ 
ระดับคะแนน  0-49 คะแนน หมายถึง ไมผานเกณฑ 
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วัตถุประสงค  :  เพื่อใหผูรบัการฝกมีความรู ความสามารถในการพัฒนาบท Story Board การวางมุมกลอง  

การออกแบบฉาก และระยะภาพ 

 
วิธีการสอน  :  บรรยาย สาธิต และใหฝกปฏิบัต ิ
 
 อุปกรณชวยฝก :  1. เครื่องคอมพิวเตอร     2.  ไมโครโฟน    3. ลําโพง    
 
การมอบหมายงาน  : 
การวัดและประเมินผล  : 
หนังสืออางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครัง้ที่ 6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครั้งที่ 2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเด้ียนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรีเมียร. 
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ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครัง้ที่ 6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครั้งที่ 2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเด้ียนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรีเมียร. 
 
 
 
 

 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

92

92 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การพัฒนาบท 
Storyboard การวางมุมกลอง  
การออกแบบฉาก และระยะภาพ 
รหัสวิชา 0922124508 
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การพัฒนาบท Storyboard การวางมุมกลอง การออกแบบฉาก และระยะภาพ 

1. ทฤษฎีพ้ืนฐานการเขียนบท 

 
2. การเลาเรื่องดวยภาพ 
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การออกแบบจากสตอรีบอรด (Storyboard) แบบที่ละเอียด 
 

Story Board คือ เครื่องมือที่ชวยใหผูเขียนบท ผูกํากับ ตากลอง ตลอดจนนักแสดง ไดเขาใจในบทมากยิง่ขึ้น และ
เห็นภาพรวมกัน และเขาใจตรงกัน 

 
การวาด Story Board ไมจําเปนตองวาดรูปเกงเสมอไป เพยีงแควาดออกมาใหดูเขาใจ รูเรื่องก็ใชไดแลว ในการ

วาด Story Board ไมนิยมเขียนขอความลงไปในกรอบสีเ่หลีย่มเพราะจะรบกวนสายตาและมุมมองภาพ แตอาจจะเขียน
อธิบายกํากับมากขึ้นเพื่อความเขาใจ โดยสวนอธิบายมกัอยูขางลางของภาพ 

 
ลักษณะของ Story Board จะเปนกรอบสีเ่หลี่ยม เรียงกันตามเรื่องราว(บท) แทนกรอบของจอโทรทัศนจะบอก

เลาเรื่องราวดวยภาพ ซึ่งมีทัง้มุมมอง และขนาดภาพที่แตกตางกัน 
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มุมภาพที่ใชแทนสายตาแบงออกดงันี ้
Eye Level มุมระดบัสายตา ความสงูของกลอง จะอยูในระดับสายตา ผูชมจะเปนภาพในระดบัปกตเิทากบัความ

สูงของคนทั่วๆ ไป 
 
Bird’s Eye View เปนมุมสูงเหมือนสายตาของนกทีม่องลงมา กลองจะอยูสูงกวาวัตถุที่ตองการถาย แลวกดมุม

กลองลงมา ผูชมจะเห็นภาพในมุมสูงเหมอืนอยูขางบน 
 
Ant’s Eye View เปนมมุสายตาของมด กลองจะอยูต่ํามากเหนือระดบัพื้นดิน กลองจะอยูต่ํากวาวัตถุแลวถายเสย

วัตถุข้ึนไป ผูชมจะเห็นภาพในมมุต่ําเหมือนแหงนหนามองดสูิ่งทีอ่ยูสงูกวา ขนาดของภาพที่ใชเลาเรื่องราว ยกตัวอยาง
เปรียบเทียบกับมาตราสวนของคนดังนี ้

 
Extreme Long Shot ( ELS) ภาพระยะไกลสุด จะเห็นคนทั้งตัวและพื้นที่ๆยืนอยู ภาพของคนที่ไดจะเต็มตัวแตมี

ขนาดเล็ก ถาเปนทิวทัศนจะเปนทิวทัศนในระยะไกล เห็นภาพรวมของสิ่งที่ตองการโชวทั้งหมด ใชเพื่อใหเห็นภาพรวมของ
วัตถ+ุบรรยากาศโดยรอบ 

 
Long Shot ( LS) ภาพระยะไกล ถาเปนคนจะเห็นเปนคนทีเ่ต็มตัว หรืออาจจะเรียกวา Full Shot ก็ได ใชเพื่อให

เห็นภาพโดยรวมของวัตถุทั้งหมด 
 
Medium Shot ( MS ) ภาพระยะปานกลาง เห็นภาพตัง้แตตนขาขึ้นไปจรดศีรษะ 
Medium Close Up (MCU) ภาพระยะใกลปานกลาง เห็นคนในระดับอกขึ้นไป 
Close Up ภาพระยะใกล (CU) เห็นภาพในระยะใกล จะเหน็คนแคใบหนา 
Extreme Close Up (ECU) ภาพระยะใกลมาก เห็นใบหนาแคบางสวน หรอืเจาะเฉพาะอวัยวะ เชนเฉพาะดวงตา 

จะเห็นรายละเอียดชัดเจนมาก ใชเพื่อเนนใหเห็นรายละเอียดของวัตถุหรือเนนตัววัตถุอยางมาก 
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ในการวาด story Board นี้ผูวาดจําเปนตองเรียงลําดับเรื่องราวที่ตองการแสดงใหเห็นใหดเีสียกอนวาผูชมจะเห็น

อะไรกอนหลงั เห็นอะไรบางเนนอะไรบางแลวเขียนออกมาเปน Shot ตั้งแตตนจนจบ เพื่อใหการเลาเรื่องนั้นสมบรูณตรง
ตามวัตถุประสงคที่ตองการจะสื่อ ทั้งนี้ยงัตองเลือกใชมุมมองของภาพ ขนาดของภาพใหเหมาะสมและสื่อความหมาย รวม
ไปถึงทักษะการเปดเรื่อง ดําเนินเรื่อง และปดเรื่องใหนาสนใจ อีกดวย 
การจัดทํา Storyboard 

ตัวอยางเชนในหัวขอ Presentations จากโฟลวชารตก็เปนการแจงแจงรายละเอียดลงไปวาในสวนนี้
ประกอบดวยภาพ ขอความ ภาพเครื่องไหว มีเสียงหรือเพลงประกอบหรือไม และมีการเรียงลําดบัการทํางานอยางไร  
มีการวางหนาจออยางไรรวมทั้งการกําหนดแหลงของขอมลู เชน ภาพและเสียงวาไดมาอยางไรจากแหลงไหน 
การเตรียมขอมูลสาํหรับ Storyboard 

ขอมูลสําหรับ Storyboard อาจมีทัง้ภาพ เสียง ขอความ ภาพเคลื่อนไหว (Animation Movies) หรืออื่นๆ ซึง่
จะตองมีการจัดเตรียมขึ้นมากอนทีจ่ะนําไปใสโปรแกรม มีรายละเอียดที่เกี่ยวของดังนี ้

 - การจัดเตรียมภาพสําหรบัโปรแกรม 
 - การจัดเตรียมเสียงและสรางภาพเคลื่อนไหว (Animation File) 
 - ตัวอยาง Storyboard 

ขอดีของการทํา Story Board  
1. ชวยใหเนื้อเรื่องลื่นไหล เพราะไดอานทวนตั้งแตตนจนจบกอนจะลงมือวาดจรงิ  
2. ชวยใหเนื้อเรื่องไมออกทะเล เพราะมีแผนการวาดกํากับไวหมดแลว  
3. ชวยกะปริมาณบทพูดใหพอดีและเหมาะสมกับหนากระดาษและบอลลูนนั้น ๆ  
4. ชวยใหสามารถวาดจบไดในจํานวนหนาที่กําหนด (สําคัญสุด!)  

ขอควรจําของการทํา Story Board  
1. อยากลัวที่จะตองแก Story Board 
2. อยา !  ลงมือวาดทันทีหลังทํา Story Board เสรจ็ 

 3. บางทีถึงจะลงมือวาดจริงแลว แตเพิง่เจอจุดที่อยากแกภายหลัง ก็ยงัสามารถแกได 
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ขั้นตอนการทํา Story Board  

1. วางโครงเรื่องหลกั ไมวาจะเปน Theme, ตัวละครหลัก, ฉาก ฯลฯ  
         1.1 แนวเรื่อง  
        1.2 ฉาก  
         1.3 เนื้อเรื่องยอ 
         1.4 Theme/แกน (ขอคิด/สิ่งที่ตองการจะสื่อ) 
         1.5 ตัวละคร 
            สิ่งสําคัญคือกําหนดรปูลกัษณของตัวละครแตละตวัใหโดดเดนไมคลายกันจนเกินไป 
            สรุปคือ ควรออกแบบรูปลักษณของตัวละครใหโดดเดนแตกตางกัน และมองแลวสามารถสื่อถงึลักษณะนสิัยของ
ตัวละครไดทันที  

 
  2. ลําดับเหตุการณคราว ๆ  จุดสําคัญคือ ทุกเหตุการณจะเปนเหตุเปนผลซึง่กันและกัน เหตุการณกอนหนาจะ

ทําใหเหตุการณตอมามีน้ําหนกัมากขึ้น  
            อยาลืมวาตองหา จุด Climax ของเรื่องใหได จุดนี้จะเปนจุดที่นาตื่นเตนทีสุ่ดกอนทีจ่ะเฉลยปมทกุอยางในเรื่อง 
การสรางปมใหผูอานสงสัยกเ็ปนจุดสําคัญในการสรางเรือ่ง ปมจะทําใหผูอานเกิดคําถามในใจและคาดเดาเนื้อเรื่องรวมถึง
ตอนจบไปตาง ๆ นานา  
 

3. กําหนดหนา  
 
4. แตงบท เปนขั้นตอนสุดทายกอนลงมือวาดสตอรี่บอรด ควรเขียนบทพูดและบทความคิดที่จะใชเขียนลงใน

คอมมิกออกมาโดยละเอียดเพื่อที่จะไดกําหนดขนาดของบอลลูนและจัดวางลงบนหนากระดาษไดอยาเหมาะสม 
 

5. เขียน Story Board 
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ขั้นตอนสําหรับการเขียนบท  
 

1. การคนควาหาขอมูล (research) เปนขั้นตอนการเขียนบทภาพยนตรอันดบัแรกที่ตองทําถือเปนสิง่สําคัญ
หลงัจากเราพบประเด็นของเรื่องแลว จึงลงมือคนควาหาขอมูลเพื่อเสรมิรายละเอียดเรื่องราวที่ถูกตอง จริง ชัดเจน และมี
มิติมากขึ้น คุณภาพของงานจะดหีรือไมจึงอยูที่การคนควาหาขอมูล ไมวาภาพยนตรนั้นจะมีเนื้อหาใดก็ตาม  

 
2. การกําหนดประโยคหลักสําคัญ (premise) หมายถึง ความคิดหรือแนวความคิดที่งาย ๆ ธรรมดา สวนใหญ

มักใชต้ังคําถามวา “เกิดอะไรขึ้นถา...” (what if) ตัวอยางของ premise ตามรปูแบบหนังฮอลลีวูด เชน  
เกิดอะไรขึ้นถาเรื่องโรเมโอ & จเูลียตเกิดข้ึนในนิวยอรค คือ เรื่อง West Side Story 
เกิดอะไรขึ้นถามนุษยดาวอังคารบุกโลก คือ เรื่อง The Invasion of Mars 
เกิดอะไรขึ้นถาก็อตซิลาบุกนิวยอรค คือ เรือ่ง Godzilla 
เกิดอะไรขึ้นถามนุษยตางดาวบกุโลก คือ เรื่อง The Independence Day 
เกิดอะไรขึ้นถาเรื่องโรเมโอ & จเูลียตเกิดข้ึนบนเรือไททานิค คือเรื่อง Titanic  
 
3. การเขยีนเรื่องยอ (synopsis) คือเรื่องยอขนาดสั้น ทีส่ามารถจบลงได 3-4 บรรทัด หรอืหนึง่ยอหนา หรืออาจ

เขียนเปน story outline เปนรางหลังจากทีเ่ราคนควาหาขอมูลแลวกอนเขียนเปนโครงเรื่องขยาย (treatment)  
 
4. การเขยีนโครงเรื่องขยาย (treatment) เปนการเขียนคาํอธิบายของโครงเรื่อง (plot) ในรูปแบบของเรื่องสั้น 

โครงเรื่องขยายอาจใชสําหรบัเปนแนวทางในการเขียนบทภาพยนตรทีส่มบรูณ บางครั้งอาจใชสําหรับยื่นของบประมาณได
ดวย และการเขียนโครงเรื่องขยายที่ดีตองมปีระโยคหลักสําคัญ (premise) ที่งาย ๆ นาสนใจ  
 

5. บทภาพยนตร (screenplay) สําหรับภาพยนตรบันเทิง หมายถึง บท (script) ซีเควนสหลัก (master 
scene/sequence) หรือ ซีนาริโอ (scenario) คือ บทภาพยนตรที่มีโครงเรื่อง บทพูด แตมีความสมบรูณนอยกวาบทถาย
ทํา (shooting script) เปนการเลาเรื่องที่ไดพัฒนามาแลวอยางมีขั้นตอน ประกอบ ดวยตัวละครหลักบทพูด ฉาก แอ็คชัน่ 
ซีเควนส มีรปูแบบการเขียนที่ถูกตอง เชน บทสนทนาอยูกึง่กลางหนากระดาษฉาก เวลา สถานที่ อยูชิดขอบหนาซาย
กระดาษ ไมมีตัวเลขกํากับช็อต และโดยหลักทั่วไปบทภาพยนตรหนึ่งหนามีความยาวหนึง่นาท ี 
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6. บทถายทํา (shooting script) คือ บทภาพยนตรทีเ่ปนขั้นตอนสุดทายของการเขียน บทถายทําจะบอก

รายละเอียดเพิ่มเตมิจากบทภาพยนตร (screenplay) ไดแก ตําแหนงกลอง การเชื่อมช็อต เชน คัท (cut) การเลือนภาพ 
(fade) การละลายภาพ หรือการจางซอนภาพ (dissolve) การกวาดภาพ (wipe) ตลอดจนการใชภาพพิเศษ (effect) อื่น 
ๆ เปนตน นอกจากนี้ยังมเีลขลําดับช็อตกํากับเรียงตามลําดบัตั้งแตช็อตแรกจนกระทั่งจบเรือ่ง  

 
7. บทภาพ (storyboard) คือ บทภาพยนตรประเภทหนึง่ที่อธิบายดวยภาพ คลายหนังสือการตูน ใหเห็นความ

ตอเนื่องของช็อตตลอดทัง้ซเีควนสหรือทัง้เรื่องมีคําอธิบายภาพประกอบ เสียงตาง ๆ เชน เสียงดนตรี เสียงประกอบฉาก 
และเสียงพูด เปนตน ใชเปนแนวทางสําหรับการถายทํา หรอืใชเปนวิธีการคาดคะเนภาพลวงหนา (pre-visualizing) กอน
การถายทําวา เมื่อถายทําสําเร็จแลว หนังจะมีรปูรางหนาตาเปนอยางไร ซึ่งบริษัทของ Walt Disney นํามาใชกับการผลติ
ภาพยนตรการตูนของบริษทัเปนครั้งแรก โดยเขียนภาพ      เหตุการณของแอ็คช่ันเรียงติดตอกันบนบอรด เพื่อใหคนดู
เขาใจและมองเห็นเรื่องราวลวงหนาไดกอนลงมือเขียนภาพ สวนใหญบทภาพจะมีเลขทีล่ําดับช็อตกํากบัไว คําบรรยาย
เหตุการณ มุมกลอง และอาจมีเสียงประกอบดวย 
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องคประกอบของละคร 
 

บทประพันธทีเ่ขียนข้ึนเพื่อแสดงหรือเรียกวาบทละครนั้น นบัวาสําคัญทีสุ่ดและมีความสมบูรณและซบัซอนมาก
ที่สุด แบงออกเปน 2 ชนิดคือ 

 
1. การแสดงละครแนวเหมือนจริง เปนบทมีเนื้อหาทีเ่ปนสภาพจรงิตามธรรมชาติการดําเนินเรื่องเปนไปตามปกติ

วิสัยของมนุษย อาจเปนเรื่องราวในอดีตหรือปจจุบันก็ได 
 

2. การแสดงละครแนวไมเหมอืนจริง เปนบทละครที่มเีนื้อหาตางไปจากธรรมดาโลก มีตัวละครที่แปลกประหลาด
ไปจากมนุษยธรรมดา มีเหตุการณที่เปนอิทธิฤทธิ์นอกเหนอืปรากฏการณธรรมชาติ มีสถานที่และเครื่องนุงหมที่วจิิตรเหนือ
ความเปนจริง 
 
องคประกอบของละคร 

ละครมอีงคประกอบ 4 ประการคือ 
1. ตองมีเรื่อง(Story) ผูชมการแสดงจะรูเรื่องไดโดยวิธีฟงบทเจรจาของตัวละคร ละคร จะมีคุณคาไดก็อยูที่

ผูประพันธบทจะตองมีความสามารถในเชิงกวีโวหาร แสดงออกซึ่งลักษณะนสิัยของตัวละครในวรรณคดีเรื่องนั้นๆ 
2. ตองมีเนื้อหาสรุป (Subject) หมายถึงเนือ้หาสรปุเกี่ยวกบัความตองการนั้นๆ เชน ความรักชาติหรือแนวคิด 

(Theme) ที่กอใหเกิดสติปญญา สอนคติธรรม เชน ธรรมะยอมชนะอธรรม ทําดียอมไดดี การชวยเปลื้องทุกข ความรักเปน
ทุกข เปนตน 

3. นิสัยตัวละคร (Characterization) จะตองตรงกับเนื้อหาสรปุ บุคลิกลักษณะ กิริยาทาทาง ตองตรงกับนสิัยตัว
ละครในเรื่อง 

4. บรรยากาศ (Atmostphere) หมายถึงการสรางบรรยากาศรอบๆ ทีเ่กี่ยวกบัตัวละครจะตองกลมกลืนกับการ
แสดงของตัวละคร ซึ่งบรรยากาศจะชวยใหผูชมละครมีความรูสกึคลอยตามไปกบัเรื่องได เชนบรรยากาศแจมใส เศรา เปน
ตน การสรางบรรยากาศใหกับตัวละคร เปนกลวิธีสําคัญอยางหนึ่งของตัวละคร  
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โครงสรางของละครนั้น จะตองประกอบไปดวยสิง่เหลานี้คือ 
 
1. โครงเรื่อง ( Plot)  4W+H คือ  

ใคร ( who )   
ทําอะไร ( what )   
ที่ไหน ( where )   
เมื่อไหร ( when )   
อยางไร ( how )  
 

2. ตัวละครและวิธีสรางตัวละคร ( Character and Characterization ) 
 
3. บทเจรจา ( Dialogue) 
 
4. ฉาก ( Setting ) 
 
5. แนวคิดของเรื่อง (Theme) แนวคิดของละครนั้นมีหลายแนว เชน  

การชวยเปลื้องทุกข การวิงวอน 
การติดตาม   การแข็งขอ หรือ กบฏ   
การพาหนโีดยใชอุบาย   การฆาตกรรม   
การแขงขันระหวางฐานะ  ความอิจฉาริษยา หึงหวง 
คนทีส่าบสูญกลบัมา ความหลงการสูญเสียความรกั ยศถาบรรดาศักดิ์ ความร่ํารวย 
ความสํานึกผิด การพลีชีพเพื่อชาต ิเพื่ออุดมคติ เพื่อญาติ เพื่อความรัก 
ปญหาชีวิต การแกแคน 

  
  

6. การแสดง ( Action ) 
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การเขียนบทละคร 

การเขียนบทละคร มักไดรบัแรงบันดาลใจจากเหตุการณอยางใดอยางหนึง่ทํานองเดียวกับเรือ่งสั้นและนวนิยาย 
แรงบันดาลใจนี้ นับเปนสิ่งสําคัญมาก การเขียนบทละครบางทีอาจไดเปรียบอยูบาง เพราะบางคนอาจเอามาจากเรื่องสัน้ 
หรือ นักประพันธเอกไดเขียนไวแลว มาทําเปนละครเวที ละครวิทยุ ละครโทรทัศน ผูทําเรียกวาฝายเขียนบท ซึง่อาจ
ปรับปรงุเปลี่ยนแปลงแกไขใหเหมาะสมกับสภาพของประเภทการเขียน       การเขียนบทละครมีจุดประสงคในการ
นําเสนอดานเนื้อหาที่แตกตางกัน จงึอาจแบงบทละครออกตามลักษณะเนือ้หาได 4 ประเภทคือ 

 
1. บทละครแนวประวัติศาสตร เปนบทละครที่แสดงเรือ่งราวในอดีต เชน ประวัติบุคคล ประวัติเหตุการณ 

ในสมัยตางๆ 
 
2. บทละครแนวปรัชญาชีวิต เปนบทละครที่แสดงเรื่องราวในอดีตหรือปจจุบันที่เนนความคิดของมนุษยใน 

การดําเนินชีวิตใหถูกตอง 
 
3. บทละครแนวช้ีนําหรือสะทอนสังคม เปนบทละครที่แสดงเรื่องราวอันเปนปญหาสังคม ซึง่เปนผลกระทบ 

รุนแรงตอบุคคลหรือชุมชน เชนปญหาความยากจน โสเภณีเด็ก เปนตน  
บทละครเหลานี้มักไมมีคําตอบหรือทางออกที่ชัดเจนใหตัวละครซึ่งตกอยูในปญหานั้น แตมักเสนอแนวคิด 

ใหทุกฝายรวมกันปองกัน 
 
4. บทละครแนวจินตนาการ เปนบทละครที่แสดงจินตนาการอันสรางสรรคในเชิงศลิปะของมนุษยชาติ ตัวละคร 

เหตุการณ สถานที่ ลวนเปนจินตนาการของกวีทีมุ่งแสดงพลงัแหงจินตนาการอันไมมีขีดจํากัด ในทางวรรณศิลป  
ดุริยางคศิลป ทัศนศิลป และนาฏศิลป ตามความแปลกประหลาดมหัศจรรย ความตระการตา เหลานีเ้ปนสิ่งธรรมดาและ
ยอมรบัได อาทิ เทพนิยาย เรือ่งจักรๆ วงศๆ  เรื่องวิทยาศาสตร เปนตนอยางไรก็ดีวัตถุประสงคของบทละครดงักลาวนี้มิได
แยกออกจากกันโดยเด็ดขาดเพียงแตบทละครแตละเรือ่งเนนสาระสําคัญตางแนวกัน 
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การเขียนบทละครมโีครงสรางอยางเดียวกับการเขียนเรื่องสัน้ คือ มีความสําคัญอันเปนแกนของเรื่อง มเีคาโครง

เรื่อง มีตัวละคร บทสนทนา และฉาก   การเขียนเรื่องสั้นทําใหผูอานไดรบัความเพลิดเพลินจากการอาน   แตงบทละคร 
เปนศิลปะทีจ่ะนําไปแสดงเพื่อใหคนไดชม แลวเกิดความสนกุสนานเพลิดเพลิน 

การเขียนบทละคร อาจเขียนจบฉากเดียวหรือหลายฉากก็ได เรียกตอนหนึ่งๆ วา องก ก็ได                              
 

ฉาก บอกใหทราบสถานที่ชัดเจน เชน ในปาลึก หาดทราย ในบาน หรือในหอง บอกเวลาในขณะนั้นดวย 
 
ตัวละคร บอกเพศ ชื่อและชื่อสกุล อายรุูปรางลักษณะ การบรรยายนําเรือ่งเพื่อสรางบรรยากาศ ในกรณีเปน 

เรื่องยาวควรมีอยางยิง่ แตถาเปนเรื่องสั้นอาจไมจําเปน 
 
บทสนทนา มีความสําคัญมาก เพราะการดําเนินเรื่องอยูที่การสนทนาของตัวละครใชภาษาพูดใหเหมอืนชีวิตจริงๆ 

ควรเปนประโยคสั้นๆเขาใจงาย อาจแทรกอารมณขันเขาไป เพราะจะทําใหเรื่องออกรสยิง่ขึ้น 
 
ตอนจบ ตองจบอยางมเีหตผุล จบอยางมีความสุข หรือเศรา หรือจบลงเฉยๆ ดวยการทิ้งทายคําพูดใหผูชมคิดเอง 

อาจเปนถอยคําประทับใจเหมือนละลอกคลื่นที่ยังคงพริ้วกระทบฝง หลังจากไดทิ้งกอนหินลงไปเมือ่ครูใหญๆ        
                                              
การขึ้นตนและการจบเรื่อง เปนลีลาและศิลปะของผูเขียนโดยเฉพาะทีจ่ะทําใหผูชมพอใจ แตเมื่อจบแลวตองให

เขาใจเรื่องโดยตลอด  
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  เทคนิคการเขียนบทละคร หมายถึง การเขียนบทละครใหมีปจจัยตาง ๆ ทีส่ามารถนําไปใชในการแสดงได ปจจัย

ในการเขียนทีส่ําคัญ 3 ประการ คือ 
1. การแบงขั้นตอนของโครงเรือ่งออกใหชัดเจนวา เรื่องดําเนินจากจุดเริม่ตนแลวเขมขนขึ้น และคลี่คลายไปสูจุด

จบอยางไร 
            1.1 การเริม่เรื่อง เปนการแนะนําผูดูใหเขาใจความเดมิและตวัละครสําคัญในเรือ่ง 
            1.2 การขยายเรื่อง เปนการดําเนินเรือ่งใหเห็นปญหาตางๆ ที่เกิดขึ้น แสดงพฤติกรรมของตัวละครตางๆ 
ตามที่กําหนดไว 
            1.3 การพัฒนาเรื่อง เปนการแสดงความขัดแยงขอตัวละครในเรื่อง ทําใหการแสดงเกิดความเขมขนข้ึน 
            1.4 เปนการที่ที่พระเอกตกอยูในสถานการณทีล่อแหลม ถึงขั้นตองมีการตัดสินใจกระทําบางการบาง
ประการใหเด็ดขาดลงไป 
            1.5 การสรปุเรื่อง หรือการดําเนนิเรื่องไปสูจุดจบบรบิูรณ 

2. การแบงเรื่องออกเปนกลุมยอยๆ เพื่อสถานการณตางๆ แบงได 6 ประการ คือ 
            2.1 แสดงความปรารถนาของตัวละคร 
            2.2 รักษาความตอเนื่องของเนื้อเรื่องโดยไมทําลายวัตถุประสงคหลักของเรื่อง 
            2.3 ทําใหการดําเนินเรือ่งแตละตอนประทบัใจ 
            2.4 สอนเงื่อนงําไวในกาลเทศะทีส่มควร 
            2.5 บรรจุปจจัยที่ทําใหเกิดความประหลาดใจ 
            2.6 เปดเผยสิง่ตางๆ ที่ควรเปดเผยในกาลเทศะทีส่มควร 

3. ลักษณะ คือ กลวิธีในการนําลักษณะตางๆ มาใชในการแสดงออกของสถานการณและความคิด ซึ่งพอจะสรุป 
ไดวาสํานวนที่จะนํามาประพันธเปนบทบรรยายและบทเจรจา โดยตองคํานึงถึง 
            3.1 พื้นเพของตัวละคร 
            3.2 ความรูสึกที่ตองการใหเกิดกับคนด ู
            3.3 ความแจมแจงของสาระในเรือ่งที่ตองการถายทอดใหคนดูเขาใจ 
            3.4 ความสัมพันธกับลกัษณะของคนตรีและทํานองเพลงที่ใชประกอบการแสดง 
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ขั้นตอนการปฏิบัติงาน  : ใหผูฝก ฝกปฏิบัติงานในหัวขอท่ี 1  
 

1. ฝกปฏิบัติการการวางโครงเรื่อง 
1.1 ฝกปฏิบัติการวางโครงเรื่องของแอนิเมชั่น (Animation) 
 
 
 
 
 
 
 

 
อุปกรณและเครื่องมือ:  1. ไมบรรทัด          

2. กระดาษรองวาด 
3. ตัวหนีบ      
4. มีดคัตเตอร    
 
 
 

 
 
 
วัสด ุ :                     1. ดินสอเบอร   

2. กระดาษ  
3. ยางลบ      
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การออกแบบฉาก และระยะภาพ 
รหัสวิชา 0922124508 
งานที่  2 

1. ฝกปฏบิัตกิารการวางโครงเรื่อง 
1.1 ฝกปฏิบัตกิารวางโครงเรื่องของแอนิเมชั่น (Animation) 

 
ขั้นตอนการวางโครงเรื่องของแอนิเมชั่น (Animation) 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. สวนของการเปดเรื่อง 
(Beginning) 

การเริ่มตนของการกําหนดฉากและแนะนํา
ตัวละคร โดยมีจุดประสงคใหคนดูทราบที่มา 
คราวๆ วาตัวละครเปนอยางไร มีนสิัย
อยางไร มีปมดอยหรือจุดเดนตรงไหน และ
บรรยากาศสถานทีร่วมๆวาเปนที่ไหน
อยางไร 

- 

2. สวนของการดําเนินเรือ่ง 
(Middle) 

แสดงออกในลักษณะตางๆ ของตัวละคร 
เปนการสรางอารมณใหผูชมผจญกับ
เหตุการณตางๆ ซึง่จะนําไปสูจุดสนใจของ
เรื่อง เปนชวงทีเ่รื่องราวตางๆ ซึ่งจะนําไปสู
จุดสนใจของเรื่อง 
 

- 

3. สวนของการปดเรื่อง (End) บทสรุปที่ดีจะชวยสรางการจดจํา และดงึดูด
ใหผูชมกลับมาดูอีกครัง้ สวนนีเ้ปนสวนที่มี  
Climax ของเรื่องรวมอยูดวย ดังนั้น จะจบ
แบบไหน อยางไร ตรงนี้เปนจุดที่ตองดงึดูด
อารมณคนดูออกมาใหไดอยางที่ตองการ
มากที่สุด 

- 

หมายเหตุ  :      
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หัวขอวิชา การพัฒนาบท 
Storyboard การวางมุมกลอง  
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งานที่  2 

 
   วิทยากร/ครูฝกกําหนดใหผูรับการฝกไดฝกทักษะการออกแบบลักษณะของตัวละคร  

 
ภาพตัวอยาง 

การออกแบบลักษณะของตัวละคร  
 

 
 
 
 
 
ครุภัณฑ/เครื่องมือ/วัสด/ุอุปกรณ  
 

1. ดินสอ  
2. กระดาษ  
3. ยางลบ    
4. ไมบรรทัด    
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หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
หัวขอที่  3 เวลา   2  ชั่วโมง 

 
วัตถุประสงค  :  เพื่อใหผูรบัการฝกมีความรู ความสามารถเกี่ยวกับพื้นฐานการสรางภาพเคลื่อนไหว 

 
วิธีการสอน  :  บรรยาย  
 
 
หัวขอสําคัญ :  1) Layout ในงาน Animation 

2) Key frame 
3) In-between 
 

อุปกรณชวยฝก :  1. คอมพิวเตอร   2. โปรแกรม Flash  
การมอบหมายงาน  : 
การวัดและประเมินผล  : 
หนังสอือางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครัง้ที่ 6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครั้งที ่2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเด้ียนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรีเมียร. 
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หัวขอวิชา การกําหนด Layout,  
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Expression 1 
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หัวขอที่  3 

 
Layout ในงาน Animation 
Layout ในงาน Animation ตอนที่ 1 Storyboard  

 
 

เลยเอาท (Layout) เปนการทํางานตอจากแผนก Storyboard ดังนั้น สิ่งที่จะไดรับเปนอันดบัแรกก็คือ สตอรี่
บอรด (Storyboard) การทํางาน Layout ขั้นแรก คือ ทําความเขาใจสตอรี่บอรดที่ไดรับมากอน สตอรี่บอรดทีส่งมาทั้ง
ตอนจะตองทําการแบงใหกับเลยเอาททั้งแผนก โดยปกตจิะหัวหนาผูควบคุมแผนกเลยเอาท (Layout Animation 
Supervisor) จะทําการแบงงาน วาใครจะทําซีน (Scene)ไหน ซึ่ง 1 ตอน อาจมหีลายรอยซีนสําหรบัการตูนทีวีซีรีส่ 

สวนมากผูที่มฝีมือมักจะไดรับการไววางใจใหทําซีนตนๆ ซึ่งเปนฉากเปดเรือ่ง และฉากปดเรื่อง หรือซีนที่ยากๆ ที่
เหลือกเ็ฉลี่ยๆ กันไป ก็มีบางครั้งเหมือนกันที่ตองทําการจับฉลาก ผูวาดสตอรี่บอรดนั้นจะเขียนกําหนดสิง่ตางๆ มาให เชน 
ฉากนี้เปนเวลากลางวันหรือกลางคืน ภายในหรือภายนอกอาคาร แสงมาจากดานไหน (เพือ่ใหเลยเอาทแบงเงาตัวละครได
ถูกและแผนกฉาก Background จะไดลงสีทิศทางของแสงไดถูก) มีเอฟเฟคอื่นๆ หรือไม เชนแสงไฮไลท รวมถึงการ Pan
กลอง ซมูเขาซมูออก การเคลื่อนกลองในทิศทางตางๆ และอื่นๆ อีกมากมาย ในสตอรีบ่อรดนั้นจะมีชองคําพูดหรือบท
บรรยาย (Dialogue) วาฉากนั้นตัวละครพูดอะไรบาง เลยเอาทตองอานเวลาวาดจะไดแสดงอารมณของตัวละครไดถูกตอง  

นอกจากนี้ตองดูใหละเอียดวาในซีนที่เราไดรับมอบหมายมานั้น มีฉากอะไรบาง ตัวละครมีตัวไหน สวมเสือ้ผา
อยางไร ของประกอบฉากมอีะไรบาง มีเอฟเฟคพเิศษอะไร ซึ่งจะมีเอกสารสงมาใหอีกชุดหนึง่ 
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Layout ในงาน Animation ตอนที่ 2 Background  

 
 

 นอกจากสตอรี่บอรดที่เลยเอาทจะไดรับแลวเอกสารทีส่ําคัญอีกอยางหนึ่งคือฉากของเรือ่งหรือBackground  
เลยเอาทจะตองดูและตรวจสอบวามีฉากใดบางที่เราจะตองใชในซีน (scene) ที่เราไดรับมอบหมาย 

โดยเราสามารถดูไดจากสตอรี่บอรด แตจะใหดีดูตรงเอกสารฉากของเรือ่งมกัจะเขียนกํากบัไววาเปนฉากที่ใชในซีน
ไหนถึงซีนไหน ทั้งนี้ก็เพือ่ปองกันความผิดพลาดในกรณีที่ฉากนั้นคลายหรือใกลเคียงกัน 

ฉากในงานการตูนแอนนิเมชั่น 2D นั้น เลยเอาทมีหนาที่เขียนขึ้นมาใหมโดยดูจากสตอรี่บอรดเปนแนวทาง ถาสตอ
รี่บอรดเขียนไวชัดเจนดีแลวในสวนของตําแหนงและมมุมอง เลยเอาทกเ็อาตามนั้น แตถามุมมองไมดีหรือไมชัดเจน
(บางครัง้สตอรี่ยบอรดอาจไมเขียนฉากในทุกซีนโดยปลอยวางไวหรือเขียนกํากับวาตัวละครอยูที่ไหน) หนาที่ของเลยเอาท
คือกําหนดมุมมองขึ้นมาใหมและดูความตอเนื่องในซีนที่ตัวเองทําดวย ถาเลยเอาทคนอื่นมซีีนที่มมุมองใกลเคียงกันก็อาจจะ
ใชฉากที่เราเขียนข้ึนไดเลยก็ม(ีโดยอางอิงวาใชฉากเดียวกับซนีของเรา ไมตองวาดข้ึนมาใหมเขียนแตตัวละคร) 

มีบางครัง้เหมือนกันทีเ่ลยเอาทสามารถนําฉากจากเอกสารทีไ่ดไปถายเอกสารขยายเพื่อใชเปนฉากไดเลยไมตอง
วาดใหม แตสวนใหญก็ตองดราฟใหมดวยดินสออยูดีเพราะฉากที่ถายเอกสารขยายเสนมกัจะแตกและหนา หรอืมีจุดดําๆ 
ทั้งนี้เพือ่ทีจ่ะไดคุณภาพของเสนที่ชัดเจน ถาถายเอกสารแลวใชไดเลยถือวาโชคดีมากๆ 
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Layout ในงาน Animation ตอนที่ 3 Props  
 

 
 

พรอพ (Props) หรือของประกอบฉาก ก็คือสิง่ของที่อยูในฉาก มีการเคลื่อนไหว โดยอาจเปนสิ่งของที่ตัวละครใช 
เครื่องแตงกาย เครื่องประดับ วัสดอุุปกรณตางๆ ฯลฯ เลยเอาทจะตองตรวจสอบวาในสตอรีบ่อรดมีพร็อพอะไรบาง หรอื
อาจจะดทูี่เอกสารพรอพวาสิ่งของนั้นๆ เขียนกําหนดไววาใชในซีนไหนบาง เพื่อปองกันความผิดพลาด 

หลายครัง้เหมือนกันทีห่าพรอพไมเจอ เห็นวามีอยูในสตอรี่บอรดแตไมมีในเอกสารพรอพทีส่งมา ก็ตองแจงไปยัง
ฝายผลิตเพือ่ใหเขียนสงมาทีหลัง งานการตูนทีม่ีเปนรอยๆ คัทก็ตองมหีลงลืมกันบาง แตถาเปนของที่ไมคอยสําคัญ 
นักเลยเอาทก็อาจจะตองออกแบบเขียนไปเลยก็ได เพื่อไมใหเปนการเสียเวลา แตถาเปนของดีสน่ีย (Disney) สวนใหญจะ
คอนขางละเอียด พรอพจะเขียนมาใหครบในทุกซีนนอยมากที่หาไมเจอ พรอบมีตัง้แตสิง่ของเล็กๆ ไปจนถึงชิ้นใหญๆ เชน
รถยนต ถาเปนซีนทีร่ถถูกชนก็จะเขียนรปูรถในสภาพที่ถูกชนมาใหดวย เลยเอาทก็ไมตองไปเขียนใหมหรือออกแบบเอง
ตามสตอรีบ่อรด สามารถนําพรอพนั้นไปถายเอกสารแลวตัดแปะใหไดขนาดตรงตามตําแหนงกพ็อ 

สรปุแลวพรอพก็คือสิ่งของตางๆ ในฉากที่นอกเหนือจากตัวละคร มีการเคลื่อนไหว เพราะถาไมตองเคลือ่นไหว 
ก็วาดรวมไปกับฉากไดเลย 
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Layout ในงาน Animation ตอนที่ 4 Effect  
 

 
 

ในสวนของการทํางานเลยเอาทในงานการตูนแอนนิเมชั่นกันตอ เอกสารอีกชุดสําหรบัเลยเอาทในงานการตูนอีก
อยางก็คือ เอฟเฟค (Effect) ซึ่งก็แลวแตวาการตูนตอนน้ันๆ มีการใชเอฟเฟคมากนอยเพียงไร บางทกี็ไมมสีงมาใหด ูนั่น
หมายถึงตองเขียนเอาเอง 

เอฟเฟคในงานการตูนแอนนเิมชั่นก็ไดแก ไฟ ควัน ลม แสง เงา น้ํา เปนตน 
ในการตนูแตละเรื่องจะมีการใชเอฟเฟคที่แตกตางกัน ซึ่งบางเรือ่งมเีอกลักษณเฉพาะเชน ในการตูนเรื่องมูหลาน 

(Mulan) ควันในเรื่องก็จะออกแบบใหมีลกัษณะเปนจีนๆ หรืออยางในการตูนเรื่องเฮอรคิวลสี (Hercules) ควัน ไฟ หรือ
เอฟเฟคอื่นๆ ก็จะมลีายเสนเปนแบบกรีก ซึง่ทางฝายผลิตกจ็ะตองสงเอฟเฟคในซีนตางๆ มาใหเลยเอาทซึง่สามารถถาย
เอกสารยอ-ขยาย ตัดแปะใหตรงตามตําแหนงไดเลย ไมตองวาดใหมทั้งนีเ้พื่อเปนการควบคุมคุณภาพของเรื่องใหมี
เอกลักษณเดียวกันน่ันเอง 

แตถาเรื่องไหนไมมีเอกสารเหลานีก้็หมายถึงเลยเอาทตองเปนฝายออกแบบเอง โดยดูสตอรีบ่อรดเปนไกดไลน แต
ถึงอยางนั้นเมื่อไปถึงมือแอนนิเมเตอร เขาจะทําเหมือนเลยเอาทหรือไมเหมือนก็ได ตามความเหมาะสม 
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Layout ในงาน Animation ตอนที่ 5 Model Sheet  

 
Model Sheet ที่ไดรับจะมีโมเดลตัวละครหลักๆ (Main Model) ไปจนถึงตัวประกอบอื่นๆ ทั้งหมดในการตูน

เรื่องนั้นๆ โดยจะแสดงใหเห็นลกัษณะของตัวละครในทุกมมุมองรอบตัว (Turnaround) ทั้งดานหนา ดานขาง ดานหลัง 
หรือแมกระทั่งมุม 45 องศา แตสําหรบัตัวประกอบที่ไมสําคัญนักก็จะเขียนมาแคดานหนาอยางเดียว 
 

 
นอกจากนี้ยงัเขียนตัวละครใหเห็นถึงการแสดงอารมณในแบบตางๆ (Expressions) เชน ดีใจ เสียใจ ประหลาดใจ 

เปนตน เพื่อใหเลยเอาทหรือแอนนเิมเตอร วาดตัวละครออกมาไดอารมณตามแบบที่ตองการของการตูนเรื่องนั้นๆ ซึ่ง 
Expressions นี้ชวยเลยเอาทไดมากในการวาดตัวละคร ทําใหเห็นนิสัยตัวละครนั้นๆ ดวย กอนจะทํางานก็ตองศึกษาตรงนี้
นิดนึงอาจจะลองวาดตามหลายๆ ทาทางเวลาทํางานจะไดคลองมือ 
 

 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

113

113 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ทฤษฎี) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
หัวขอที่  3 

 
สิ่งที่ขาดไมได คือ ขนาดเปรียบเทียบตัวละครตางๆ (Size Comparison) เลยเอาทจะไดทราบวาตัวละครมีขนาด

สูงต่ํากวากันอยางไรบาง เวลาที่ตัวละครหลายๆ ตัวอยูรวมซนีเดียวกันจะไดเขียนไดถูกตอง จะยึดตามสตอรีบ่อรดไมไดตอง
ดูที่ขนาดเปรียบเทียบแลวแกไขตามนี ้

 
อื่นๆ ก็จะมีขอควรระวัง ในการวาดตัวละครในการตูนเรื่องนัน้ๆ ซึ่งแตละเรือ่งจะมเีอกลักษณในการวาดและการ

ใชเสนแตกตางกันไป มรีายละเอียดเลก็ๆ นอยๆ ที่ไมควรมองขาม เชนการใชเสนโคง เสนหักมุม รปูหนา รอยยับเสื้อผา 
ลักษณะมือ และอื่นๆ อีกมากมาย ถาเขียนผิดจากแบบกจ็ะไมเหมือน ซึ่งเรียกกันวา ออฟโมเดล (Off Model) หรือไม
เหมอืนแบบนั่นเอง ถาผิดเลก็นอยอาจไมเปนไรแตถาออฟโมเดลมากๆ ก็อาจถูกตีกลบัมาแกเลยเอาท บางทีอาจใชวิธีถาย
เอกสารทาบแลววาดตามสัดสวนเลยก็ม ีซึ่งก็ชวยใหวาดไดตามสัดสวนที่ถกูตองและเหมือนแบบมากทีสุ่ด การแกไขก็
นอยลง 

นอกจากนี้ยงัมีโครงรางโมเดลแบบสเก็ตซ ที่ชวยใหเขียนสัดสวนไดถูกตอง รวมไปถึงรูปปาก (Mouth Chart) และ
ชารตการเดินหรอืวิง่ เวลาทํางานสวนใหญก็จะนําโมเดลไปถายเอกสารแลวตัดเอาเฉพาะตัวละครที่ตองใชหลายๆ มุม มา
แปะอยูในแผนเดียวกันแลวไปแปะที่โตะเวลาวาดก็จะไดสะดวก 
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Key frame และ In-Between  
 
หลักการของ Animation 

ภาพเคลื่อนไหว หรือทีเ่ราเรียกวา Animation คือ การเปลีย่นแปลงวัตถุ โดยมีความสมัพันธกับเวลา เชน 
ภาพยนตรการตูนทีม่ีการเคลื่อนที่ การเดิน การวิ่ง เปนตน สําหรับ Flash นั้น จะมีการเคลื่อนที่อยู 2 ลักษณะคือ 

1. การเคลือ่นยายแบบยายสถานที่ (Motion) เชน วัตถุเคลื่อนที่จากจุด A ไปจุด B 

 
2. การเคลือ่นที่โดยการเปลี่ยนแปลงลกัษณะ (Transform)  

 
ประเภทของภาพเคลื่อนไหว 

การเคลื่อนไหวชนิดภาพตอภาพ (Frame By Frame Animation) 
เปนการเคลื่อนไหวชนิด ภาพที่ 1 ไปภาพที ่2 ไปภาพที่ 3 … ไป ภาพสุดทาย หรือเปนลกัษณะการเคลื่อนไหวของ

การตูนนั่นเอง 

 
การเปลี่ยนแปลงของภาพแตละภาพที่เรียงอยางตอเนื่องในลักษณะนี ้เหมาะสําหรบัการทํา Animation  

ที่ซับซอน เชน Animation ที่มีการเคลื่อนไหว ลักษณะทาทางมาก เปนตน ซึง่จะใชภาพจํานวนมาก โดยที่แตละ 
Frame  จะใสภาพในลักษณะทาทางตาง ๆ 1 ภาพ ทําใหเสยีเวลา แตจะทําใหภาพมีการเคลือ่นไหวที่เหมือนจรงิ  
การเคลื่อนไหวชนิดกําหนดจุดเริ่มตนและจุดสิ้นสุด  (Tweened Animation) 
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การเคลื่อนไหวของ Animation  ลักษณะนี้จะมีการกําหนดจุดเริม่ตนในการแสดงภาพเคลื่อนไหว และใชวิธีการ

คํานวณของ Flash ในการแสดงภาพตาง ๆ โดยที่เราไมตองไปหาภาพมาเรียงตอกัน เราสามารถแบงลักษณะการ
เคลื่อนไหวออกเปน 2 ลักษณะ คือ 

1. เปลี่ยนแปลงสถานที่ (Motion Tween) เปนการเคลือ่นไหวที่มีการยายสถานที ่โดยไมมีการเปลี่ยนแปลง
รูปรางของวัตถุ แตสามารถเปลี่ยนสหีรือขนาดได คือ การเปลี่ยนแปลงจากจุด A ไป จุด B นั่นเอง โดยทีร่ะหวางการ
เคลื่อนทีจ่าก A ไป B สามารถมกีารเปลี่ยนแปลงขนาด เปลีย่นส ีหรือคอย ๆ จางหายไป แตไมสามารถเปลี่ยนจากรปูหนึ่ง
ไปยังอีกรูปหนึ่งได  การทํา Animation ลักษณะนี ้Flash Movie จะมีขนาดเล็กกวา การเคลื่อนไหวชนิดภาพตอภาพ 
เพราะใชการคํานวณการเคลือ่นไหวแทนการใชภาพจริงหลาย ๆ มาแสดงตอกัน               

2. เปลี่ยนแปลงลักษณะเดิม (Shape Tween) เปนการเคลื่อนไหวโดยมกีารเปลี่ยนแปลงรปูราง หรอืเปลี่ยน
จากวัตถุหนึ่งไปเปนอกีวัตถุหนึ่ง 

 
Frame 

Frame มีลักษณะเปนชองเล็ก ๆ ทีเ่รียงกันเปนแถวยาว ทําหนาที่บรรจุภาพและเสียงทีจ่ัดวางบน Stage  
เราจงึตองจัดเรียงเรือ่งราวบน Frame เพื่อแสดงออกมาเปน Flash Movie โดยแตละ Frame จะถูกแสดงเมื่อมกีารผาน
ของ Playhead ซึ่ง Playhead ตัวนี้เองจะเปนตัววิ่งผาน Frame แตละ Frame  เพื่อแสดงภาพและเสียงทีบ่รรจอุยูใน 
Frame นั้น 
 

 
 

 
 
 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

116

116 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ทฤษฎี) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
หัวขอที่  3 

 
การเพิ่ม Frame 
                เลือก Insert > Frame หรือคลกิเมาสปุมขวาที่ชอง Frame เลือก Insert Frame 
 

 
 
การลบ Frame 
                เลือก Insert > Remove Frames หรือคลิกเมาสปุมขวาที่ชอง Frame เลือก Frame ที่เราตองการ 
Remove Frames 
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Keyframe 

Keyframe คือ Frame ที่มีวัตถุหรือมีการเปลี่ยนแปลง เราสามารถสังเกตได โดยจะมจีุดใน Frame      หรือจะมี
จุดที่จุดเริม่ตนของ Frame ในการสรางงาน Animation เราจะตองกําหนด Keyframe ในตําแหนงตาง ๆ และกําหนด
รายละเอียดของแตละ Keyframe ไดอยางเหมาะสม งาน Animation ที่ไดจึงจะมผีลลัพธตามที่ตองการ 

 

 
   
การเพิ่ม Keyframe 
                เปนการเพิ่ม Frame โดยมีภาพหรือวัตถุของ Frame ที่อยูกอนหนาติดมาดวย หาก Frame กอนหนาเปน 
Frame วาง ๆ  เรากจ็ะได Frame เปลามา เราสามารถเพิม่ Keyframe ไดโดยเลือก Insert  à Keyframe  หรอืคลิก
เมาสที่ปุมขวา Frame เลอืก Insert เลอืก Keyframe 
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การลบ Keyframe 
                ใหเราทําการคลกิเมาสที ่Frame ที่เราตองการลบออก เลอืก Insert à Clear Keyframe หรือคลิกเมาสทีปุ่ม
ขวา เลือก Clear Keyframe 

 
 

Blank Keyframe  เปน Keyframe ที่วางอยูยังไมมีการใชงาน ไมมีวัตถุหรือ Instance ใด ๆ เปน Keyframe 
เปลา ๆ  

 
การเพิ่ม Blank Keyframe  

การเพิม่ Frame เปลา ๆ ขึ้นมา โดยไมขึ้นอยูวา  Frame  กอนหนาจะมีวัตถุอยูหรอืไม โดยเลือก Insert à Blank 
Keyframe หรือคลิกเมาสปุมขวาที ่Frame เลอืก Insert Blank Keyframe 
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Inbetween  

ศิลปะในการกําหนด Inbetween  
รูจัก keyframe กันแลว ในเมื่อมี keyframe ก็จะมี inbetween Frame เขามาเกี่ยวของ 

 
จากรปูทีเ่ห็นคือ รปูลกูตุมซกัอยางแกวงไปมา เห็นวา Action หลักๆ ทีเ่รียกวา Key คือ การแกวงจากซายไปขวา 

เราจงึกําหนด key ในลักษณะดังกลาว แลวเราจะกําหนด inbetween frame  
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..  
. 

 
 

ตาม ภาษา Animation เคาจะเรียก INBETWEEN FRAMEที่ เบรคอาการเคลื่อนที่ตรง ๆ วา BREAKDOWN 
ดังนั้น รูปดานบนเปน Frame ตรงกลางจะเรียกวา BREAKDOWN 
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เมื่อเราไดครบแลวทั้ง Key ทั้ง BREAKDOWN เราจะมาลองซอย inbtween อีกท ี

ตัวอยางเดิม ดูรูปลูกบอลแกวง 
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   คําช้ีแจง แบบทดสอบมีทั้งหมด 2 ตอน 
   ตอนที่ 1 เขียนเคร่ืองหมาย ลอมรอบตัวอักษรหนาคําตอบที่ถูกตอง 

1. Animation คือขอใด 
ก การเปลี่ยนแปลงสหีรือขนาด 
ข การเปลี่ยนแปลงรูปรางของวัตถ ุ
ค การเคลื่อนไหวที่มีการยายสถานที ่
ง การเปลี่ยนแปลงวัตถใุหมีความสมัพันธกับเวลา 

2. Motion Tween คือขอใด 
ก การเปลี่ยนแปลงรูปรางของวัตถุ 
ข การเคลื่อนไหวที่มีการยายสถานที ่
ค เปลี่ยนจากวัตถุหนึ่งไปเปนอกีวัตถุหนึ่ง 
ง การเปลี่ยนแปลงวัตถใุหมีความสมัพันธกับเวลา 

3. Shape Tween คือขอใด 
ก การเปลี่ยนแปลงสหีรือขนาด 
ข การเคลื่อนไหวที่มีการยายสถานที ่
ค เปลี่ยนจากวัตถุหนึ่งไปเปนอกีวัตถุหนึ่ง 
ง การเปลี่ยนแปลงวัตถใุหมีความสมัพันธกับเวลา 

4. Frame มีลักษณะตามขอใด 
ก ชองเล็กๆแถวยาว ข  ชองเลก็ๆแถวสั้น 
ค ชองกวางๆแถวยาว ง  ชองกวางๆแถวสั้น 

5. ขอใด คือ Keyframe 
ก Frame ที่ไมมีวัตถุ  
ข Frame มีการเปลี่ยนแปลง 
ค Frame ที่มีวัตถุและมกีารเปลี่ยนแปลง  
ง  ถูกทุกขอ 
 

6. Blank Keyframe  คือ ขอใด 
ก Frame ที่ไมมีวัตถุ  
ข Frame มีการเปลี่ยนแปลง 
ค Frame ที่มีวัตถุและมกีารเปลี่ยนแปลง  
ง  ถูกทุกขอ 

7. ถาตองการเพิม่ Frame ตองทําตามขอใด 
ก Insert > Frame 
ข Insert > Remove Frames 
ค Insert > Keyframe  
ง Insert > Clear Keyframe 

8. ถาตองการเพิม่ Keyframe ตองทําตามขอใด 
ก Insert > Frame 
ข Insert > Remove Frames 
ค Insert > Keyframe  
ง Insert > Clear Keyframe 

9. ถาตองการลบ Frame ตองทําตามขอใด 
ก Insert > Frame 
ข Insert > Remove Frames 
ค Insert > Keyframe  
ง Insert > Clear Keyframe 

10. ถาตองการลบ Keyframe ตองทําตามขอใด 
ก Insert > Frame 
ข Insert > Remove Frames 
ค Insert > Keyframe  
ง Insert > Clear Keyframe 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเฉลยทดสอบ 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
หัวขอที่  3 

 
1. Animation คือขอใด 

ง การเปลี่ยนแปลงวัตถใุหมีความสัมพันธกบัเวลา 
2. Motion Tween คือขอใด 

ข การเคลื่อนไหวที่มกีารยายสถานที ่
3. Shape Tween คือขอใด 

ค เปลี่ยนจากวัตถุหนึ่งไปเปนอีกวัตถุหนึ่ง 
4. Frame มีลักษณะตามขอใด 

ก ชองเล็กๆแถวยาว 
5. ขอใด คือ Keyframe 

ค Frame ที่มีวัตถุและมีการเปลี่ยนแปลง  
6. Blank Keyframe  คือ ขอใด 

ก Frame ที่ไมมีวัตถุ  
7. ถาตองการเพิ่ม Frame ตองทําตามขอใด 

ก Insert > Frame 
8. ถาตองการเพิม่ Keyframe ตองทําตามขอใด 

ค Insert > Keyframe  
9. ถาตองการลบ Frame ตองทําตามขอใด 

ข Insert > Remove Frames 
10. ถาตองการลบ Keyframe ตองทําตามขอใด 

ง Insert > Clear Keyframe 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเตรียมการสอน 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 เวลา  4  ชั่วโมง 

 
วัตถุประสงค  :  เพื่อใหผูรบัการฝกมีความรู ความสามารถเกี่ยวกับพื้นฐานการสรางภาพเคลื่อนไหว 

 
วิธีการสอน  :  บรรยาย  
 
  
อุปกรณชวยฝก :  1. คอมพิวเตอร   2. โปรแกรม Flash  
 
การมอบหมายงาน  : 
 
การวัดและประเมินผล  : 
หนังสอือางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครั้งที ่6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครั้งที ่2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเด้ียนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรีเมียร. 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

 
Timeline 
 Timeline เปนเครื่องมือหนึง่ของ Flash ที่ชวยในการกํากับเวลาในการแสดงของภาพเคลื่อนไหวโดยมี Playhead 
เปนตัววิ่งผานแตละ Frame ใน Timeline เพื่อแสดงภาพหรือ Animation ที่ใสไวใน Frame นั้นๆ 
 
 

 
 
 
Playhead เครื่องมีอแสดงวัตถุใน Frame 
 Playhead เปนเครื่องมือที่แสดงวัตถุตางๆ ที่อยูใน Frame บน Stage ทําหนาที่คลายกบัหัวอานในเครื่องเลน
วิดีโอเทปที่ว่ิงบน Timeline ผานแตละ Frame เพื่อแสดงวตัถุที่อยูใน Frame นั้นออกมาบน Stage โดย Playhead จะ
ทํางานทีส่ัมพันธกบัเวลา และแสดง ภาพแตะละภาพออกมาบน Stage อยางรวดเร็วทําใหดูเหมือนมีการเคลื่อนไหวเกิดขึ้น 
 
การแสดงสถานะเกี่ยวกับภาพเคลื่อนไหวบน Timeline 
 

 
  
 
 
Current frame – เปนชองทีบ่อกวาขณะนี้ Playhead แสดง Frame อยูที่ชองเทาไหร 
Frame Rate –   เปนชองที่บอกวาขณะนี้ Playhead วิ่งดวยความเร็วกี่ Frame ตอวินาท ี
Elapsed time – เปนชองทบีอกวาเมื่อ Playhead วิ่งมาถึง Frame นี้จะใชเวลาเทาไหร มีหนวยเปนวินาท ี
 
 
 

 

Playhead 
 

Frame 
 

Current frame 
 Frame rate 

 

Elapsed time 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

 
Timeline 
 Timeline เปนเครื่องมือหนึง่ของ Flash ที่ชวยในการกํากับเวลาในการแสดงของภาพเคลื่อนไหวโดยมี Playhead 
เปนตัววิ่งผานแตละ Frame ใน Timeline เพื่อแสดงภาพหรือ Animation ที่ใสไวใน Frame นั้นๆ 
 
 

 
 
 
Playhead เครื่องมีอแสดงวัตถุใน Frame 
 Playhead เปนเครื่องมือที่แสดงวัตถุตางๆ ที่อยูใน Frame บน Stage ทําหนาที่คลายกบัหัวอานในเครื่องเลน
วิดีโอเทปที่ว่ิงบน Timeline ผานแตละ Frame เพื่อแสดงวตัถุที่อยูใน Frame นั้นออกมาบน Stage โดย Playhead จะ
ทํางานทีส่ัมพันธกบัเวลา และแสดง ภาพแตะละภาพออกมาบน Stage อยางรวดเร็วทําใหดูเหมือนมีการเคลื่อนไหวเกิดขึ้น 
 
การแสดงสถานะเกี่ยวกับภาพเคลื่อนไหวบน Timeline 
 

 
  
 
 
Current frame – เปนชองทีบ่อกวาขณะนี้ Playhead แสดง Frame อยูที่ชองเทาไหร 
Frame Rate –   เปนชองที่บอกวาขณะนี้ Playhead วิ่งดวยความเร็วกี่ Frame ตอวินาท ี
Elapsed time – เปนชองทบีอกวาเมื่อ Playhead วิ่งมาถึง Frame นี้จะใชเวลาเทาไหร มีหนวยเปนวินาท ี
 
 
 

 

Playhead 
 

Frame 
 

Current frame 
 Frame rate 

 

Elapsed time 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มติิ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

 

Frame 

Frame มีลักษณะเปนชองสี่เหลี่ยมเล็กทีเ่รียงกันเปนแถวยาว ทําหนาที่บรรจุภาพและเสียงที่จะจัดวางบน Stage 
เราจงึตองจัดเรียงเรือ่งราวบน Frame เพื่อแสดงออกมาเปน Flash Movie โดยแตละ Frame จะถูกแสดงเมื่อมกีารผาน
ของ Playhead ซึ่ง Playhead ตัวนี้เองจะเปนตัววิ่งผาน Frame แตละ Frame เพื่อแสดงภาพและเสียงที่บรรจุอยูใน 
Frame นั้น     

การกําหนดขนาดของFrame 

ขนาดของเฟรม หรอืความกวางของเฟรมที่แสดงบน Timline สามารถกําหนดไดโดยคลิกทีปุ่ม Frame View 
pop-up menu และกําหนดคาที่ตองการ 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

 
การเพิ่ม/ลบFrame ใน Timeline 
 

การเพิม่จํานวนเฟรม - การเพิ่มจํานวนเฟรม จะชวยให Movie นําเสนอไดอยางราบรื่นและดูเปนธรรมชาติ หรือ 
Smooth มากขึ้น หลกัการเพิ่มจํานวนเฟรม กระทําไดดังนี ้

คลิกเมาสที่ Frame ที่ตองการจะเพิ่มบน Timeline  
เลือกเมนูคําสั่ง Insert >Frame หรือ กดคีย <F5>  

 
การลบเฟรม  เมื่อมีการเพิ่มจํานวนเฟรม ก็สามารถลบจํานวนเฟรมไดเชนกัน โดยเลือกคําสั่ง  
Insert > Remove Frame หรือ กดคีย <Shift+F5>  

 

 
 

 
 

 
 
 

 

ลบ Frame 
 

เ����Frame 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

 
Keyframe 
  Keyframe คือ Frame ที่มีวัตถุหรือมีการเปลี่ยนแปลง เราสามารถสังเกตได โดยจะมจีุดใน Frame   หรอืจะมี
จุดที่จุดเริม่ตนของ Frame ในการสรางงาน Animation เราจะตองกําหนด Keyframe ในตําแหนงตางๆและกําหนด
รายละเอียดของแตละ Keyframe ไดอยางเหมาะสม งาน Animation ที่ไดจึงจะมผีลลัพธตามทีเ่ราตองการ 
การเพิ่ม Keyframe 

เปนการเพิม่ Frame โดยมีภาพหรือวัตถุของ Frame ที่อยูกอนหนาติดมาดวย หาก Frame กอนหนาเปน 
Frame วางๆ เรากจ็ะได Frame เปลามา เราสามารถเพิ่ม Keyframe ไดโดย 

คลิกเมาสที่ Frame ที่ตองการจะเพิ่มบน Timeline  
เลือกคําสั่ง Insert > Keyframe หรือ กดคีย <F6>  

การลบ Keyframe  
คลิกเมาสที่ Keyframe ที่ตองการจะลบบน Timeline  
เลือกคําสั่ง Insert > Clear Keyframe หรือ กดคีย <Shift+F6>  

Blank Keyframe 
 เปน Keyframe ที่วางอยูยังไมมีการใชงาน ไมมีวัตถุหรือ Instance ใดๆ เปน Keyframe เปลาๆ   
การเพิ่ม Blank Keyframe 

คลิกเมาสที่ Frame ที่ตองการจะเพิ่มบน Timeline  
เลือกคําสั่ง Insert >Blank Keyframeหรือ กดคีย <F7>  

  

 
 

 
 
 

 

Keyframe 
 

Blank Keyframe 
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รหัสวิชา 0922124509 
งานที่  3 

 
Keyframe 
  Keyframe คือ Frame ที่มีวัตถุหรือมีการเปลี่ยนแปลง เราสามารถสังเกตได โดยจะมจีุดใน Frame   หรอืจะมี
จุดที่จุดเริม่ตนของ Frame ในการสรางงาน Animation เราจะตองกําหนด Keyframe ในตําแหนงตางๆและกําหนด
รายละเอียดของแตละ Keyframe ไดอยางเหมาะสม งาน Animation ที่ไดจึงจะมผีลลัพธตามทีเ่ราตองการ 
การเพิ่ม Keyframe 

เปนการเพิม่ Frame โดยมีภาพหรือวัตถุของ Frame ที่อยูกอนหนาติดมาดวย หาก Frame กอนหนาเปน 
Frame วางๆ เรากจ็ะได Frame เปลามา เราสามารถเพิ่ม Keyframe ไดโดย 

คลิกเมาสที่ Frame ที่ตองการจะเพิ่มบน Timeline  
เลือกคําสั่ง Insert > Keyframe หรือ กดคีย <F6>  

การลบ Keyframe  
คลิกเมาสที่ Keyframe ที่ตองการจะลบบน Timeline  
เลือกคําสั่ง Insert > Clear Keyframe หรือ กดคีย <Shift+F6>  

Blank Keyframe 
 เปน Keyframe ที่วางอยูยังไมมีการใชงาน ไมมีวัตถุหรือ Instance ใดๆ เปน Keyframe เปลาๆ   
การเพิ่ม Blank Keyframe 

คลิกเมาสที่ Frame ที่ตองการจะเพิ่มบน Timeline  
เลือกคําสั่ง Insert >Blank Keyframeหรือ กดคีย <F7>  

  

 
 

 
 
 

 

Keyframe 
 

Blank Keyframe 
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Layer 
  

ลักษณะการทํางานแบบ Layer เปนเหมือนการวางแผนใสซอนทับกันเปนลําดับขั้นขึ้นมาเรื่อยๆ โดยแตละแผนใส
เปรียบเสมอืนเปนแตละ Layer บรเิวณของ Layer ที่ไมมรีูป จะเห็นทะลุถึง Layer ที่อยูขางลาง โดยกระบวนการเชนนีจ้ะ
ทําใหเกิดเปนรูป Flash Movie ที่สมบรูณ  

นอกจากนี้ในแตละ Layer จะแยกการทํางานอยางชัดเจนมคีุณสมบัติตางๆ เปนของตัวเอง และการแกไขทีเ่กิดข้ึน
ในแตละ Layer นั้นจะไมสงผลตอ Layer อื่นๆ  

 
  

 
  
  
  
  

  
 
 
 
 
 
 
 
 
 

 

 

������งLayer����� 
 

เ����Layer 
 

Guide layer 
 

สร้าง Folder เก็บ Layer 
 

ลบ layer 
 

Active Layer 
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Active Layer 
  
 ในการสราง Flash Movie ชึ้นมานั้น แมจะประกอบไปดวย Layer หลาย Layer แตเราจะทํางานไดเพียง 
ทีละ Layer เทานั้น Layer ที่เรากําลังทํางานอยูเราเรียกวา Active Layer สามารถสังเกตไดจะปรากฏเปนแบบสีดําที่ 
Layer นั้น และเราสามารถกําหนดสถานะตางๆของ Layer นั้นได เชนกําหนด ใหแสดงหรือซอน Layer,กําหนดให Layer 
นั้นสามารถปรบัแตงไดหรือไมได, กําหนดให Layer นั้นแสดงเฉพาะเสนโครงราง เปนตน 
 
การสราง Layer ใหม 

คลิกปุมสรางLayer  หรือ เลือกคําสั่ง Insert > Layer  
 
การเปลี่ยนชื่อLayer 

ดับเบิล้คลกิที่ชื่อเลเยอรเดิม แลวปอนช่ือใหมจากนั้นกดปุม  
 
การเปลี่ยนลําดับ Layer 

นําเมาสไปคลิกที่ช่ือเลเยอรที่ตองการเปลี่ยนลําดบั กดปุมเมาสคางไว แลวลากไปปลอย ณ ตําแหนงใหม  
  
การลบ Layer 

คลิกเลือกLayer ที่ตองการลบ  
คลิกปุม Delete Layer  
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การเปลี่ยนตําแหนง และส ีของวัตถุ 
 

ขั้นตอนที่ 1 วาดวงกลมลงไป 1 วง ที่ เฟรมที่ 1 
 

 
 
 
 
ขั้นตอนที่ 2 คลิกเมาสขวาทีเ่ฟรมที่ 20 แลวเลือก Insert Keyframe เพื่อใชเปนเฟรมหลักที่สามารถปรับวัตถุให

แตกตางกับเฟรมอื่นๆ ได 
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ขั้นตอนที่ 3 จะเห็นวาเกิดจุดวงกลมที่เฟรมที่ 20 ซึ่งเปน Keyframe ในขณะที่เฟรมที่ 2-19 ยังคงเปนวัตถุ

เดียวกับวัตถุในเฟรมที ่1 
 

 
 
ขั้นตอนที่ 4 คลิกเมาสขวาทีเ่ฟรมที่ 1 แลวเลอืก Create Shape Tween ซึ่งเปนการสราง Shape Tween 
 

 
 

ขั้นตอนที่ 5 เมื่อสรางเสรจ็จะเห็นวา ระวางคียเฟรมทัง้สอง จะเกิดลูกศรแถบสเีขียวเกิดขึ้น ซึ่งแทน Shape 
Tween โดยมีจุดเริ่มตนทีเ่ฟรมที่ 1 และสิ้นสุดทีเ่ฟรมที่ 20 
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ขั้นตอนที่ 6 คลิกทีเ่ฟรมที่ 20 แลวทําการลากวัตถุไปทางดานขวา (วงกลมสีดํา เพือ่บอกตําแหนงเกา สวนวงกลม

โปรงใสคือวงกลมที่ถูกลาก ณ ตําแหนงปจจุบัน)  
 

 
 

 
ขั้นตอนที่ 7 ขณะที่วงกลมทีเ่ฟรมที่ 20 ยังโดนมีสถานะโดนเลือกอยูนั้น ใหทําการปรบัสจีากสีเดมิ ใหเปนสีแดง 
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ขั้นตอนที่ 8 จะเห็นวาวงกลมของเราเปนสีแดงเรียบรอยแลว 
 

 
 

ขั้นตอนที่ 9 เมื่อเรากดทดสอบโดยกด <Ctrl+Enter> วัตถุจะวิ่งจากตําแหนงซายไปยังตําแหนงขวาโดยมีการ
เปลี่ยนสีและตําแหนงดังภาพ (จากภาพใชคําสั่ง Onion Skin และ Edit Multiple Frame ตรงไทมไลน เพื่อใหสามารถ
เห็นความเปลี่ยนแปลงของวัตถุในชวงเฟรมที่เลือก) 
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การเปลี่ยนรูปทรงวัตถุ 

ขั้นตอนที่ 1 วาดวงกลมลงไป 1 วง ที่ เฟรมที ่1 
 

 
 

ขั้นตอนที่ 2 คลิกเมาสขวาทีเ่ฟรมที่ 20 แลวเลือก Insert Blank Keyframe (กรณีที่ใช Insert Keyframe จะทํา
ใหติดวัตถุเหมือนกับเฟรมกอนหนามาดวย ก็ใหทําการลบวัตถุบนเฟรมนั้นออกไป ก็จะเปน Blank Keyframe 
เชนเดียวกัน) 

 

 
 

เมื่อเราสราง Blank Keyframe จะเห็นวาบน Stage จะไมมวีัตถุใดๆ ปรากฏ ยกเวนถามีการสรางวัตถุเอาไว 
ในเลเยอรอื่นที่เฟรมนั้นๆ 
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ขั้นตอนที่ 3 เลอืกเครื่องมือสําหรับวาดสีเ่หลี่ยม (คลกิเมาสคางเพื่อเปลี่ยน) แลวทําการวาดสี่เหลี่ยมลงไปดงัภาพ 
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ขั้นตอนที่ 4 คลิกเมาสขวาทีเ่ฟรมที่ 1 ซึ่งวาดรูปวงกลมเอาไว แลวเลือก Create Shape Tween 
 

 
 
จะไดผลลัพธดังนี ้
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สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

 
ขั้นตอนที่ 5 กด <Ctrl+Enter> เพื่อทดสอบผลลพัธ ซึ่งจะไดผลการเปลี่ยนแปลงดังภาพ 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

 
ขั้นตอนการปฏิบัติงาน  : ใหผูฝก ฝกปฏิบัติงานในหัวขอท่ี 1  
 

1. ฝกปฏิบัติการเปลี่ยนตําแหนง สี และรปูทรงของวัตถ ุ
1.1 ฝกปฏิบัตกิารเปลี่ยนตําแหนง และส ีของวัตถ ุ
1.2 ฝกปฏิบัตกิารเปลี่ยนรูปทรงของวัตถ ุ
 
 
 
 
 
 
 
 
 

 
อุปกรณและเครื่องมือ:  1. คอมพิวเตอร        

2. โปรแกรม Flash 
 
 
 

 
 
 
วัสด ุ :                    
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

1. ฝกปฏบิัตกิารเปลี่ยนตําแหนง สี และรปูทรงของวัตถ ุ
1.1 ฝกปฏิบัตกิารเปลี่ยนตําแหนง และส ีของวัตถ ุ

 
ขั้นตอนการเปลี่ยนตําแหนง และส ีของวัตถ ุ

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. วาดวงกลม 1 วง วาดวงกลมลงไป 1 วง ที่ เฟรมที่ 1  
2. Insert Keyframe คลิกเมาสขวาที่เฟรมที่ 20 แลวเลือก Insert 

Keyframe เพื่อใชเปนเฟรมหลักที่สามารถ
ปรับวัตถุใหแตกตางกับเฟรมอื่นๆ ได  

เกิดจุดวงกลมที่เฟรมที่ 20 ซึ่งเปน 
Keyframe ในขณะที่เฟรมที่ 2-
19 ยังคงเปนวัตถุเดียวกับวัตถุใน
เฟรมที ่1 

3. Create Shape Tween คลิกเมาสขวาที่เฟรมที่ 1 แลวเลือก Create 
Shape Tween ซึ่งเปนการสราง Shape 
Tween  

เมื่อสรางเสรจ็จะเห็นวา ระวางคีย
เฟรมทั้งสอง จะเกิดลูกศรแถบสี
เขียวเกิดขึ้น ซึ่งแทน Shape 
Tween โดยมีจุดเริ่มตนทีเ่ฟรม 
ที่ 1 และสิ้นสุดที่เฟรมที่ 20 

4. ยายตําแหนงของวัตถุ คลิกที่เฟรมที่ 20 แลวทําการลากวัตถุไป
ทางดานขวา 

วงกลมสีดํา เพื่อบอกตําแหนงเกา 
สวนวงกลมโปรงใสคือวงกลมที่ถูก
ลาก ณ ตําแหนงปจจบุัน 

5. ปรับสีจากสเีดิม ใหเปนสีแดง ขณะที่วงกลมที่เฟรมที่ 20 ยังโดนมีสถานะ
โดนเลือกอยูน้ัน ใหทําการปรับสจีากสเีดิม 
ใหเปนสีแดง  

วงกลมเปนสีแดง 

6. ทดสอบผลลัพธ กดทดสอบโดยกด <Ctrl+Enter> วัตถุจะ
วิ่งจากตําแหนงซายไปยังตําแหนงขวาโดยมี
การเปลี่ยนสีและตําแหนงดงัภาพ 

- 

หมายเหตุ  :      
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

1. ฝกปฏบิัตกิารเปลี่ยนตําแหนง สี และรปูทรงของวตัถ ุ
1.2 ฝกปฏิบัตกิารเปลี่ยนรูปทรงของวัตถ ุ

 
ขั้นตอนการเปลี่ยนรูปทรงของวัตถุ 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. วาดวงกลม 1 วง วาดวงกลมลงไป 1 วง ที่ เฟรมที ่1  
2. Insert Blank Keyframe คลิกเมาสขวาที่เฟรมที่ 20 แลวเลือก Insert 

Blank Keyframe เมื่อสราง Blank 
Keyframe จะเห็นวาบน Stage จะไมมีวัตถุ
ใดๆ ปรากฏ ยกเวนถามีการสรางวัตถุเอาไว
ในเลเยอรอื่นที่เฟรมนั้นๆ 

กรณีที่ใช Insert Keyframe จะ
ทําใหติดวัตถุเหมอืนกับเฟรมกอน
หนามาดวย ก็ใหทําการลบวัตถุ
บนเฟรมนั้นออกไป ก็จะเปน 
Blank Keyframe เชนเดียวกัน 

3. วาดสี่เหลี่ยม เลือกเครือ่งมอืสําหรบัวาดสี่เหลี่ยม คลิก
เมาสคางเพื่อเปลี่ยน แลวทําการวาด
สี่เหลี่ยมลงไป 

- 

4. Create Shape Tween คลิกเมาสขวาที่เฟรมที่ 1 ซึ่งวาดรูปวงกลม
เอาไว แลวเลือก Create Shape Tween 

- 

5. ทดสอบผลลัพธ กด <Ctrl+Enter> เพื่อทดสอบผลลัพธ ซึ่ง
จะไดผลการเปลี่ยนแปลง วัตถุจะวิ่งจาก
ตําแหนงซายไปยงัตําแหนงขวาโดยมกีาร
เปลี่ยนรปูทรงของวัตถ ุ

- 

หมายเหตุ  :      
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบงาน 
 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 1 
รหัสวิชา 0922124509 
งานที่  3 

 
   กําหนดใหผูฝกอบรมสรางวัตถุโดยใหวัตถุมีการเปล่ียนตําแหนง และสขีองวัตถุ 
   กําหนดใหผูฝกอบรมสรางวัตถุโดยใหวัตถุมีการเปล่ียนตําแหนง และรูปทรงของวัตถุ 
 

ตัวอยางช้ินงาน 
วัตถุมีการเปลี่ยนตําแหนง และสขีองวัตถุ 
 

 
 
วัตถุมีการเปลี่ยนตําแหนง และรูปทรงของวัตถุ 
 

 
 
 
ครุภัณฑ/เครื่องมือ/วัสด/ุอุปกรณ  
 

1. คอมพิวเตอร 
2. โปรแกรม Flash 
 
 
 
 

 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

143

143 
 

 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเตรียมการสอน 
(ทฤษฎี) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
หัวขอที่ 4 เวลา  2  ชั่วโมง 

 
วัตถุประสงค  :  เพื่อใหผูรับการฝกมีความรู ความสามารถเกี่ยวกับพื้นฐานการสรางภาพเคลื่อนไหว 

 
วิธีการสอน  :  บรรยาย สาธิต และใหฝกปฏิบัต ิ
 
 
หัวขอสําคัญ :  1) การออกแบบตัวละคร 

2) ชนิดของตัวละครหลัก 
3) การออกแบบ Character 
4) ทาทางของตัวละครและอารมณทางสีหนา 

  
อุปกรณชวยฝก :  1. คอมพิวเตอร   2. โปรแกรม Flash  
 
การมอบหมายงาน  : 
การวัดและประเมินผล  : 
หนังสอือางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครัง้ที่ 6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครัง้ที่ 2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเดี้ยนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรีเมียร. 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ทฤษฎี) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
หัวขอที่ 4 

 
Expression  
 
การออกแบบตัวละคร  

เรื่องราวทัง้หมดของการตูนแอนเิมชัน่จะถายทอดโดยนักแสดงหรอืตัวละครเปนหลกั โดยการพูด การกระทําที่
แสดงออก รวมทั้งความสัมพันธกบัตัวละครตัวอื่นๆ ซึ่งสามาถบงบอกถึงบุคลิกลักษณะของตัวแสดงโดยแบงออกเปน 2 
ลักษณะ คือ  

 
1. บุคลิกแบบจําลอง หมายถึง บุคลิกลกัษณะทั่วๆ ไป ซึ่งอาจจะไมเปนจรงิ ในขณะที่คนอื่นๆ  มักจะคาดเดาวา

คนในบุคลิกแบบนั้นจะมีนิสัย อาชีพ ฯลฯ อยางไร นั่นคือ การประเมินตัวละครที่เห็นจากบุคลกิภาพภายนอก เชน คนที่ใส
แวนหนาๆ จะเปนพวกหนอนหนงัสือ เปนตน  

 
ภาพตัวอยางแสดงบุคลิกของตัวละคร 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ทฤษฎี) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
หัวขอที่ 4 

 
2. บุคลิกลกัษณะพิเศษเฉพาะตัว หมายถึง บุคลิกพิเศษเฉพาะตัว ของตัวการตูน ตัวการตูนที่ดีควรมีเอกลักษณ

ของตัวเอง เพื่อใหคนดูสนใจ จดจํา และติดตาม เชน ตัวละครคนแคระทั้งเจ็ด ในภาพยนตรเรื่องสโนวไวทแตละตัวจะมี
บุคลิกที่แตกตางกันไป ทั้งนี้เราสามารถใชบุคลิกพิเศษของตวัละครแตละตัวเพิ่มสีสันใหกับเนื้อเรื่องของการตูนไดดวย  

 
ภาพแสดงบุคลิกพิเศษของตัวละคร 
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ชนิดของตัวละครหลัก 

ชนิดของตัวละครหลักที่มีอยูในทกุๆ เรื่อง โดยจะแบงสถานะของตัวละครออกเปน 7 ชนิด คือ 
Hero : หรือพระเอก หรือจะเรียกวาตัวละครหลักของเรือ่ง จะมเีปาหมายในชีวิตวาจะตองไปทําอะไรสักอยาง 

ใหสําเร็จ อาจจะเกงหรือไมเกงก็ไดวากันไปตามเนื้อเรื่อง ถาจะใหดีตองมีปมดอยอะไรสักอยางเอาไวเปนจุดออนหนอย 
ก็จะดูนาสนใจขึ้นมาก  

Mentor : อาจารยหรอืผูแนะนําของ Hero เชน แกนดาลฟใน Lord of the ring หรือ ทานฤๅษีในสุดสาคร 
บุคลิกของ Mentor จะออกแนวฉลาดรอบรู รูจักอาวุธในตํานาน เกงกาจเหนอืมนุษย ใจดี มีเมตตา  

Herald : เพื่อพระเอก คอยสงขาวสาร คอยบอกขอมลูตางๆ ใหพระเอก เปนที่ปรึกษา คอยชวยเหลอืพระเอก  
ใหผานพนเรื่องราวตางๆ จากเรื่องหนึง่ไปสูอีกเรื่องหนึ่งได  

Threshold guardian : หยิ่งๆ ดุๆ ไมเอาใคร ไมฝกใฝฝายใด มักจะเปนพวกทีเ่ฝาอาวุธในตํานาน หรือมังกร  
หรือ สัตวประหลาดอะไรทํานองนี้ มีหนาที่หลักๆ คือ คอยพิสูจนฝมือและความตั้งใจจริงของ Hero  

Shape shifter : ไมคอยจริงใจเปนหนาทีห่ลักของ Shape shifter เปนพวกนกสองหัวทีเ่ปลี่ยนไปไดเรื่อยๆ  
เปนตัวที่คอยทรยศ หักหลงั ทําใหเรื่องราวเปลี่ยนมมุ ไปจากที่เปน คอยสรางความสับสนใหเนื้อเรื่อง  

Trickster : ตัวปวน ตัวโจก ชวยสรางสสีันและเสียงหัวเราะ ใหเรือ่งราว มักจะมาในรูปแบบตัวอะไรก็ได เล็กๆ 
นารักๆ เบอะบะ ซุมซาม มีไดทั้งฝง Hero และ Shadow อาจจะเปนตัวหลักหรือเปนฝูงๆ หรืออาจจะโผลมาเปนชวงๆ 
ชวงละตัวก็ได ตัว Trickster นี่ถาไมมีในเนื้อเรื่องคงขาดความสนุก ไปเลยทเีดียว  

Shadow : ผูราย จอมมาร มีหนาทีห่ลกัคือ คอยขัดขวางพระเอก หรือมหีนาทีเ่กงอยางเดียว นอนรอให 
พระเอกไปปราบ   
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การออกแบบ Character 
     การออกแบบ Character จะมีหลักการอยูสองเรือ่ง คือ Style และ Profile 

Style  
Style  เปนการเลือกสไตลของตัวการตูนวาจะใหออกมาแนวไหน แนวจริงจงั หรือแนวคิกขุนารกั ใชลายเสนแบบ

ไหน สีสันสดใสหรือดอูึมครมึ สําหรับเรื่อง Style แนะนําใหหาการตูนเยอะๆ กจ็ะหาทางที่เหมาะๆ ไดเอง ไมวาเปนแบบ
เหมอืนจริง แบบการตูนลายเสน 3 มิติ หรือแบบการตูนเล็กๆ แนว SD 
          หลงัจากกรอกรายละเอียดพวกนี้ครบหมดแลว คราวนี้เวลาออกแบบกจ็ะพอมีเหตุผลวาทําไมตองมีสิง่ตาง ๆ 
ปรากฏอยูในตัวละครของเรา 
          การออกแบบ Character ที่ดีไมใชวาจะตองสวยอยางเดียว ถาสวยแลวตอบไมไดวาเปนอะไร อายุเทาไหร ถือดาบ
เพราะอะไร ทําไมตองคาบบหุรี ่ทําไมตองใสหมวก จะไปไหน ไปทําอะไร และอื่นๆ อีกมากมาย หลายคําถาม ก็เหมอืนมัน
เปนแคภาพที่มี่วิญญาณ ไมมีเรือ่งราว หรือหนักๆ เขาก็คือ เหมือนแคไปลอกงานสวยๆ มาเทานั้นเอง  

Profile Data 
Profile Data เปนสิ่งที่สําคัญมากๆ สําหรบังานออกแบบ Character คือ เวลาออกแบบตัวละคร กอนอื่นควรจะ

ใส Profile พวกนี่กอน โดย Profile หลักๆ จะมอียู 7 หัวขอ คือ 
ID : อาย,ุ เพศ, สวนสูง, สีผิว, ผม, ตา และจุดสังเกตสําคัญๆ เชน ใสแวนดําตลอดเวลา หรือมปีกเล็กๆ เปนตน  
Characteristic : เปนตัวทีบ่อกบุคลิกวาเปนคนอยางไร อารมณดีตลอดเวลา หรือซมึเศราเกบ็ตัว มีความเปน

ผูนํา หรืออื่นๆ ที่เปนบุคลิกเฉพาะของตัวละครตัวน้ี  
Role : บอกบทบาทหลักๆ วามีหนาที่ทําอะไรในเรื่องนี้ เชน เปนเด็กจากชนบทตองการไปตามหาอาวุธในตํานาน

เพื่อปกปองโลก หรอืตองไปแกแคนใหทานพอ  
Origin : เปนรากเหงาของตัวละครวามาจากไหน จากหมูบานอะไร หรอืจากดาวดวงไหนในกาแล็กซี ่ 
Background : บอกภูมหิลงัของตัวละครสักหนอยวาเคยทาํอะไรมา ทําไมตองมาอยูในเรื่องนี้ เชน เคยเปนเดก็

ชาวนา ตอนเด็กๆ ไดเรียนคาถาอาคมมาบาง จงึมีวิชาติดตัวมาพอสมควร และดวยความที่หลวงตาสอนมาใหชวยเหลือ
ผูคน จึงออกเดินทางเพือ่ชวยเหลือคนที่เดอืดรอน  

Power : มีพลงัพิเศษ หรือความสามารถพิเศษอะไร  
Associate : มีแนวรวมเปนใครบาง เชน Hero ก็จะมีแนวรวมเปน Mentor และ Herald แลวแนวรวมที่วานี้

ชวยทําอะไรบาง  
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การออกแบบ Character 
     สําหรับขั้นตอนการออกแบบ Character จะไมมีขั้นตอนที่แนนอนตายตัว ขึ้นอยูกับหลายๆ ปจจัยทีเ่ขามาเกี่ยวของ  
ไมวาจะเปนเรือ่ง การนําไปใชงาน งานสเกลใหญหรือเลก็ หรือนําไปใชในสื่ออะไร แตโดยรวมๆ แลว การออกแบบ 
Character ทั่วไปก็จะหนีไมพน 5 ขั้นตอนตอไปนี้ 
1. เริ่มจากโจทย 

โจทยที่วากม็าจากเนื้อเรื่องนั่นเอง กอนอื่นตองเขาใจกันกอนวาถึงเนื้อเรื่องจะดีแคไหน ก็ใชวางานจะออกมาดีได
ตลอด เมื่อมีเนื้อเรือ่งที่ดีแลว ในการนําเสนอออกไป ควรจะมีความนาสนใจดวย ทางเลือกแรกๆ สําหรับการสรางความ
สนใจใหเนื้อเรื่องก็คือ มี Character ที่นาสนใจ ดังนั้น ในข้ันตอนแรก ควรดูเนื้อเรื่องแลวสรุปโจทยออกมาใหไดเสียกอน 
วาจะทําอะไร เชน“ออกแบบตัวละครหลักสําหรับเกม โดยใหเปนอาชีพนักรบเด็ก เปนตัวที่มเีผาผสมระหวางซอมบี้กับ
มังกร และ มีอารมณที่ชวนอึดอัด” 

นักออกแบบ Character ควรทํางานตอบโจทยที่กําหนดมาใหไดถูกตองทีสุ่ด แบบนีง้านจะตรงกบัความตองการ 
ตรงกบัเนื้อเรือ่ง แลวทํางานตอไดอยางราบรื่น 
2. สรางและออกแบบขอมูลของ Character 

เปนขั้นตอนที่ตองสรางขอมูลของ Character ขึ้นมากอนตรงนี้ใหกรอกขอมลูในสวนของ Profile Data ใหครบ 
ก็ถือวาเพียงพอแลว แตโดยหลักการแลว Profile Data เปนเพียงแบบฟอรมเบื้องตนเทานั้น ถาตองการใหตัวละครของเรา
มีชีวิตจริงๆ ก็ควรจะมีขอมูลตางๆ ใหเหมอืนสิง่มีชีวิตจรงิๆ มากที่สุด Character Designer บางทีเตรียมขอมลูละเอียดถึง
ขัน้เรียงลําดับญาติของตัวละครทั้งหมด 

การวาดใหสวยเปนสวนหนึ่งเทานั้น เพราะขอมลูทีส่รางขึ้นมาจะสงผลกบัตัวละครที่พบเจอสิง่ตางๆ ในเนื้อเรือ่ง 
ดังนั้น เตรียมขอมูลใหเยอะที่สุด ตัวละครกจ็ะดูเหมือนจรงิมากที่สุด 
3. วาด 

เปนขั้นตอนทีส่นุกสําหรับงานออกแบบ Character ซึ่งมีมากมายหลายวิธี เชน ทดลองเขียนไปหลายๆ รูป หรือ
เรียกกันวาเขียน Thumbnail หรือจะเขียนมันรูปเดียวแลวคอยๆ แก คอยๆ ตกแตงไปเรือ่ยๆ จนไดตรงตามความตองการ 

มีขอแนะนําสําหรับการทํางาน คือ พยายามเขียนไปเรื่อยๆ ไมตองไปใสใจวาจะสวยหรอืไมสวย แลวมาดูวา 
ตัวไหนตรงใจมากทีสุ่ดก็คอยจบัมาพฒันาตอ โดยนึกถึงขอมลูและโจทยที่เตรียมไว งานก็จะออกมาด ีเคล็ดลบัในการ
ออกแบบ Character คือ ตองออกแบบใหมเีอกลักษณ  
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เตรียมตัวละคร (The Cast) 

หลงัจากที่ไดออกแบบเรียบรอยแลว ตองขัดเกลา (Clean up) หรือลอกเสนหรือวาดใหมใหสวยงามพรอมนําตัว
การตูนไปใชตอได การวาดภาพการตูนควรเริ่มตนจากโครงสรางของภาพดวยรปูทรงพื้นฐานตางๆ เชน สี่เหลี่ยม, วงกลม, 
วงรี เปนตน และควรคํานงึถึงขนาดและสัดสวนของรูปทรง เพื่อใหตัวการตูนทีอ่อกมาไดภาพที่ไดองคประกอบที่ถูกตอง  
  
สราง Character Model Sheet  

หลงัจากที่เราไดตัวละครมาแลว คราวนี้ก็เปนการวาดดานอืน้ๆ ของตัวละคร เพื่อใหคนทีเ่อางานไปทําตอเขาใจตัว
ละครไดมากที่สุด โดยทําออกมาเปน Character Model Sheet 

Character Model Sheet คือ แผนแสดงภาพการตูนหรอืตวัแสดงตางๆ ที่ใชงานในแอนิเมชัน ซึ่งแสดงถึงการ
ออกแบบ รูปทรง สัดสวน และโครงสรางตางๆ ของรางกาย เปนตน การตูนแตละตัวจะถูกออกแบบในหลายลกัษณะ
ทาทางโดยนักวาดภาพ (Artists) ซึ่งแตละคนกจ็ะมสีไตลเปนของตัวเอง  

ดังนั้น นักแอนนิเมเตอร (Animator) จึงตองอาศัยเครือ่งมอื Model Sheet ในการอางอิงเพื่อใหภาพที่ไดรับการ
ออกแบบมานั้นมีทิศทางที่ตรงกัน การวาดภาพโดยการอางองิ Model Sheet เรามกัจะเรียกกันวา “On-model” ภายใน 
Model Sheet จะประกอบไปดวยภาพการตูนที่มีหลากหลายทาละมมุมองที่แตกตางกัน 

เนื่องจากตัวประกอบบางตัวไมไดแสดงในหลายๆ ฉาก อาจไมจําเปนตองใช Model Sheet ในการอางอิง (Off-
model) แตอยางไรก็ตามแนะนําใหสราง Model Sheet ในการอางองิกอนลงมือสรางการตูนแอนเิมชัน่ดวยโปรแกรม 
Flash เพราะชวยสรางมาตรฐานของตัวละคร และยังประหยัดเวลา ทําใหงานเสร็จสิ้นไดในเวลาอันสั้น 

 
ภาพแสดงสราง Character Model Sheet 
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Synchronization  
 
ทาทางของตัวละครและอารมณทางสีหนา  

เวลาเริ่มตนการวาดสีหนาของตัวละคร สิ่งที่ตองรูอยางแรก คือ นิสัยของตัวละคร พอรูนสิัยของตัวละครแลว 
เวลาวาดการแสดงอารมณก็จะวาดงายยิ่งขึ้น 

 
ภาพการแสดงอารมณของตัวละคร 

 

 
 

สองคนนี้ทัง้ๆที่ยิ้มเหมือนกัน ทําไมใหความรูสึกที่ตางกัน คําตอบคือ องศาของคิ้ว 
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ภาพการวาดค้ิวที่ทําใหอารมณของตัวละครแตกตางกันไป 

 
 

 
รูปแบบของคิ้วมีแค 3 แบบ ซึ่งคิ้วแตละแบบก็แสดงอารมณที่หลากหลาย แมตัวละครจะคิ้วจุด หรือ คิ้วหนา  

จะมสีวนประกอบสองอยางคือ หัวค้ิว หับหางคิ้วเทานั้น ซึ่งเวลาคิ้วขมวดหรือกระตุกก็คือ การเคลือ่นตัวของกลามเนือ้ 
ตรงบริเวณนั้นนั่นเอง  
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ภาพตัวอยางของการเปลี่ยนแปลงของค้ิว 

 

 
 

สังเกตวาค้ิวมีสวนคอนขางมากเวลาแสดงอารมณตางๆ และนอกจากคิ้วก็คือ ตา 
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ภาพวาดค้ิวกับดวงตา 

 
 
 

สังเกตที่ดวงตา การเคลื่อนตัวของลูกนัยนตาก็ชวยขับดันอารมณเชนกัน อยางดวงตาลางสุดหากเทียบกับบนสุด 
อาจจะดกูดดันกวาหรอืตัวละครอาจจะกําลังทําหนาเบื่อหนายสุดยอดก็เปนได และหลักเกณฑนี้ก็ใชไดกับเพศหญิงเชนกนั  
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ภาพวาดค้ิวกับดวงตาในแบบตางๆ 

 

 
 

จะเห็นวาไมตางกัน ลักษณะดวงตาเองก็เปนสวนชวยในการกําหนดบุคลิก ดวงตาจะมหีางชี้กบัหางตก ซึ่งทั้งสอง
แบบก็แสดงความรูสึกที่แตกตางกันไป แตไมจําเปนเสมอไปวาบุคลิกและนสิัย จะตองเหมือนรปูลักษณภายนอกเสมอไป 
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   คําช้ีแจง แบบทดสอบมีทั้งหมด 2 ตอน 
   ตอนที่ 1 เขียนเคร่ืองหมาย ลอมรอบตัวอักษรหนาคําตอบที่ถูกตอง 

 
1. การออกแบบ Character จะมีหลักการอยูสองเรื่อง  
คือขอใด 

ก Style และ Profile 
ข Style และ Role 
ค Style และ Origin 
ง Style และ Power 

2. สิ่งใดไมเกี่ยวของกับ Profile Data 
ก ID    ข  Power 
ค Style   ง  Background 

3. ขอใดเปนสวนประกอบของ ID 
ก อาย,ุ เพศ, สีผิว 
ข อาย,ุ สวนสงู, ผม 
ค เพศ, สีผิว, สวนสงู 
ง ถูกทุกขอ 

4. ขอใดเปนเปนรากเหงาของตัวละคร 
ก Role   ข  Origin 
ค Associate  ง  Characteristic 

5. ขอใดคือบุคลิกเฉพาะของตัวละคร 
ก Role   ข  Origin 
ค Associate  ง  Characteristic 
 

 
6. ตัวปวน ตัวโจก ชวยสรางสีสันและเสียงหัวเราะ คือ ขอใด 

ก Hero   ข  Herald 
ค Trickster  ง  Mentor 

7. ตัวละครที่คอยชวยเหลือพระเอก คือ ขอใด 
ก Herald  ข  Mentor 
ค Shadow  ง  Shape shifter 

8.   
ภาพที่ปรากฏมีชื่อเรียกวาอะไร 

ก Character  ข  Model Sheet 
ค Thumbnail  ง  Characteristic 

9. การวาดภาพการตูนควรเริม่ตนจากขอใด 
ก ลักษณะดวงตา 
ข การแสดงอารมณ 
ค นิสัยของตัวละคร 
ง รูปทรงพื้นฐานตางๆ 

10. อวัยวะสวนใดมีผลตอการแสดงอารมณมากทีสุ่ด 
ก ตา 
ข คิ้ว  
ค ปาก  
ง คาง 
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   ตอนที่ 2 กําหนดใหผูเขาฝกทําการฝกเขียนภาพการตูนเคลื่อนไหว 1 อิริยาบถ โดย

ประกอบดวยภาพ keyframe และ inbetween 
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1. การออกแบบ Character จะมีหลักการอยูสองเรื่อง  
คือขอใด 

ก Style และ Profile 
2. สิ่งใดไมเกี่ยวของกับ Profile Data 

ค Style  
3. ขอใดเปนสวนประกอบของ ID 

ง ถูกทุกขอ 
4. ขอใดเปนเปนรากเหงาของตัวละคร 

ข  Origin 
5. ขอใดคือบุคลิกเฉพาะของตัวละคร 

ง  Characteristic 
6. ตัวปวน ตัวโจก ชวยสรางสีสันและเสียงหัวเราะ คือ ขอใด 

ค Trickster 
7. ตัวละครที่คอยชวยเหลือพระเอก คือ ขอใด 

ก Herald 

8.   
ภาพที่ปรากฏมีชื่อเรียกวาอะไร 

ข  Model Sheet 
9. การวาดภาพการตูนควรเริม่ตนจากขอใด 

ง รูปทรงพื้นฐานตางๆ 
10. อวัยวะสวนใดมีผลตอการแสดงอารมณมากทีสุ่ด 

ข คิ้ว  
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ภาพตัวอยาง 

การเคล่ือนไหว 1 อิริยาบถ โดยประกอบดวยภาพ keyframe และ inbetween 
 

 
 
 
 
 
 
 
 
 
 
 

 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

159

159 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบประเมนิแบบทดสอบ 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
หัวขอที่ 4 

 
เกณฑการประเมิน  :   
 

เกณฑการใหคะแนน ระดับคะแนน 
1. ความสมจรงิของการเคลื่อนไหว 25  คะแนน 
2. ความเหมาะสมของการเคลื่อนไหว 25  คะแนน 
3. ความคิดสรางสรรค 25  คะแนน 
4. ชิ้นงานมีความสวยงามและเรียบรอย 25  คะแนน 

รวม 100  คะแนน 
 
หมายเหตุ  :       

ระดับคะแนน  90-100 คะแนน หมายถึง ดีเยี่ยม 
ระดับคะแนน  70-89 คะแนน หมายถึง ด ี
ระดับคะแนน  50-69 คะแนน หมายถึง ผานเกณฑ 
ระดับคะแนน  0-49 คะแนน หมายถึง ไมผานเกณฑ 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเตรียมการสอน 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 เวลา  4  ชั่วโมง 

 
วัตถุประสงค  :  เพื่อใหผูรบัการฝกมีความรู ความสามารถเกี่ยวกับพื้นฐานการสรางภาพเคลื่อนไหว 

 
วิธีการสอน  :  บรรยาย สาธิต และใหฝกปฏิบัต ิ
 
  
อุปกรณชวยฝก :  1. คอมพิวเตอร   2. โปรแกรม Flash  
 
การมอบหมายงาน  : 
 
การวัดและประเมินผล  : 
หนังสอือางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครั้งที ่6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครั้งที ่2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเด้ียนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรเีมียร. 
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รหัสหลักสูตร 0920084210102 
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รหัสวิชา 0922124510 
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รางเสนตัวการตูน 
 

ภาพตนแบบ 
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สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
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Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

 
รางเสนตัวการตูน 
 

ภาพตนแบบ 
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สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

 
1. ใช    Line Tool รางเสนบนกระดาษ  
 

 
 

2. ใช  Selection Tool (V) ในการดึงเสนใหโคง โดยเมื่อนํา Selection Tool มาวางดานขาง ของเสนจะ
เกิดเสนโคงขึ้น สามารถดึงได  จะได โครงหนารูปคนออกมา 
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สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

 
3.สําหรับการสรางคิ้ว ก็ทําวิธีเดียวกันแตเปลี่ยนขนาดเสนใหเปน 2 

 
 

จะไดภาพแบบนี ้

 
เพื่อใหคิ้ว 2 ขางเทากันไมควรสรางอีกขาง ใหใชเมาสจี้ที่คิ้วใหเกิดภาพดังนี ้
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

 
จากนั้นกด Ctrl+C และ Ctrl+V เพื่อเปนการ Copy คิ้วอันเดิม แลวจากนัน้กด Modify> Transform> Filp 

Horizontal 

 
 
 
แลวนํามาวางขางกันจะไดภาพดังนี ้
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

 
4. ภาพตาก็เชนกันเพียงแคเปลี่ยนขนาดของเสนใหกลายเปน 1 เพียงเทานั้น 
 
5. จากนั้นภาพลูกนัยนตา ใหใช Brush Tool (B) เลอืก ขนาดใหเหมาะสมกับภาพ  
 

 
 
จะไดภาพดังนี ้
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

 
6. จากนั้นวาดจมูก โดยการสรางภาพสามเหลี่ยม แลวนําเขามาใสในภาพใบหนาภายหลัง  

 
 

7. วาดปากโดยใช   Line Tool (N)  แลวดึงเอาหรือ Pencil Tool (Y) วาดเอาก็ไดถาผิดพลาดสามารถ
ลบไดโดย Ereser Tool (E)จะไดภาพดังนี ้

 

 
 

 
 
 

 
 

ภาพจมูกที่ได 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
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Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

 
 

8. จากนั้นตกแตงตัวละครใหมรีูปรางสวนอื่นๆ ดังนี ้
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

 
ใสสีสันใหกับตัวการตูน 
 

ภาพตนแบบ 
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ชื่อภาษาอังกฤษ 2D Animation 
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1. ใช Colors ในการเลอืกส ี 

 

 
 

2. สําหรบั สผีิวของตัวการตูน ใชสีครีม (รหสัส ี#FEDFB3) 
 

 
 
 

 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

170

170 
 

 

หลักสตูรการฝกยกระดับฝมือ 
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ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
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รหัสวิชา 0922124510 
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3. จะสังเกตไดวาไมสามารถที่จะใช ถังสีในการลงสีที่แขนได เนื่องจากยงัเหลอืชองวางอยูในกรณี น้ีสามารถ

แกปญหาได 2 วิธีใหเลือกใช 
 
3.1 ใช  Line Tool (N) มาปดชองวาง แลวเอาถังสีเทใสอกีครั้ง 
 

 
 

3.2 ใช  Brush Tool (B) คอยๆ ระบายไป 
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4. เมื่อลงสีขั้นแรกเสรจ็แลวจะไดภาพแบบนี ้ 

 
 
 

5. จากนั้นมาเกบ็รายละเอียด 
 
- วิธีการทําสวนสีขาวของดวงตา ใช  Line Tool (N) ใช  Selection Tool (V) ดึงใหโคง แลววางที่

ดานลางของดวงตาแลวใชถังสีเทใสไดเลย (Line ใชสีขาว)  
 
- จากนั้น ใสความยับของเสื้อผาอาจใช  Pencil Tool (Y) วาด และเก็บรายละเอียดดวย 

 Eraser Tool (E) 
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6. จะไดภาพดังนี ้
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ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
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รหัสวิชา 0922124510 
งานที่ 4 

 
ทําใหภาพมีการเคลือ่นไหวอยางงายๆ 

 
1. เตรียมตัวการตูน ที่ตองการใช 

 
 

2. เพื่ม Layer ขึ้นมา 1 Layer     
 

3. Insert Key Frames ขึ้นมาใน Frames ที่ 2 ของ Layer ที่ 2 เพื่อตัดภาพในพื้นที่  
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ใบขอมูล 
(ปฏิบตัิ) 
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รหัสวิชา 0922124510 
งานที่ 4 

 
4. วาดรูปกอนเมฆใหเต็มจอ  

 
  

5. จากนั้น คลิกขวาที่ Frames ที่ 2 ของ Layer ที่ 2 Create Motion Tween  
 

 
  

6. จากนั้นเลือกความเร็วของเมฆ แลว Insert Key Frames ที่ Frames นั้น 
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(ปฏิบตัิ) 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
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รหัสวิชา 0922124510 
งานที่ 4 

 
7. เลื่อนกลับมาที ่ Frames แรกของ Motion Tween (สังเกตุที่สีมวง) ของ Layer 2  

 

 
 

8. เลื่อนกอนเมฆไปดานหลงัของ Stage  

 
 

9. เลื่อนกลับมาที ่ Frames สุดทายของ Motion Tween (สังเกตุทีส่ีมวง) ของ Layer 2 
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รหัสวิชา 0922124510 
งานที่ 4 

 
10. เลื่อนกอนเมฆไปดานหนาของ Stage  

 

 
 

11. ทําแบบนี้อีก 2 -3 ครั้งสลบักันไปแลวเลือ่นกลบัมาใหเปนเฟรมแรก จากนั้นเลื่อนรปูขึ้นมาทีบ่นสุดแลว Insert 
Frames ใหไกลเทา Key Frames Motion Tween  ของกอนเมฆ 
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รหัสวิชา 0922124510 
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ขั้นตอนการปฏิบัติงาน  : ใหผูฝก ฝกปฏิบัติงานในหัวขอท่ี 1  
 

1. ฝกปฏิบัติการสรางการเคลื่อนไหวใหกับตัวการตูน 
1.1 ฝกปฏิบัติการรางเสนตัวการตูน 
1.2 ฝกปฏิบัติการใสสีสันใหกบัตัวการตูน 
1.3 ฝกปฏิบัติการสรางการเคลื่อนไหวใหกับตัวการตูน 
 
 
 
 
 
 
 

 
 

 
อุปกรณและเครื่องมือ:  1. คอมพิวเตอร        

2. โปรแกรม Flash 
 
 
 

 
 
 
วัสด ุ :                    
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ชื่อภาษาอังกฤษ 2D Animation 
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ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

1. ฝกปฏบิัตกิารสรางการเคลื่อนไหวใหกบัตัวการตนู 
1.1 ฝกปฏิบัติการรางเสนตัวการตูน 

 
ขั้นตอนการรางเสนตัวการตูน 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. รางเสน ใช    Line Tool รางเสนบนกระดาษ - 
2. ดึงเสนใหโคงใหได โครงหนารูปคน ใช  Selection Tool (V) ในการดึงเสน

ใหโคง โดยเมือ่นํา Selection Tool มาวาง
ดานขาง ของเสนจะเกิดเสนโคงขึ้น สามารถ
ดึงได  จะได โครงหนารปูคนออกมา 

- 

3. สรางคิ้ว สําหรับการสรางคิ้ว ก็ทําวิธีเดียวกันแต
เปลี่ยนขนาดเสนใหเปน 2 

เพื่อใหคิ้ว 2 ขางเทากันไมควร
สรางอีกขาง ใหใชเมาสจี้ที่คิ้ว 
จากนั้นกด Ctrl+C และ Ctrl+V 
เพื่อเปนการ Copy คิ้วอันเดิม 
แลวจากนั้นกด Modify> 
Transform> Filp Horizontal 
แลวนํามาวางขางกัน 

4. สรางตา ภาพตาก็เชนกันเพียงแคเปลี่ยนขนาดของ
เสนใหกลายเปน 1 จากนั้นภาพลกูนัยนตา 
ใหใช Brush Tool (B) เลือก ขนาดให
เหมาะสมกับภาพ 

- 

5. วาดจมูก วาดจมูก โดยการสรางภาพสามเหลี่ยม แลว
นําเขามาใสในภาพใบหนาภายหลงั 

- 

6. วาดปาก วาดปากโดยใช   Line Tool (N)  แลว
ดึงเอาหรือ Pencil Tool (Y) วาดเอาก็
ไดถาผิดพลาดสามารถลบไดโดย 

Ereser Tool (E) 

- 

หมายเหตุ  :      
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

1. ฝกปฏบิัตกิารสรางการเคลื่อนไหวใหกบัตัวการตนู 
1.2 ฝกปฏิบัติการใสสีสันใหกบัตัวการตูน 

 
ขั้นตอนการใสสีสันใหกับตัวการตูน 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. ใช Colors ในการเลอืกส ี สําหรับ สผีิวของตัวการตูน ใชสีครมี (รหัสส ี

#FEDFB3) 
- 

2. ลงสทีี่แขน ใช  Brush Tool (B) คอยๆ ระบายไป ไมสามารถที่จะใช ถังสีในการลงสี
ที่แขนได เนื่องจากยงัเหลือ
ชองวางอยู 

3. เก็บรายละเอียดของดวงตา ทําสวนสีขาวของดวงตา ใช  Line 
Tool (N) ใช  Selection Tool (V) ดึง
ใหโคง แลววางที่ดานลางของดวงตาแลวใช
ถังสีเทใสไดเลย (Line ใชสีขาว) 

- 

4. เก็บรายละเอียดใสความยับของ
เสื้อผา 

ใสความยับของเสื้อผาอาจใช  Pencil 
Tool (Y) วาด และเก็บรายละเอียดดวย 
 Eraser Tool (E) 

- 

หมายเหตุ  :      
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ชื่อภาษาอังกฤษ 2D Animation 
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ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

1. ฝกปฏบิัตกิารสรางการเคลื่อนไหวใหกบัตัวการตนู 
1.3 ฝกปฏิบัติการสรางการเคลื่อนไหวใหกับตัวการตูน 

 
ขั้นตอนการสรางการเคลื่อนไหวใหกับตัวการตูน 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. เตรียมตัวการตูน ทีต่องการใช นําตัวการตูนที่เคยสรางไวในงานที่แลวมาใช - 
2. เพิ่ม Layer 

เพิ่ม Layer ขึ้นมา 1 Layer     
- 

3. Insert Key Frames Insert Key Frames ขึ้นมาใน Frames ที่ 
2 ของ Layer ที่ 2 เพื่อตัดภาพในพื้นที ่

- 

4. วาดรูปกอนเมฆ วาดรูปกอนเมฆใหเต็มจอ - 
5. Create Motion Tween คลิกขวาที่ Frames ที่ 2 ของ Layer ที่ 2 

Create Motion Tween 
- 

6. เลือกความเร็วของเมฆ เลือกความเร็วของเมฆ แลว Insert Key 
Frames ที่ Frames 

- 

7. กลับมาที ่ Frames แรก เลื่อนกลบัมาที ่ Frames แรกของ Motion 
Tween  

สังเกตุทีส่ีมวง ของ Layer 2 

8. เลื่อนกอนเมฆไปดานหลงั เลื่อนกอนเมฆไปดานหลังของ Stage - 
9. เลื่อนกลับมาที ่ Frames สุดทาย เลื่อนกลบัมาที ่ Frames สุดทายของ 

Motion Tween  
สังเกตุทีส่ีมวง ของ Layer 2 

10. เลื่อนกอนเมฆไปดานหนา เลื่อนกอนเมฆไปดานหนาของ Stage - 
11. ทําอีก 2 -3 ครั้งสลบักัน แลว
เลื่อนกลบัมาใหเปนเฟรมแรกแลว 
Insert Frames 

ทําแบบนี้อกี 2 -3 ครั้งสลับกันไปแลวเลื่อน
กลับมาใหเปนเฟรมแรก จากนั้นเลื่อนรปู
ขึ้นมาที่บนสุดแลว Insert Frames ใหไกล
เทา Key Frames Motion Tween  ของ
กอนเมฆ 

- 

หมายเหตุ  :      
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ชื่อภาษาอังกฤษ 2D Animation 
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ใบงาน 
 

หัวขอวิชา การกําหนด Layout,  
Key frame, In-between และ 
Expression 2 
รหัสวิชา 0922124510 
งานที่ 4 

 
   วิทยากร/ครูฝกกําหนดใหผูรับการฝกไดใหสรางการตูนโดยใชเครื่องมือตางๆ ของ 

Adobe Flash มาสราง และนําเทคนิค Motion Tween และ Frame by Frame  
    มาสรางใหตัวการตูนเคลื่อนไหว  

 
ภาพตัวอยาง 

การนําเทคนิค Motion Tween และ Frame by Frame มาสรางใหตัวการตูนเคลื่อนไหว 

                    
 
 
 
 
ครุภัณฑ/เครื่องมือ/วัสด/ุอุปกรณ  

1. คอมพิวเตอร 
2. โปรแกรม Flash  
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วัตถุประสงค  :  เพื่อใหผูรบัการฝกมีความรู ความสามารถลงสีลงในฉากและตัวละครโดยใชโปรแกรมคอมพิวเตอร 

 
วิธีการสอน  :  บรรยาย สาธิต และใหฝกปฏิบัต ิ
 
 
หัวขอสําคัญ :  1) การใชคําสั่งพื้นฐานของโปรแกรม Adobe Photoshop 

2) การใชเครื่องมือ การเลอืกสี การใชเลเยอร 
3) การเทสี การกําหนดแสง เงา และทิศทางของแสง 
4) การบันทกึไฟลขอมูลและการจัดเก็บภาพ 
5) การสแกนภาพและการตกแตงเสนตัวละคร 
6) การลงสีตัวละครและฉาก 
 

  
อุปกรณชวยฝก :  1. ดินสอเบอร EE   2. กระดาษ 80 ปอนด   3. ยางลบ   4. ไมบรรทัด   5. กระดาษรองวาด 
                       6. ตัวหนีบ  7. มีดคัตเตอร 
 
การมอบหมายงาน  : 
การวัดและประเมินผล  : 
หนังสื่ออางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ (พมิพครัง้ที่ 6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบือ้งตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศลิปะ (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรงุเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรงุเทพฯ: เอส.พี.ซ.ีบุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรบังานพรีเซนตและเว็บไซต. กรุงเทพฯ: โปรวิช่ัน. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรงุเทพฯ: เอส.พี.ซ.ีบุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน (พมิพครัง้ที่ 2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรงุเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีสี.  กรุงเทพฯ: โอเดี้ยนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรเีมียร. 
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การลงสีฉากโดยใชโปรแกรม Adobe Photoshop  
 
การใชคําสั่งพ้ืนฐานของโปรแกรม Adobe Photoshop 
      โปรแกรม   Adobe Photoshop เปนโปรแกรมตกแตงสรางสรรคภาพที่มีผูใชมากที่สุดในโปรแกรมประเภทเดียวกนั 
เนื่องจากมีการพฒันาความสามารถอยางตอเนื่อง ทําใหประสิทธิภาพของโปรแกรมรองรับการใชงานไดอยางครอบคลุมไม
วาสําหรบัผูใชมือใหมหรือนกัออกแบบมืออาชีพ Adobe Photoshop เปนโปรแกรมที่ใชเพือ่สรางสรรคและตกแตงภาพให
เกิดความสวยงาม ซึ่งมักมีสวนรวมกับงานทุกชนิดที่ตองการ ความสวยงาม เชน การแกไขสีภาพ การแกไขขอบกพรองใน
ภาพ การซอมแซมรปูทีเ่สียหายรวมถึงการตัดตอหรือดัดแปลงภาพใหเกินจริง เพื่อใชในงานออกแบบ  
 
หนาตาโปรแกรม Adobe Photoshop  

 
 
หนาจอของโปรแกรม Photoshop ประกอบไปดวยองคประกอบตาง ๆ ดังตอไปนี ้

1. สัญลกัษณของโปรแกรม Photoshop 
2. แถบเมนู ( Manu Bar ) 
3. ปุมควบคุมการทํางาน 
4. แถบกําหนดรปูแบบของเครื่องมือที่ใชงาน ( Tool Option Bar ) 
5. กลองเครื่องมือ ( Tool Box ) 
6. Palette ที่รวบรวมคุณสมบัติของการทํางานตางๆ เชน Navigator , Color , Layer , History เปนตน  
7. พื้นที่ทํางาน 
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เครื่องมือใชงานใน Photoshop  
 

 
 

Marquee Tools ปนกลุมเครื่องมือสําหรบัเลือกสวนที่ตองการ การใชงานคือ เลือกรูปทรงที่ตองการ ลากคลุม
สวนที่ตองการ บริเวณที่เปนจุดไขปลา จะถูกเลือกใหพรอมที่จะรับคําสัง่อื่นๆ ตอไป การยกเลิก กดที่ไหนก็ไดในงาน 1 ครั้ง 

 

 
 

Move Tool เปนเครือ่งมอืเพื่อการเคลื่อนยายตําแหนง เรียกใชงานไดที่ Tools Box ที่ เครื่องหมายลกูศรและ มี
เครื่องหมายทิศทางอยู ใชโดยการใชเมาสลากไปตําแหนงที่ตองการ 

 

 
 

Lasso Tools เปนเครื่องมือสําหรับเลอืกบางสวนของภาพที่ตองการ  
รูปท ี่ 1 คอื  การคลิกลากตามสวนที่ตองการ ปลอยคลิกเมื่อไหร มันจะวิ่งไป หาจุดเริม่ตน ทันท ี 
รูปท ี่ 2 คือ  ใชคลิกลากเมาสแลวหยุดที่ตองการ คอยๆ คลกิได อันไหนผิด กด Delete  

     เพื่อลบจุดที่กําหนดไวโดย ระหวางจุดทีเลือกจะเปนเสนตรง 
รูปท ี่ 3 คอื  จะเลือกจากความแตกตาง ของสีใหโดยอัตโนมตัิ โดยคอย สรางจุดที่กําหนดไวไดเอง 
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 Magic wand (W) เครื่องมอืในการสราง Selection ในบรเิวณที่มีโทนสีเดียวกัน 
 

 
 
 Crop Tool เปนเครื่องมือสําหรบัเลือกตัดเฉพาะสวนที่ตองการ วิธีใชคือ เมื่อเลือกเครื่องมือนี้แลวก็กําหนด
จุดเริม่ตน จากนั้นกล็ากจนคลุม สวนที่เราตองการ จะไดลักษณะเปนรปู สี่เหลี่ยม ดับเบิ้ลคลิก ก็จะไดรูปที่ตองการ 
 

 
 

Healing Brush Tool การใชงานเหมือน Clone แตจะมีการเกลี่ยส ีใหใกลเคียงกบับริเวณใกลเคียง 
Patch Tool คือการสรางสวนที่ตองการจะวางทับ โดยกําหนดบริเวณที่ตองการ แลวเลอืกโดยใชเมาส 

ลากไปเลือกสวนที่ตองการทับ 
Color Replacement Tool  เครื่องมือชื้นสุดทายนี้ไวเปลี่ยนส ีของจุดที่ตองการ กับสทีี่ไดเลอืกไว 

 

 
 

Brush Tool ใชเพื่อการวาดภาพ ถาคลิกคางจะสามารถเลอืกเปลี่ยนเปน 
Pencil Tool ไดดวย สามารถ เลือกสีโดยคลกิที่ แท็บ Switch คลิกที่สเีพื่อเปลี่ยนสีตามตองการ สามารถเปลี่ยน

ขนาดไดโดย คลิกขวาที่ไฟลงาน เลือกปรับแตงขนาดตามตองการ 
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Clone StampTool / Healing Brush Tool  เครื่องมอื 2 กลุม มีวิธีใชเหมือนกัน Clone คือการกอปป
บริเวณทีเ่ลอืก ไปวางทับสวนที่ตองการ ใชงานโดยเลือก กด Alt คางไว แลวเลือกบรเิวณที่ตองการจะโคลนหรือ Copy 
แลวคลิกเมาสซาย ปลอย ALT แลวนําเมาสมบริเวณทีเ่ราตองการจะโคลนทบัคลิกลากเมาสโคลน สวนทีเ่รา copy ก็จะถูก
มาวาดทับสวนที่ตองการ 

Red Eye Tool การลบจุดแดงในตา เพียงแตคลิกลากเมาสตกลูกตาแดงกจ็ะมีสีดํามาเทแทนที่สีแดง  
 

 
 

Eraser Tool สวนการลบ เลือกที ่Eraser Tool แลวไปใชในสวนที่ตองการลบ สามารถปรับขนาดได เหมือนกับ 
Brush Tool 

BackGround Eraser Tool จะเปนการเลอืกลบในสวน แบ็กกราวนด ที่ไมตองการออกจากรปู 
Magic Eraser Tool จะทําการลบสทีี่ตอเนื่องกบัสทีี่เราเลอืกไวทั้งผืน 

 

 
 

Paint Bucket Tool คือ การลงส ีหลังจากเลือกสทีี่ตองการแลว ก็เลือกเครื่องมือนี้ ไปที่ๆ ตองการจะเติมส ี 
แลวก็คลิก 

Gradient Tool คือ การเทสีแบบไลระดับสี คลิกเลือก Gradient Tool แลวเลือกชุดสทีี่กําหนดไว แลวนําเมาส
คลิกลากไปตามสวนที่ตองการเทส ีการไลระดับมี 5 แบบ จะไลระดบัสีแบบไหนใหคลิกเลือก  
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Blur คือ การทําภาพใหเบลอ  
Sharpen คือ การทําภาพ ใหคมชัดขึ้น  
Smudge คือการทําใหภาพ ดูเหมือนเคลื่อนไหว ใชมากๆภาพจะเบลอการ ใชงานคือ คลิก แลวลาก สามารถ

ปรับขนาดโดย คลิกขวาเหมอืน Brush Tool สวนออฟชั่นอืน่ๆ ปรับไดที่ Tool Option Bar 
 

 
 

Zoom Tool มีใหใชทั้ง ซูมอิน และ ซูมเอาท เลือกไดที่ Tool Option Bar แตมีเทคนิคงายๆ คือ  
กด < Ctrl + Space Bar> เพื่อ ZOOM IN  แลวก็กด < Ctrl + Shift + Space Bar> เพื่อ ZOOM OUT 
 

 
 

Quick Mask / Standard เปนเครื่องมือสําหรบัเลือกสวนที่ตองการปกปอง ไมใหถูกแกไข  
ในขณะที่เราทํางาน แตก็สามารถใชเปนเครื่องมือชวยเลอืกสวนที่เราตองการทํางานได การใชงาน คลิกที ่Quick Mask 
Mode จากนั้นใชเครื่องมือ Brush กําหนดจุดทีเ่ราตองการ ถาคลุมพื้นที่กวางๆ อาจใช Paint ชวยในการลง เมื่อครบแลว 
คลิกที ่Edit in Standard Mode จะเห็นวา สวนที่เราลงสีไว จะถูกปกปอง การทํางานกบัภาพ จะไมถูกทําในสวนนี้ได แต
ถาหากตองการใชเปนสวนที่ทํางาน ก็สั่งไดที ่Select > Inverse หรือกด <Shift + Ctrl + I> ตอนนี้เรากส็ามารถทํางาน
ในสวนที่เลือกโดยสวนที่ไมถูกเลือกจะถูกปกปองไว 
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การเลือกใชเลเยอร และ การเคลื่อนยายวัตถุ 

เมื่อเราตองการดูวาขณะนี้เรากําลงัทํางานอยูที่เลเยอรใดสังเกตวาจะมีแถบสีน้ําเงินคลุมอยูที่เลเยอรนั้น และการ
ยายตําแหนงวัตถุในเลเยอรนั้นสามารถทําไดโดยคลิกเลือกเครื่องมือ  Move  Tool  บน  Toolbox  จากนั้นคลิกในชอง
สี่เหลี่ยมใหมเีครื่องหมายถกูที่คําสัง่   
-    Auto  Select  Layer     คลิกบนวัตถุใดจะเปนการเลือกเลเยอรของวัตถุนั้นโดยอัตโนมัต ิ
-   Show  Bounding  Box  ใชกําหนดใหเกิดกรอบสี่เหลีย่มลอมรอบเลเยอรทีเ่ลอืก   
 เมื่อคลกิเลือกคําสั่งทัง้  2  คําสั่งนี้แลวจะทําใหเราสามารถเคลื่อนยายวัตถุ หรือ เลือกใชงานวัตถุไดงายข้ึน   
รวมทั้งการเลือกเลเยอรของวัตถุน้ันกส็ามารถทําไดสะดวกยิง่ขึ้น  รวมทั้งสามารถยอ – ขยาย และหมุนวัตถุไดเชนกัน   
โดยเมื่อเลือกคําสั่ง  Show  Bounding  Box  จะมีจุดแฮนเดิ้ล (Handle)  เพื่อใหสามารถปรบั หรอื หมุนวัตถุไดงายข้ึน 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

เมื่อเลือกคําสั่ง  Auto Select  Layer  และ Show  Bounding  Box   
จะปรากฏเสนประลอมรอบวัตถุทีเ่ลือก 
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การเปลี่ยนลําดบัชั้นของเลเยอร 
              เมื่อเราสรางเลเยอรไวใชงานหลาย ๆ เลเยอรแลว  และตองการจะเปลี่ยนลําดับชั้นของเลเยอรไวสําหรบั 
การใชงานในรปูแบบที่หลากหลาย  สามารถทําไดโดย 
 1.  สรางเลเยอรประมาณ  2-3  เลเยอร 
 
 
 
 
 
 
 
 
 
  

 
2.  คลิกเมาสที่เลเยอรที่ตองการเลื่อนลําดบัขึ้น – ลง  จากนัน้คลิกเมาสคางไวแลวลากไปยังตําแหนงของเลเยอร 

ที่ตองการเปลี่ยน สงัเกตวารูปภาพจะเปลี่ยนลําดับตามเลเยอรทีเ่ปลี่ยนลําดบัดวยเชนกัน 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 

�ร���เลเยอร์ Cat �ล� Dog  ��ย���เลเยอร์  
Cat ��อย�����เลเยอร์  Dog   

เ���อ�ล��เลเยอร์ Cat  ��อย��
����ล���เลเยอร์  Dog  ���เ�����ร��
�������อย���������อ�ร�����  
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การล็อคเลเยอร  
              การล็อคเลเยอร  คือ  การล็อคไมใหกระทําสิง่ใด ๆ กับเลเยอร   โดยในการล็อคเลเยอรของโปรแกรม  
Photoshop  มีรูปแบบตาง ๆ อกี 4 ตัวเลือก  ซึ่งรปูแบบของการล็อคนีจ้ะอยูที่พาเล็ต  Layer  ตรงคําสั่ง  Lock   
 
 
 
 
 

 
 

 
   

  
โดยวิธีการใชล็อคเลเยอรนั้นใหผูเรียนคลิกเมาสเลเยอรที่ตองการล็อค จากนั้นคลิกตรงสญัลกัษณของ 

การลอ็คแตละชนิดก็จะสามารถใชการล็อคตามทีเ่ลือกได โดยสังเกตวาเลเยอรที่เลือกจะใชการล็อคนั้นจะมรีูปกญุแจ 
อยูตรงทายของเลเยอร และสัญลักษณของการล็อคที่เลือกกจ็ะเปนปุมบุมลงไป ดังรายละเอียดของรปูแบบการล็อค ดังนี ้ 

   Lock  Transparent  Pixels  ล็อคสวนโปรงใสทําใหไมสามารถทําสิง่ใดในสวนที่โปรงใสได 
  Lock  Image  Pixels  ล็อคเลเยอรทําใหไมสามารถปรับสี  เติมสี สวนใด ๆ ของเลเยอรได 
  Lock  Position   ล็อควัตถุไวทําใหไมสามารถเคลื่อนยายหรือปรบัเปลี่ยนได 

    Lock  All  ล็อคทุกอยางทําใหไมสามารถทําอะไรกับเลเยอรนั้นได 
 
 
 
 

 
 

 
 
 
 
 
 
 

ร��������� � �อ���รล�อ�เลเยอร์ 

เ���อ�����รล�อ�เลเยอร์�ล��  ����ร�������อย�����ยเลเยอร์  �ล�
���ล����์��รล�อ�������ล���������เร��ร���������� �เร�
เล�อ���รล�อ�เ�� ������ 
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การเปลี่ยนสีเลเยอร 
 การเปลี่ยนสีเลเยอร คือ การเปลี่ยนสีของเลเยอรทีอ่ยูในพาเล็ตเพื่อใหเลเยอรทีส่รางขึ้นมาน้ันดูงาย  และสะดวก
ในการจัดกลุมใหกับเลเยอรโดยใชสเีปนตัวบอกได   โดยใหคลิกเลือกเลเยอรที่ตองการเปลี่ยนสี  จากนั้นคลิกทีปุ่ม     
บนพาเล็ต  Layer จะปรากฏแถบคําสัง่ ใหคลิกเลอืกคําสัง่ Layer Properties จะปรากฏไดอะล็อกซบล็อกซขึ้นมา   
ในชอง  Color  คลิกเลอืกสทีี่ตองการ   
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

 

���อ�เลเยอร์������
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     การรวมเลเยอร  

  การรวมเลเยอร   คือ  การกําหนดใหเลเยอรหนึ่งไปรวมกบัอีกเลเยอรหนึ่ง หรือ รวมเลเยอรทั้งหมดในพาเล็ต  
Layers ใหกลายเปนเพียงเลเยอรเดียว ซึ่งการรวมเลเยอรมหีลายรูปแบบ  ดังนี้   
 

Merge  Down การรวมเลเยอรสองเลเยอรเขาดวยกัน   
Merge  Down  เปนคําสั่งที่กําหนดใหเลเยอรที่กําลงัทํางานอยูรวมกับอีกเลเยอรหนึ่งที่อยูดานลาง โดยช่ือของ 

เลเยอรที่แสดงผลหลังจากรวมเลเยอรแลวจะเปนชื่อเลเยอรที่อยูทางดานลาง   
 

วิธีการรวมเลเยอร 
1.  คลิกเมาสเลอืกเลเยอรหลกั หรือเลเยอรที่อยูดานบน  จากตัวอยางเลเยอรทีเ่ลือกคือ เลเยอร dog  สวนเล

เยอรที่อยูดานลางคือ เลเยอร  Dog 
2.  เลอืกเมนูคําสั่ง  Layers  บนเมนูบาร  จากนั้นเลือกคําสัง่ Merge  Down หรือ คลกิเมาสทางขวาตรงเลเยอร

ที่คลิกเลือกจากนั้นคลิกคําสัง่ Merge Down เลเยอร dog และ cat จะรวมกันและเปลี่ยนเปนชื่อเลเยอรดานลาง  
คือ เลเยอร cat   

   
 
 
 
 

  
 
 
 
 
 
 
 
 

 
 
 
 
 

เลเยอร์ Rat ���เล�อ�����������รร��เลเยอร์ เลเยอร์ Rat �ล�  Dog ��ร��เ�� �เลเยอร์เ��ย���� 
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การซอน / แสดงเลเยอร  
เมื่อเราเปดใชเลเยอรตาง ๆ ของรูปภาพแลว เราสามารถท่ีจะซอนเลเยอรที่ไมตองการใชได โดยการซอนนั้น

เหมือนกับการลบเลเยอรนั้นทิ้ง แตในความจริงแลวเราไมไดลบทิ้งเพียงแตซอนไวเทานั้น ถาเราตองการใชก็ใหคลิกยกเลิก
การซอน เพื่อใหเลเยอรนั้นแสดงตามปกต ิ 

วิธีทํา คือ คลิกเมาสที่รูปดวงตาที่อยูดานหนาของเลเยอรใหรูปดวงตาน้ันหายไป รูปภาพที่อยูบนเลเยอรนั้นก็จะ
ไมแสดงบนหนากระดาษทําการแลว และเมื่อตองการใชงานเลเยอรนั้นอีกครั้ง ก็ใหคลิกรูปดวงตาอีกครั้งเพื่อแสดงเลเยอร   

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 
 
 
 
 
 
 

เลเยอร์�����������ร�������อย�� 
��������เลเยอร์�ล���ร��������� 
�������ร���� 

เลเยอร์  Cat  �����อ����   ��ย���เลเยอร์�������ร�������อย��
��������เลเยอร์  �ล�ร������������ร�������������อ�เ������ 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

194

194 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ทฤษฎี) 

หัวขอวิชา การลงสีตัวละครและฉาก 
รหัสวิชา 0922124511 
หัวขอที่ 6 

 
การกําหนดแสง เงา และทิศทางของแสง 

Layer style เปนเครื่องมือในการชวยเพิ่ม Effect ใหกับงานที่ทําใน Layer ทั้งงานตกแตงภาพ และงาน
สรางสรรคตัวอักษรขอความตางๆ ใหมลีักษณะพเิศษ โดดเดน และสวยงามมากยิ่งขึ้น เชนการกําหนดแสง - เงา การ
กําหนดความตื้น - ลึกของภาพเพื่อใหเกิดมิต ิเปนตน 

Layer Style  จะถูกสรางขึ้นมาใหมซอนทับผสานลงไปกับรปูภาพในเลเยอรหลัก  โดยในขณะที่รูปภาพตนฉบบั
ยังคงมีรายละเอียดเหมือนเดิม 

photoshop มี layer styleที่หลากหลาย กอนการจะใชงานก็ควรจะมกีารทําความเขาใจเกี่ยวกับ Effect ของเล
เยอร ใหไดรูจักหนาที ่และความสามารถ ของ Effect ตางๆใน Layer Style เพื่อจะไดใชเครื่องมือเหลานี้สรางสรรคงานให
สวยงามอยางที่ตองการ 

 
การใชงาน Layer Style 

1. คลิกขวาที่แถบเลเยอร เลือก Blending Optionหรอืคลกิเมาสที ่  ตรงแถบดานลางของพาเล็ต แลวเลือก
รูปแบบ Effect ที่ตองการ 

2. ดับเบิล้คลิกที่แถบเลเยอร 
3. ไปที่แถบ Tool Bar คลิกที ่Layer > Lsyer Style > เอฟเฟคที่ตองการ  จะมีไดอะล็อกซของ Layer Style 

ขึ้นมาซึ่งมเีครื่องมือสราง Effect  อยู 10 อยางคือ 
1. Drop Shadow- เปนการใสเงาใหกบัตัวอักษรหรือรูปภาพโดยเราสามารถกําหนดทิศทางและปรับระดับความ

เขมของเงาได(ทําใหตัวอักษรเหมอืนดูลอยขึ้น) 
2. Inner Shadow - เปนการใสเงาใหกบัตัวอักษรหรือรูปภาพเชนเดียวกับDrop Shadow แตแตกตางกันตรงที่

เปนการใสเงาแบบภายในวัตถุ(ทําใหตัวอักษรดเูหมอืนยุบลง) 
3. Outer Glow - เปนการใสสีแบบฟุงกระจายภายนอกวัตถุทําใหตัวอักษรดูมลีักษณะเรืองแสงออกมา 
4. Inner Glow – มีลกัษณะเชนเดียวกันกบั Outer Glow แตเปนการใสสีแบบฟุงกระจายภายในวัตถุ 
5. Bevel and Emboss - เปนการทําใหภาพมลีักษณะนูนในหลายๆรปูแบบโดยมีทัง้แบบนูนข้ึนและยุบลง 
6. Satin - เปนการใสสเีพิ่มลงไปใหกบัตัวอกัษรโดยมีลกัษณะเปนเหลือบเงาและมหีลายรูปแบบไวใหปรับแตงกัน 
7. Color Overlay - เปนการเติมสีใหมทบัลงไปในตัวอักษรเมื่อเรายกเลกิการใชเอฟเฟกตนี้แลวสเีกาจะยังคงอยู 
8. Gradient Overlay - เปนการเตมิสีใหตัวอักษรในรปูแบบการไลสซีึ่งเราสามารถกําหนดลกัษณะได 
9. Pattern Overlay – เปนการใสลวดลายแบบตางๆ ลงไปในภาพ 
10. Stroke – เปนการใสเสนขอบลอมรอบใหกบัตัวอักษรหรือภาพเราสามารถกําหนดสีและความหนาของเสน 
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การบันทึกไฟลขอมูลและการจัดเก็บภาพ 
การบันทึกงาน File > Save as แลวเปลี่ยนชื่อลงในชอง File name  
   

  
 

เลือก Format รูปภาพตามลักษณะการใชงาน แลวกด Save  
ชนิดของไฟลที่ใชบอย  

1. PSD เปนไฟลของโปรแกรม Photoshop สามารถเก็บคณุสมบัติตางๆของการใชงานทื่ตกแตงไวได มีขอด ี 
โดยสามารถกลบัมาแกไขไฟลงานชนิดนี้ไดตามตองการ สามารถใชคําสั่ง save as เพื่อเปลี่ยนเปนไฟลอื่นๆไดทั้งหมด 
เมื่อตองการ  

2. JPG หรือ JPEG (Joint Photographics Expert Group) เปนไฟลที่รูจักกันในการใชบนอินเทอรเน็ต  
เพราะไฟลมีขนาดเล็ก การบันทกึภาพยังรกัษาคุณภาพใหอยูในเกณฑทีร่ับได  
3. TIFF นิยมใชในงานออกแบบสิ่งพมิพที่ตองการงานคุณภาพสูง ไฟลมีขนาดใหญ ทําใหสิ้นเปลืองพื้นที ่

ในการเกบ็มาก  
 
 
 

 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

195

195 
 

 

หลักสตูรการฝกยกระดับฝมือ 
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รหัสวิชา 0922124511 
หัวขอที่ 6 

 
การบันทึกไฟลขอมูลและการจัดเก็บภาพ 
การบันทึกงาน File > Save as แลวเปลี่ยนชื่อลงในชอง File name  
   

  
 

เลือก Format รูปภาพตามลักษณะการใชงาน แลวกด Save  
ชนิดของไฟลที่ใชบอย  

1. PSD เปนไฟลของโปรแกรม Photoshop สามารถเก็บคณุสมบัติตางๆของการใชงานทื่ตกแตงไวได มีขอด ี 
โดยสามารถกลบัมาแกไขไฟลงานชนิดนี้ไดตามตองการ สามารถใชคําสั่ง save as เพื่อเปลี่ยนเปนไฟลอื่นๆไดทั้งหมด 
เมื่อตองการ  

2. JPG หรือ JPEG (Joint Photographics Expert Group) เปนไฟลที่รูจักกันในการใชบนอินเทอรเน็ต  
เพราะไฟลมีขนาดเล็ก การบันทกึภาพยังรกัษาคุณภาพใหอยูในเกณฑทีร่ับได  
3. TIFF นิยมใชในงานออกแบบสิ่งพมิพที่ตองการงานคุณภาพสูง ไฟลมีขนาดใหญ ทําใหสิ้นเปลืองพื้นที ่

ในการเกบ็มาก  
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4. EPS เปนไฟลคุณภาพสูงแสดงผลไดดีในระบบงานพิมพ ใชการประมวลผลแบบ Vector  
5. GIF (.gif) Graphic Interchange Format เปนไฟลที่ใชกันมากบน Internet เพราะเปนไฟลที่มีขนาดเล็ก

สะดวกในการสง-ถายขอมูล 
 

การบันทึกงานโดยการเปลี่ยนชื่อเดิมไปเปนชื่อใหม 
ไปที่เมน ูFile < Save as 

 
การปดโปรแกรมการใชงาน  

กอนปดการใชงานนั้นหากเราตองการบันทกึงานกจ็ัดการบันทึกใหเรียบรอย กอนที่จะสั่งปดดังนี ้  
ไปที่เมน ูFile < Exit  

 
การเปดใชงานที ่Save ไว  

ไปที่เมน ูFile < Open 
 
การปริ้นทภาพ   

ไปที่เมน ูFile < Print 
 
การตั้งคาหนากระดาษ เชน ตองการใหกระดาษเปนแนวนอน  

ไปที่เมน ูFile < Page Setup...  
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การเตรียมภาพสําหรับลงสีโดยใชโปรแกรม Adobe Photoshop 
 

1. สแกนภาพที่วาดไวเขาไปเก็บไวในคอมพิวเตอร 

 
 

2. ตอมาถาหากเราวาดขางนอกแลวสแกนเขาไปยอมที่จะมรีอยเปอนของกระดาษหรือรอยทีเ่ราไมตองการ  
สามารถกําจัดมันไดดวย 
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3. ปรับคาใหพอเหมาะตามที่ตองการ 

 
 

 
4. ถายังคงเหลือรอยเปอนอยู ใหใชยางลบลบจุดเล็กๆที่ไมตองการทิ้ง 
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5. เมื่อเราไดเลเยอรเสนทีส่ะอาดไรรอยเปอนกเ็ขาสูขั้นตอนการเตรียมการลงส ีปรับโหมดของเลเยอรเสน 
เปน multiply 
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การลงสตีัวละครและฉากโดยใชโปรแกรม Adobe Photoshop 

 
1.สรางเลเยอร Background (BG) ขึ้นมาใตเลเยอรเสน 

 
 

2. ลงสทีี่เลเยอร BGดวย บรัช ตอนนี้ถาเราลงสีทีเ่ลเยอร BG ก็จะสามารถเห็นสทีี่ลงได เพราะเลเยอรเสนที่อยู
ขางบนเราปรับเปนmultiplyไวแลว 
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3. ลงบรรยากาศโดยรวมของภาพที ่BG อาจจะแบงเลเยอรไวตามความเหมาะสมเพื่อความสะดวกในการทํางาน 
 

 
 

4. ถาเราลงสีโดยแบงแตละสวนไว เราสามารถคลิก้ขวาเลือก Select layer tranparency ไดที่ชองเลเยอร  
ซึ่งจะกั้นกําหนดขอบเขตที่เราลงสีไปแลวในเลเยอรนั้นทั้งหมด ทําใหสะดวกในการที่จะลงสีไมใหเกินขอบทีเ่ราลงสีไวแลว 
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หัวขอวิชา การลงสีตัวละครและฉาก 
รหัสวิชา 0922124511 
หัวขอที่ 6 

 
5. ขั้นตอไปเพื่อความเปนระเบียบควรสราง Set ของเลเยอรคาแรกเตอรขึ้นมาตางหากแยกจาก set BG และ

สรางเลเยอร skin ไวในนั้นเพื่อเตรียมลงสีผิว 
 

 
 

6. ลงสผีิวตามขอบเขตที่ตองการดวยบรัช 
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รหัสวิชา 0922124511 
หัวขอที่ 6 

 
7.ลงสีผิวใหหมด 
 

 
 

8.เปดเลเยอรใหมขึ้นมา ทําแบบเดียวกันกบัผม เสือ้ และกระโปรง ทีละเลเยอร 
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หัวขอที่ 6 

 
9. หลังจากทีก่ั้นขอบเขตของสเีนื้อแลวเรากม็าเริ่มลงสีเนื้อ ดวยการกั้นขอบเขตไวดวย Select layer 

tranparency กอน 
 

 
 

10. ลงแสงเงาตามความเหมาะสม ดวยบรัชตรงนี้คงตองฝกและสงัเกตจากงานของคนอื่นๆ ไปเรื่อยๆ หรอื 
สังเกตจากของจริงแลวมาตัดทอน 
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(ทฤษฎี) 

หัวขอวิชา การลงสีตัวละครและฉาก 
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11. เก็บรายละเอียดดวยบรัชชนิดตางๆ ปรับขนาดตามรายละเอียดที่เราจะใช 

 

 
 

12. ตอนนี้เราจะเห็นวาเสนดินสอทีเ่ราสแกนเขามาเปนสีเทาดํา ถาเราสแกนเขามาในโหมด คัลเลอร เราสามารถ
เปลี่ยนเสนใหกลายเปนสีไดดวยการไปที่เลเยอรเสนแลวเลือกปรบั 
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13. ลองปรับคาตางๆ ดู แลวจะเห็นวาสีของเสนเปลี่ยนไป 

 

 
 

14. คราวนี้เราก็มาลงตาดวยวิธีเดียวกัน 
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(ทฤษฎี) 

หัวขอวิชา การลงสีตัวละครและฉาก 
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หัวขอที่ 6 

 
15. แตงรายละเอียดของแสงเงาตามไสตลที่แตละคนชอบ 

 

 
 

16. เติมไฮไลทของดวงตา 
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17. จากนั้นลงแสงเงาใหเสือ้และผาถุง  

 

 
 

18. เริ่มลง BG เพิ่มรายละเอียดมากขึ้นจากที่เราลงน้ําหนกัคราวๆ ไว 
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19. ลง BG น้ําสวนบนรายละเอียดของแสงสะทอนบนผิวน้ํา 

 

 
 

20. ลง BG ดานลาง เก็บรายละเอียดจากที่ลงน้ําหนกัไว  
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21. เก็บรายละเอียดจุดเล็กๆ ของฉากเพื่อบรรยากาศ 

 

 
 

22. ขั้นตอนสุดทาย .เปดเลเยอรใหมใวใหมบนสุด (ควรจะอยูเหนือเลเยอรเสน)  ลงไฮไลทแสงบรรยากาศ และ
เก็บรายละเอียดรอบสุดทาย ตามความเหมาะสม เทานี้ก็เสรจ็สมบูรณ 
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ใบทดสอบ 
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หัวขอที่ 6 

 
   คําช้ีแจง แบบทดสอบมีทั้งหมด 2 ตอน 
   ตอนที่ 1 เขียนเคร่ืองหมาย ลอมรอบตัวอักษรหนาคําตอบที่ถูกตอง 

1. Move Tool เปนเครื่องมือที่ใชทําอะไร 
ก การเกลี่ยส ี
ข เลือกสวนที่ตองการ 
ค เคลื่อนยายตําแหนง 
ง ตัดเฉพาะสวนที่ตองการ 

2. Gradient Tool คืออะไร 
ก การวาดภาพ 
ข การลบจุดแดงในตา 
ค การเทสีแบบไลระดบัส ี
ง การเคลื่อนยายตําแหนง 

3. Lock Transparent  Pixels คืออะไร 
ก ล็อคสวนโปรงใส 
ข ล็อคเลเยอรทําใหไมสามารถปรบัสี   
ค ล็อควัตถุไวทําใหไมสามารถเคลื่อนยาย 
ง ล็อคทุกอยาง 

4. Lock  Image  Pixels คืออะไร 
ก ล็อคสวนโปรงใส 
ข ล็อคเลเยอรทําใหไมสามารถปรบัสี   
ค ล็อควัตถุไวทําใหไมสามารถเคลื่อนยาย 
ง ล็อคทุกอยาง 

5. Lock  Position   คืออะไร 
ก ล็อคสวนโปรงใส 
ข ล็อคเลเยอรทําใหไมสามารถปรบัสี   
ค ล็อควัตถุไวทําใหไมสามารถเคลื่อนยาย 
ง ล็อคทุกอยาง 

 
 
 

6. Drop Shadow คือ ขอใด 
ก การใสลวดลาย 
ข การใสสีแบบฟุงกระจาย 
ค การทําใหภาพมลีักษณะนูน 
ง การใสเงาใหกับตัวอักษรหรือรปูภาพ 

7. Pattern Overlay คือ ขอใด 
ก เปนการเติมสีใหมทับลงไปในตัวอักษร 
ข เปนการใสลวดลายแบบตางๆลงไปในภาพ 
ค เปนการใสเงาใหกบัตัวอักษรหรือรูปภาพ 
ง การทําใหภาพมีลักษณะนูนในหลายๆรปูแบบ 

8. Outer Glow มีลักษณะคลายกับขอใด 
ก Drop Shadow            ข Satin 
ค Outer Glow               ง Color Overlay 

9. ไฟลที่รูจักกันในการใชบนอินเทอรเน็ต เพราะไฟล 
มีขนาดเล็กคือขอใด 

ก PSD 
ข JPEG 
ค TIFF 
ง EPS 

10. เปนไฟลคุณภาพสูงแสดงผลไดดีในระบบงานพมิพ ใช
การประมวลผลแบบ Vector คือขอใด 

ก PSD 
ข JPEG 
ค TIFF 
ง EPS 

 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

212

212 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
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หัวขอที่ 6 

 
   ตอนที่ 2 กําหนดใหออกแบบตัวละครและฉากดวยโปรแกรม Adobe Photoshop 
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1. Move Tool เปนเครื่องมือที่ใชทําอะไร 

ค เคลื่อนยายตําแหนง 
2. Gradient Tool คอือะไร 

ค การเทสีแบบไลระดบัส ี
3. Lock Transparent  Pixels คอือะไร 

ก ล็อคสวนโปรงใส 
4. Lock  Image  Pixels คอือะไร 

ข ล็อคเลเยอรทําใหไมสามารถปรบัสี   
5. Lock  Position   คอือะไร 

ค ล็อควัตถุไวทําใหไมสามารถเคลื่อนยาย 
6. Drop Shadow คือ ขอใด 

ง การใสเงาใหกับตัวอักษรหรือรปูภาพ 
7. Pattern Overlay คือ ขอใด 

ข เปนการใสลวดลายแบบตางๆลงไปในภาพ 
8. Outer Glow มีลักษณะคลายกับขอใด 

ก Drop Shadow 
9. ไฟลที่รูจักกันในการใชบนอินเทอรเนต็ เพราะไฟล 
มีขนาดเล็กคือขอใด 

ข JPEG 
10. เปนไฟลคุณภาพสูงแสดงผลไดดีในระบบงานพมิพ ใชการประมวลผลแบบ Vector คือขอใด 

ง EPS 
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รหัสหลักสูตร 0920084210102 

ใบเฉลยทดสอบ 
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1. Move Tool เปนเครื่องมือที่ใชทําอะไร 

ค เคลื่อนยายตําแหนง 
2. Gradient Tool คอือะไร 

ค การเทสีแบบไลระดบัส ี
3. Lock Transparent  Pixels คอือะไร 

ก ล็อคสวนโปรงใส 
4. Lock  Image  Pixels คอือะไร 

ข ล็อคเลเยอรทําใหไมสามารถปรบัสี   
5. Lock  Position   คอือะไร 

ค ล็อควัตถุไวทําใหไมสามารถเคลื่อนยาย 
6. Drop Shadow คือ ขอใด 

ง การใสเงาใหกับตัวอักษรหรือรปูภาพ 
7. Pattern Overlay คือ ขอใด 

ข เปนการใสลวดลายแบบตางๆลงไปในภาพ 
8. Outer Glow มีลักษณะคลายกับขอใด 

ก Drop Shadow 
9. ไฟลที่รูจักกันในการใชบนอินเทอรเนต็ เพราะไฟล 
มีขนาดเล็กคือขอใด 

ข JPEG 
10. เปนไฟลคุณภาพสูงแสดงผลไดดีในระบบงานพมิพ ใชการประมวลผลแบบ Vector คือขอใด 

ง EPS 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเฉลยทดสอบ 

หัวขอวิชา การลงสีตัวละครและฉาก 
รหัสวิชา 0922124511 
หัวขอที่ 6 

 
ภาพตัวอยาง 

การออกแบบตัวละครและฉากดวยโปรแกรม Adobe Photoshop 
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หลักสตูรการฝกยกระดับฝมือ 
    สาขา พื้นฐานศลิปะและการวาดภาพ  
 ชื่อภาษาอังกฤษ Basic Art & Drawing  

รหัสหลักสูตร 0920084210101 

ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การลงสีตัวละครและฉาก 
รหัสวิชา 0922124511 
หัวขอที่ 6 

 
เกณฑการประเมิน  :   
 

เกณฑการใหคะแนน ระดับคะแนน 
1. การใชโปรแกรม Adobe Photoshop สรางงานศิลปะอยางเปนธรรมชาต ิ 25  คะแนน 
2. การเลอืกใชสีทางศิลปะ และการใหแสงเงา   25  คะแนน 
3. ความคิดสรางสรรค 25  คะแนน 
4. ชิ้นงานมีความสวยงามและเรียบรอย 25  คะแนน 

รวม 100  คะแนน 
 
หมายเหตุ  :       

ระดับคะแนน  90-100 คะแนน หมายถึง ดีเยี่ยม 
ระดับคะแนน  70-89 คะแนน หมายถึง ด ี
ระดับคะแนน  50-69 คะแนน หมายถึง ผานเกณฑ 
ระดับคะแนน  0-49 คะแนน หมายถึง ไมผานเกณฑ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

215

215 
 

 

หลักสตูรการฝกยกระดับฝมือ 
    สาขา พื้นฐานศลิปะและการวาดภาพ  
 ชื่อภาษาอังกฤษ Basic Art & Drawing  

รหัสหลักสูตร 0920084210101 

ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การลงสีตัวละครและฉาก 
รหัสวิชา 0922124511 
หัวขอที่ 6 

 
เกณฑการประเมิน  :   
 

เกณฑการใหคะแนน ระดับคะแนน 
1. การใชโปรแกรม Adobe Photoshop สรางงานศิลปะอยางเปนธรรมชาต ิ 25  คะแนน 
2. การเลอืกใชสีทางศิลปะ และการใหแสงเงา   25  คะแนน 
3. ความคิดสรางสรรค 25  คะแนน 
4. ชิ้นงานมีความสวยงามและเรียบรอย 25  คะแนน 

รวม 100  คะแนน 
 
หมายเหตุ  :       

ระดับคะแนน  90-100 คะแนน หมายถึง ดีเยี่ยม 
ระดับคะแนน  70-89 คะแนน หมายถึง ด ี
ระดับคะแนน  50-69 คะแนน หมายถึง ผานเกณฑ 
ระดับคะแนน  0-49 คะแนน หมายถึง ไมผานเกณฑ 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเตรียมการสอน 
(ปฏิบตัิ) 

หัวขอวิชา การลงสีตัวละครและฉาก 
รหัสวิชา 0922124511 
งานที่ 5 เวลา  4  ชั่วโมง 

 
วัตถุประสงค  :  เพื่อใหผูรบัการฝกมีความรู ความสามารถลงสีลงในฉากและตัวละครโดยใชโปรแกรมคอมพิวเตอร 

 
วิธีการสอน  :  บรรยาย สาธติ และใหฝกปฏิบัต ิ
 
  
อุปกรณชวยฝก :  1. ดินสอเบอร EE   2. กระดาษ 80 ปอนด   3. ยางลบ   4. ไมบรรทัด   5. กระดาษรองวาด 
                       6. ตัวหนีบ  7. มีดคัตเตอร 
 
การมอบหมายงาน  : 
 
การวัดและประเมินผล  : 
หนังสอือางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครัง้ที่ 6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครั้งที ่2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเดี้ยนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรีเมียร. 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การลงสีตัวละครและฉาก 
รหัสวิชา 0922124511 
งานที่ 5 

 
การลงสตีัวละครและฉาก 
 

1. การลงสีตัวละครโดยใชโปรแกรม Adobe Photoshop 
2. การลงสีฉากโดยใชโปรแกรม Adobe Photoshop 
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การลงสีตัวละครและ
ฉาก 
รหัสวิชา 0922124511 
งานที่ 5 

 
ขั้นตอนการปฏิบัติงาน  : ใหผูฝก ฝกปฏิบัติงานในหัวขอท่ี 1  
 

1. ฝกปฏิบัติการลงสโีดยใชโปรแกรม Adobe Photoshop 
1.1 ฝกปฏิบัติการลงสีตัวละครและฉากโดยใชโปรแกรม Adobe Photoshop 
 
 
 
 
 
 
 

 
 
 
 
อุปกรณและเครื่องมือ:  1. เครื่อง Scanner  

2. เมาสปากกา    
3. คอมพิวเตอร 
4. โปรแกรม Adobe Photoshop 
 

 
 
 
 
 
วัสด ุ :                    
 
 
 
 
 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

219

219 
 

 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การลงสีตัวละครและ
ฉาก 
รหัสวิชา 0922124511 
งานที่ 5 

1. ฝกปฏบิัตกิารลงสีโดยใชโปรแกรม Adobe Photoshop 
1.1 ฝกปฏิบัติการลงสีตัวละครและฉากโดยใชโปรแกรม Adobe Photoshop 

 
ขั้นตอนการลงสีตัวละครและฉากโดยใชโปรแกรม Adobe Photoshop 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. สแกนภาพ สแกนภาพที่วาดไวเขาไปในคอม ถารอย

เปอนอยู ใหใชยางลบลบจุดเล็กๆที่ไม
ตองการทิ้ง 

- 

2. ปรับโหมดของเลเยอรเสนเปน 
multiply 

เมื่อไดเลเยอรเสนทีส่ะอาดไรรอยเปอนก็เขา
สูขั้นตอนการเตรียมการลงส ีปรับโหมด
ของเลเยอรเสนเปน multiply 

- 

3. สรางเลเยอร Background สรางเลเยอร Background (BG) ขึ้นมา 
ใตเลเยอรเสน 

- 

4. ลงสทีี่เลเยอร BGดวย บรัช ลงสีที่เลเยอร BGดวย บรัช  ลงสีที่เลเยอร BG ก็จะสามารถ
เห็นสีทีล่งได เพราะเลเยอรเสนที่
อยูขางบนเราปรับเปนmultiply
ไวแลว 

5. ลงบรรยากาศโดยรวมของภาพ ลงบรรยากาศโดยรวมของภาพที ่BG 
อาจจะแบงเลเยอรไวตามความเหมาะสม
เพื่อความสะดวกในการทํางาน 

- 

6. Select layer tranparency ถาลงสโีดยแบงแตละสวนไว สามารถคลิ้ก
ขวาเลือก Select layer tranparency ไดที่
ชองเลเยอร ซึ่งจะกั้นกําหนดขอบเขตที่เรา
ลงสีไปแลวในเลเยอรนั้นทัง้หมด ทําให
สะดวกในการที่จะลงสีไมใหเกินขอบทีเ่ราลง
สีไวแลว 

- 

หมายเหตุ  :      
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หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชือ่ภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การลงสีตัวละครและ
ฉาก 
รหัสวิชา 0922124511 
งานที่ 5 

1. ฝกปฏบิัตกิารลงสีโดยใชโปรแกรม Adobe Photoshop 
1.1 ฝกปฏิบัติการลงสีตัวละครและฉากโดยใชโปรแกรม Adobe Photoshop 

 
ขั้นตอนการลงสีตัวละครและฉากโดยใชโปรแกรม Adobe Photoshop 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
7. สราง Set ของเลเยอรคาแรกเตอร
และสรางเลเยอร skin 

ขั้นตอไปเพื่อความเปนระเบียบควรสราง 
Set ของเลเยอรคาแรกเตอรขึ้นมาตางหาก
แยกจาก set BG และสรางเลเยอร skin ไว
ในนั้นเพื่อเตรียมลงสีผิว 

- 

8. ลงสผีิว ลงสีผิวตามขอบเขตที่ตองการดวยบรัช - 
9. ลงสผีม เสื้อ และกระโปรง ทลีะ 
เลเยอร 

เปดเลเยอรใหมขึ้นมา ทําแบบเดียวกันกบั
ผม เสื้อ และกระโปรง ทีละเลเยอร 

- 

10. กั้นขอบเขต Select layer 
tranparency 

หลงัจากที่กั้นขอบเขตของสีเนื้อแลว มาเริม่
ลงสีเนื้อ ดวยการกั้นขอบเขตไวดวย Select 
layer tranparency กอน 

- 

11. ลงแสงเงา ลงแสงเงาตามความเหมาะสมดวยบรัช และ
เก็บรายละเอียด 

- 

12. เปลี่ยนเสนใหกลายเปนส ี เสนดินสอทีส่แกนเขามาเปนสีเทาดํา ถาเรา
สแกนเขามาในโหมด คัลเลอร เราสามารถ
เปลี่ยนเสนใหกลายเปนสีไดดวยการไปที ่
เลเยอรเสนแลวเลือกปรบั จะเห็นวาสีของ
เสนเปลี่ยนไป 

- 

13. ลงสีตา ลงสีตา แตงรายละเอียดของแสงเงา ไฮไลท
ของดวงตา  

- 

14. ลงแสงเงาใหเสื้อ จากนั้นลงแสงเงาใหเสื้อและผาถงุ - 
15. ลงรายละเอียด BG น้ํา ลงรายละเอียด BG น้ําสวนบนรายละเอียด

ของแสงสะทอนบนผิวน้ํา และเกบ็
รายละเอียดจุดเลก็ๆ ของฉากเพื่อ
บรรยากาศ 

- 

หมายเหตุ  :      
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หัวขอวิชา การลงสีตัวละครและฉาก 
รหัสวิชา 0922124511 
งานที่ 5 

 
   วิทยากร/ครูฝกกําหนดใหผูรับการฝกไดฝกลงสีตัวละครและฉากจากวิชาท่ีแลว 

 
 

 
 
 
 
 
 
 
 
 

 
 
 

 
ครุภัณฑ/เครื่องมือ/วัสด/ุอุปกรณ  
 

1. เครื่อง Scanner  
2. เมาสปากกา    
3. คอมพิวเตอร 
4. โปรแกรม Adobe Photoshop 
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วัตถุประสงค  :  เพื่อใหผูรบัการฝกมีความรู ความสามารถนําภาพเคลื่อนไหวมาใชรวมกบัโปรแกรมใน 

การ Composite 
 
วิธีการสอน  :  บรรยาย สาธิต และใหฝกปฏิบัต ิ
 
 
หัวขอสําคัญ :  1) โปรแกรม After Effect 

2) การทํา Effect ของภาพเคลือ่นไหวดวยโปรแกรม After Effects 
3) เครื่องมือและพื้นฐานของโปรแกรม After Effects 
4) การนําไฟลภาพเขาสูโปรแกรม Adobe After Effect 

  
อุปกรณชวยฝก :  1. ดินสอเบอร EE   2. กระดาษ 80 ปอนด   3. ยางลบ   4. ไมบรรทัด   5. กระดาษรองวาด 
                       6. ตัวหนีบ  7. มีดคัตเตอร 
 
การมอบหมายงาน  : 
 
การวัดและประเมินผล  : 
 
หนังสอือางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครั้งที ่6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพืน้ฐาน. (พิมพครั้งที ่2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเด้ียนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรีเมียร. 
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โปรแกรม After  Effect  
การจัดองคประกอบและรวมภาพ ดวยโปรแกรม After  Effect 

 
 

โปรแกรม After Effect เปนโปรแกรมสําหรบังานทางดาน Video Compost หรืองานซอนภาพวีดีโอ รวมถึงงาน
ทางดานการตกแตง หรอืเพิม่เติม Effect พิเศษใหกับภาพโปรแกรม After Effect ก็คือ โปรแกรม Photoshop เพียงแต
เปลี่ยนจากการทํางานภาพนิ่งมาเปนภาพเคลื่อนไหว  

ผูที่มีพื้นฐานทางดานการใชงานโปรแกรม Photoshop สามารถใชงานโปรแกรม After Effect ไดอยางงาย    
โดยใชโปรแกรม Adobe After Effect ซึ่งเปนโปรแกรมยอดนิยมทางดาน Motion Graphic ใชในธุรกิจการตัดตอ
ภาพยนตร งานโทรทัศน การสราง Project การใช Transition , Effect และ Plug in ตางๆ ในการทํางาน การตัดตองาน 
Motion Graphic เชน การบันทกึเสียง, การทําเสียงพากย, การใสดนตรีประกอบ  

นอกจากนี้ยงัมีเทคนิคพิเศษตางๆ เชน การทําตัวอักษรใหเคลื่อนไหว, การซอนภาพกับโปรแกรมยอดนิยมตางๆ 
และการทําMastering, การบันทกึผลงานลงเทป DV , VHS และการแปลงไฟลเพื่อทํา VCD , DVD 

 
 

After Effect เปนโปรแกรมที่ใส Effect ใหกับภาพยนตรในขั้นตอนการตัดตอไฟลที่นําเขามาใชในโปรแกรมนี้ได
เกือบทุกชนิดไดทั้งภาพนิ่งภาพเคลื่อนไหวไฟลเสียง ยิ่งถาเปนการทํามาจากโปรแกรม 3d แลวมาทําตอที่ After Effect  
จะทําใหงานสมบรูณยิ่งขึ้น โดยที่สามารถจะนําไฟลทั้งหลายเหลานี้มาใชงานรวมกัน  เพื่อใหไดงานทีเ่ปนภาพเคลื่อนไหว
ชิ้นใหมออกมาจากโปรแกรม After Effects 
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การสราง Effect ของภาพเคลือ่นไหวดวยโปรแกรม After Effects 
 

       
 

โปรแกรม After Effects เปนโปรแกรมที่นิยมใชในการทํางานดาน Motion graphic และ Visual – Effect  
ที่เหมาะสําหรบันํามาใชในงาน Presentation, Multimedia, งานโฆษณาและรวมไปถึงการทําSpecial – Effectตาง ๆ 
ใหกับงานภาพยนตร โดยเครือ่งมอืที่ใชและลักษณะการใชงานโดยทั่วไปในโปรแกรมนั้นจะคลายกับโปรแกรมอื่น ๆ ใน
ตระกลู Adobe ดังนั้นในการเริม่ตนใชงาน After Effects ก็จะงายขึ้น ถาผูใชเคยไดใชโปรแกรมของ Adobe เชน 
Photoshop, Illustrator หรือPremiereมากอน 

 
การทํางานของโปรแกรม After Effects 

ในการทํางานของโปรแกรม After Effects นั้น เปรียบเทียบกับการทํางานภาพยนตร คือ การตัดตอ เนื่องจาก
การทํางานของโปรแกรมจะทํางานในลักษณะทีเ่ปนการนําไฟลที่ทําเอาไวเรียบรอยแลวจากที่อื่นเขามาใช โดยไฟลที่จะ
นํามาใชงานโปรแกรม After Effects สามารถเปน ไฟลใดๆ ก็ไดแทบทุกชนิด ไมวาจะเปนไฟลภาพนิง่ ภาพเคลื่อนไหว 
และ ไฟลเสียง โดยที่สามารถจะนําไฟลทัง้หลายเหลานีม้าใชงานรวมกัน เพือ่ใหไดงานทีเ่ปนภาพเคลื่อนไหวช้ินใหมออกมา
จากโปรแกรม After Effects 
 
การเตรียมไฟลที่จะนํามาใชงาน 

เนื่องจากในการทํางานกบัโปรแกรม After Effects จําเปนจะตองมีการนําไฟลอื่นเขามาใชรวมดวยอยูเสมอจึง
ตองมีการเตรียมไฟลที่จะใชงานไวใหเรียบรอยกอน และจึงนาํไฟลที่ไดเตรียมไวแลวมาใชเปนฟุตเทจในการทํางานของ
โปรแกรม After Effects  
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เครื่องมือและพืน้ฐานของโปรแกรม After Effects 
  
การใช  Adobe After Effect  ในการตกแตง Effect ตางๆ 

โปรแกรม Adobe After Effect CS3 เปนโปรแกรมทีส่ามารถสราง effect ไดอยางดีเยี่ยม สามารถตกแตงภาพ
ใหมีชีวิตชีวาและดูสมจริงยิง่ขึ้น ซึ่งโปรแกรมนีเ้ปนที่นิยมกันมากในกลุมผูชื่นชอบดานกราฟก 

สวนประกอบของหนาจอโปรแกรม Adobe after Effect 
(1)  ไตเติ้ลบาร (Title Bar) แถบที่อยูทางดานบนสุดของหนาตางโปรแกรมเพื่อใชแสดงชื่อโปรแกรม Adobe 

After Effect CS3 และชื่อไฟลทีก่ําลังเปดทํางานอยูในขณะนั้นและทางดานขวามือของไตเติ้ลบารเปนปุมควบคุมการ 
ยอ - ขยายหรือปดโปรแกรม  

(2)  เมนูบาร (Menu Bar) เมนูบารแสดงอยูในบรรทัดลางตอจากไตเติล้บาร ซึ่งเปนทีเ่ก็บคําสั่งตางๆ ที่ใชในการ
สรางสรรคผลงานซึ่งอยูในรูปแบบของคําสั่งเมน ูโดยเริ่มตัง้แตเมนู File เรื่อยไปจนถึงเมนู Help ตามลําดับ เมนแูตละเมนู
จะมรีายการคําสั่งยอยออกมา โดยจะมรีายการคําสั่งยอยแตกตางกันออกไปตามลักษณะประเภทของเมนูดังรายการ
ตอไปนี ้

(2.1)  เมน ู File เปนคําสั่งเกี่ยวกับการทํางานทางดานไฟลทั้งไฟลวีดีโอและไฟลภาพ เชน การบันทกึไฟล  
การเปดไฟล เปนตน 

(2.2)  เมน ู Edit เปนคําสัง่เกี่ยวกบัการปรับแตงแกไขไฟลภาพหรือไฟลวีดีโอ 
(2.3)  เมน ู Composition เปนคําสั่งเกี่ยวกับเทคนิคตางๆในการสรางสรรคผลงาน 
(2.4)  เมน ู Layer เปนคําสัง่เกี่ยวกับการจัดเลเยอรตางๆ 
(2.5)  เมน ู Effect เปนคําสั่งเกี่ยวกบัการจัดการ effect ตางๆ 
(2.6)  เมน ู Animation เปนคําสั่งเกี่ยวกบัการกําหนดการเคลื่อนไหวของไฟลตางๆ 
(2.7)  เมน ู View เปนคําสัง่เกี่ยวกับการดูมุมมองของไฟลตลอดจนการยอ-ขยาย ไฟล 
(2.8)  เมน ู Window เปนคําสั่งที่รวบรวมการเรียกใช Palette เพื่อใหสะดวกตอการสรางสรรคผลงาน 
(2.9)  เมน ู Help เปนคําสัง่ทีร่วบรวมการชวยเหลือและแนะนําการใชโปรแกรม Adobe after Effect  

(3)  กลองเครื่องมือ (Toolbox)  เปนที่จัดเกบ็กลุมเครื่องมือตางๆ เครื่องมือเหลานี้มหีลากหลายประเภท 
ดังนั้นจึงมีการรวมเครื่องมือบางตัวซอนเอาไว ซึ่งสังเกตไดวาหากเครื่องมือใดมีปุมสามเหลี่ยมสีดําอยูทางดานขวาลาง 
แสดงวายังมเีครื่องมืออื่นซอนอยูอกี 

(4)  Palette เปนไดอะล็อกซประเภทหนึ่งที่ใชเลอืกรายละเอียดสําหรับการทํางานตางๆ ในโปรแกรมควบคูกับ
คําสั่งและเครื่องมือ 
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ตัวอยางโปรแกรม Adobe after   Effect  

1. Project คือ ชิ้นงานที่กําลังทํา เพราะงานแบบนี้ไมไดจบแคการใชไฟลไฟลเดียว แตประกอบกันหลายๆ ไฟล 
จึงตองเกบ็ทั้งหมดไวในโปรเจ็ค 

2. Footage คือ สิ่งที่นํามาใชงาน ไมวาจะเปนภาพ คลปิวีดีโอ เพลง สิ่งเหลานี้เราจะเรียกวา Footage 
3. Composition คือ พื้นที่สําหรับทํางาน คลายกบัเปดโฟโตช็อป แลว new file 
4. Time line คือ เสนของเวลาในงานที่เรากําลงัทําอยู 
5. Key Frame คือ เฟรมที่ตั้งคาไว  (หรือเฟรมหลักที่ใชเห็นคีย) ซึ่งจะอธิบายวิธีใชในลําดับตอไป 
6. Render คือ การประมวลผลของงาน เพราะในแตละเฟรม เอฟเฟคตางๆ ที่ใสไปจะตองใชเวลาและตองทํา 

กับทุกๆเฟรม ซึ่งจะใชเวลามากหรอืนอยขึ้นอยูกับขนาดภาพ และความยุงยากของเอฟเฟค 
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หนาตาของโปรแกรม After Effect  

1. Project เปนที่สําหรบัเก็บ Footage ตางๆ ทีเ่ราทํางานไว โดยเราจะตอง import ไฟลเขามากอน (คลิ้กขวา 
แลว import footage) 

2. Effect ในการทํางาน เอฟเฟดเปนสิง่ที่ขาดไมได (สําหรบั ver ต่ํากวานี้ หนาตาง effect จะเรียกไดในหมวด 
Window ) 

3. Composition คือพื้นที่ทีเ่ราทํางานอยู จะแสดงออกมาบริเวณน้ี 
4. Time Control ใชกด play โดยจะมสีองแบบ 

4.1 ปุม > ธรรมดา จะเพลยแบบปกติ (คอนขางชา และไมไดเวลาจริง) 
4.2 ปุม > ทางขวาสุด จะเพลยโดยการเรนเดอรเกบ็ไวกอนแลวแสดงออกมา ซึ่งจะเปนเวลาจริงและมี
เสียง 

5. Layer โปรแกรมนี้ใชการทํางานในรปูแบบเลเยอร Footage จะเรียงกันภายใน Composite เปนรูปแบบของ 
Layer โดยแตละเลเยอร จะสามารถปรับคาตางๆ ได เชน ตําแหนง ความเอียง ขนาด คาความใส 

 

 
 

6. Timeline คือสวนที่บอกเวลาวาเราทํางานเวลาไหน และเราจะกําหนดคียเฟรมตรงไหน 
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การนําไฟลภาพเขาสูโปรแกรม Adobe After Effect 
 

1. ตั้งชื่อไฟลเรียงเปน ใสไวในโฟลเดอรเดียวกัน 

 
  

2.เปดโปรแกรมขึ้นมาสรางงาน New Composition 

 
  

3. ตั้งคางานเปน PAL D1/DV widescreen อยาลืม ตั้งคาจอ 720x576 
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4. ตั้งเฟรมเรต 24  แลวก็ตั้งเวลาที่จะใชทํางาน ต้ังไวที ่2 วินาท ี

 
  
 

5. จากนั้นก็มาคลิ๊กขวาตรงพื้นที่วางในชองที่ Comp 1 อยูแลวเลอืก   Import > File  

 
 

  
6. เลือกภาพเเรกแคภาพเดียว แลวกด JPEG Sequence ดวยแลว Open  
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7. ลากงานลงมาใชชองTime Line 

 
 

  
8. ยอใหพอดี สังเกตตัวงานดวย อาจจะยืดได 

 
 
 

9. จากนั้นคลิ๊กขวาที่ชองงานดานลาง New > Solid เพื่อสรางเสนพื้น 
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10. กด Ok 

 
  
 

11. จะไดภาพดํามายอมันใหเปนเสนพื้น หนาตามตองการ 

 
 
  

12. กําหนดเสนใหพอดีกับเฟรมทีลู่กบอลเดงลงพื้น 
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13. ตอไปจะหนวงเวลาตอนเริ่มเพื่อเวลาเปดดูงานจะไดดูทนั กดแทบtime line ของงานเลือ่นไปตามตองการ 

ที่จะหนวง 

 
  

14. จากนั้น คลิ๊กขวาตรงพื้นที่วางในชองที่ Comp 1 อยูแลวเลือก   Import > File แตคราวนี้เอา JPEG 
Sequence ออก เพราะตองการภาพแรกภาพเดียว 

 
  

15. ลากไฟลภาพเเรกลงมา 
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16. ยอ Time line ของภาพแรกมาใหพอดีในชวงแรกทีห่นวงไว 

 
 
 

17. ยอภาพใหพอดีกบัอันเกา 

 
  
 

18. ลองกดปุม ทดสอบเรนเดอร ลองเลื่อนขีดแดงๆ ในtime line ดูชาๆ เพื่อวามีการตกเฟรมไป (การตกเฟรม 
คือ เฟรมบางเฟรมหายไป  แกไขโดยกลบัไปเช็คไฟลภาพวาเรียงรปูและช่ือไฟลตามถูกตองไหมแลวก็ทําใหมตั้งแตตนด)ู  
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19. จะ Render แลวกด Ctrl + M 

 
  
 

20.กดตามที่วงไว จะขึ้นมาใหเราเลือกไฟล   ในนี้ไมมี MOV ตองเลือกเปน AVI แลวไปแปลงไฟลเอา 

 
  
 

21.วงอันซายคือเลือกที่ๆ  จะเซฟ วงอันขวาคือ Render 

 
  
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

235

235 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ทฤษฎี) 

หัวขอวิชา การจัดองคประกอบและ
รวมภาพ 
รหัสวิชา 0922124512 
หัวขอที่ 6 

 
22.จะไดไฟลมา ไมตองแปลกใจถาขนาดมันใหญ 2 วินาทีเรากินไป 50 Mb กวาๆ 

จากนั้นเรามาแปลงไฟลเปน MOV   เราใชโปรแกรม Format Factory เปนโปรแกรมฟรีแวรดวย 
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ชื่อภาษาอังกฤษ 2D Animation 
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ใบทดสอบ 

หัวขอวิชา การจดัองคประกอบและ
รวมภาพ 
รหัสวิชา 0922124512 
หัวขอที่ 6 

 
   คําช้ีแจง แบบทดสอบมีทั้งหมด 2 ตอน 
   ตอนที่ 1 เขียนเคร่ืองหมาย ลอมรอบตัวอักษรหนาคําตอบที่ถูกตอง 

1. Project คือ อะไร 
ก ชิ้นงานที่กําลังทํา 
ข สิ่งที่นํามาใชงาน 
ค พื้นที่สําหรับทํางาน 
ง การประมวลผลของงาน 

2. สิ่งที่นํามาใชงาน ไมวาจะเปนภาพ คลิปวีดีโอ เพลง สิ่ง
เหลานี้เราจะเรียกวาอะไร 

ก Render ข Time line 
ค Footage ง Key Frame 

3. การประมวลผลของงาน เกี่ยวของกับขอใด 
ก Footage ข Time line  
ค Project ง Render 

4. Time line คืออะไร 
ก พื้นที่สําหรับทํางาน 
ข เสนของเวลาในงาน 
ค สิ่งที่นํามาใชงาน 
ง เฟรมที่ตั้งคาไว  

5. โปรแกรม After Effects เปนโปรแกรมที่ทํางานดานใด
ไดบาง  

ก งานโฆษณา  
ข Presentation 
ค Special – Effect 
ง ถูกทุกขอ 
 

6. การเริม่ตนใชงาน  After  Effects  ก็จะงายขึน้เพราะ
อะไร 

ก เคยไดใชโปรแกรม Photoshop 
ข เคยไดใชโปรแกรม Illustrator 
ค เคยไดใชโปรแกรม Premiere 
ง ถูกทุกขอ 

7. โปรแกรม Adobe after Effect ไตเติ้ลบารจะอยู
ตําแหนงใด 

ก อยูทางดานบนสุดของหนาตางโปรแกรม 
ข อยูทางดานลางสุดของหนาตางโปรแกรม 
ค อยูทางดานขวาของหนาตางโปรแกรม 
ง อยูทางดานซายของหนาตางโปรแกรม 

8. โปรแกรม Adobe after Effect เมนูบาร จะอยูตําแหนง
ใด 

ก แสดงอยูในบรรทัดบน 
ข แสดงอยูในบรรทัดลาง 
ค อยูทางดานขวาตอจากไตเติ้ลบาร 
ง อยูทางดานซายตอจากไตเติล้บาร 

9. คําสั่งเกี่ยวกบัเทคนิคตางๆในการสรางสรรคผลงาน 
คือขอใด 

ก Layer                     ข Window 
ค Composition            ง Animation 

10. คําสั่งเกี่ยวกับการดูมมุมองของไฟลตลอดจนการ 
ยอ-ขยาย ไฟลคือขอใด 

ก Edit                       ข View 
ค Animation               ง Composition 
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ใบเฉลยทดสอบ 

หัวขอวิชา การจัดองคประกอบและ
รวมภาพ 
รหัสวิชา 0922124512 
หัวขอที่ 6 

 
1. Project คือ อะไร 

ก ชิ้นงานที่กําลังทํา 
2. สิ่งที่นํามาใชงาน ไมวาจะเปนภาพ คลิปวีดีโอ เพลง สิ่งเหลานี้เราจะเรียกวาอะไร 

ค Footage 
3. การประมวลผลของงาน เกี่ยวของกับขอใด 

ง Render 
4. Time line คืออะไร 

ข เสนของเวลาในงาน 
5. โปรแกรม After Effects เปนโปรแกรมที่ทํางานดานใดไดบาง  

ง ถูกทุกขอ 
6. การเริม่ตนใชงาน  After  Effects  ก็จะงายขึน้เพราะอะไร 

ง ถูกทุกขอ 
7. โปรแกรม Adobe after Effect ไตเติ้ลบารจะอยูตําแหนงใด 

ก อยูทางดานบนสุดของหนาตางโปรแกรม 
8. โปรแกรม Adobe after Effect เมนูบาร จะอยูตําแหนงใด 

ข แสดงอยูในบรรทัดลาง 
9. คําสั่งเกี่ยวกบัเทคนิคตางๆในการสรางสรรคผลงานคือขอใด 

ค Composition  
10. คําสั่งเกี่ยวกับการดูมมุมองของไฟลตลอดจนการยอ-ขยาย ไฟลคือขอใด 

ข View 
 
 
 
 
 
 
 
 
 
 
 

 

 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

237

237 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  
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ใบเฉลยทดสอบ 

หัวขอวิชา การจัดองคประกอบและ
รวมภาพ 
รหัสวิชา 0922124512 
หัวขอที่ 6 

 
1. Project คือ อะไร 

ก ชิ้นงานที่กําลังทํา 
2. สิ่งที่นํามาใชงาน ไมวาจะเปนภาพ คลิปวีดีโอ เพลง สิ่งเหลานี้เราจะเรียกวาอะไร 

ค Footage 
3. การประมวลผลของงาน เกี่ยวของกับขอใด 

ง Render 
4. Time line คืออะไร 

ข เสนของเวลาในงาน 
5. โปรแกรม After Effects เปนโปรแกรมที่ทํางานดานใดไดบาง  

ง ถูกทุกขอ 
6. การเริม่ตนใชงาน  After  Effects  ก็จะงายขึน้เพราะอะไร 

ง ถูกทุกขอ 
7. โปรแกรม Adobe after Effect ไตเติ้ลบารจะอยูตําแหนงใด 

ก อยูทางดานบนสุดของหนาตางโปรแกรม 
8. โปรแกรม Adobe after Effect เมนูบาร จะอยูตําแหนงใด 

ข แสดงอยูในบรรทัดลาง 
9. คําสั่งเกี่ยวกบัเทคนิคตางๆในการสรางสรรคผลงานคือขอใด 

ค Composition  
10. คําสั่งเกี่ยวกับการดูมมุมองของไฟลตลอดจนการยอ-ขยาย ไฟลคือขอใด 

ข View 
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สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบเตรียมการสอน 
(ปฏิบตัิ) 

หัวขอวิชา การจัดองคประกอบและ
รวมภาพ 
รหัสวิชา 0922124512 
งานที่ 6 เวลา  4  ชั่วโมง 

 
วัตถุประสงค  :  เพื่อใหผูรบัการฝกมีความรู ความสามารถนําภาพเคลื่อนไหวมาใชรวมกบัโปรแกรมใน 

การComposite 

 
วิธีการสอน  :  บรรยาย สาธิต และใหฝกปฏิบัต ิ

  
อุปกรณชวยฝก :  1. ดินสอเบอร EE   2. กระดาษ 80 ปอนด   3. ยางลบ   4. ไมบรรทัด   5. กระดาษรองวาด 
                       6. ตัวหนีบ  7. มีดคัตเตอร 
 
การมอบหมายงาน  : 
การวัดและประเมินผล  : 
หนังสอือางอิง  : 
ฉัตรชัย อรรถปกษ (2553).  องคประกอบศิลปะ. (พิมพครัง้ที่ 6), กรุงเทพฯ: วิทยพฒัน. 
ชัยวิวัฒน การรื่นศรี (2546). ศิลปะเบ้ืองตน. กรุงเทพฯ: ปาเจรา. 
ชลูด นิ่มเสมอ (2542). องคประกอบของศิลปะ. (พิมพครัง้ที่ 5). กรุงเทพฯ: ไทยวัฒนาพานิช. 
น.ณ ปากน้ํา. (2515). พจนานุกรมศิลป. กรุงเทพฯ: เมอืงโบราณ. 
ปรัชญา อาภรณ. (2538). หลักการออกแบบ. ภูเก็ต: โปรแกรมออกแบบฯ สถาบันราชภัฏภูเก็ต. 
ปติ รังสีธนานนท (2553). 3D Advanced Workshop. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
ปุณยวีร รุจปิูริตานันท (2554). FLASH Cartoon Animation. กรุงเทพฯ: โปรวิช่ัน. 
_______.  (2555). FLASH Animation สําหรับงานพรีเซนตและเว็บไซต. กรงุเทพฯ: โปรวิชั่น. 
พูนศักดิ ์ธนพันธพาณิช (2549).  Maya Ready&Work. กรุงเทพฯ: เอส.พ.ีซี.บุคส. 
วัชรพงศ หงษสุวรรณ (2552). วาดเสนพื้นฐาน. (พิมพครั้งที ่2). กรุงเทพฯ: วาดศิลป. 
_______.  (2548). องคประกอบศิลปะ. กรุงเทพฯ: วาดศิลป. 
สมเกียรติ ตั้งนโม (แปล) (2536).  ทฤษฎีส.ี  กรุงเทพฯ: โอเดี้ยนสโตร. 
อนัน ภาชนะกาญจน และ อนัน วาโชะ (2554). โฟโตช็อป (โปรแกรมคอมพิวเตอร). กรุงเทพฯ: ไอดีซ ีพรเีมียร. 
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ใบขอมูล 
(ปฏิบตัิ) 
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รวมภาพ 
รหัสวิชา 0922124512 
งานที่ 6 

 
ขั้นตอนการทํางาน กบั Effect ตางๆ 
 

 
 

1. เริ่มจากการเปดโปรแกรมก็จะมาเจอ Window Untitled project.aep เปน file ของ AE แลวจัดการกดที่ 
file เลือก Save as เปนช่ือ file ที่ตองการ ในที่นี้ใหชื่อวา test.aep 
  

 
  

2. จากนั้นให เลือก file , Import , file...เลือก file ที่จะนําเขามาตัดตอ ในที่นี้จะเลือก file ตัวอยางที่มีมาใหใน
โปรแกรม premiere ชื่อวา Boys  มาทํา composite 
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รหัสวิชา 0922124512 
งานที่ 6 

 

 
  

3. เมื่อ Import เขามาจะเห็น file boy.avi ใน project window จากนั้นใหคลิกที ่icon create new 
composition ตามลกูศร ก็จะมีหนาตาง composite setting ขึ้นมาใหกําหนดคา สามารถเลือกขนาดของภาพไดวา 
จะเปนแบบไหน ในตัวอยางเลอืกขนาด midium 320*240 และเวลา 10 วนิาทีในการทํา composition โดยเลอืก 
จากชอง duration เสร็จแลว คลิก ok 
  

 
  

4. จะเห็นวาใน project windowมี icon comp1 คืออันเดยีวกับหนาตาง composite ดานขวา จากนั้นให 
ลาก file boy.avi จากหนาตาง project window มายัง timeline ตามลูกศรหมายเลข 2 จะเห็นวาในหนาตาง comp1 
จะมีภาพเกิดขึ้นมา  
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5. ใหกด effect ตามหมายเลข 1  ตามดวย text , basic text แลวเขียนคําวา AE แลวกด OK จะมีคําสั่ง Basic 
text ใตคําสั่ง effect หมายเลข 2 ถายังไมมีคําสั่ง basic text ใหกดลูกศรที่หันไปทางขวาใหหันลงก็จะแสดง basic text 
ออกมาภาพขยายดาน ขวามือ ใน composite window จะมีรปูตัวอักษร AE ดวย ตอไปก็จะเขาแกน ของ AE แลว 
keyframe 
  

 
  

6. เริ่มการทํา animate ที่คําสั่ง size หมายเลข 4 ใหกดทีร่ปูนาฬิกาจับเวลา จะเห็น วามีเครื่องหมายรูปขาว
หลามตัดข้ึนที่ timeline หมายเลข 1 จากนั้นใหปรบัคา parameter ดานขวาของคําสั่ง size ในที่นี้เทากับ 36.7  
จากนั้นใหเลื่อน ไปที่เวลา 2 วินาทีหรอืกด ctrl+g แลวใสเวลา จากนั้นปรับ parameter เปน 70ก็จะมีเครื่องหมาย  
รูปขาวหลามตัดข้ึนที่ timeline หมายเลข 2 เสรจ็ใหลองเลือ่น ตัวกําหนดเวลาไปทีเ่วลา 0 วินาที หรือกดปุม Home  
แลวลองกด spacebar ดูผลที่เกิดขึ้น จะเห็นวาตัวอักษร AE จะ คอยๆ ขยายขึ้น ตอไปจะเปนการ render 
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7. การ render เริ่มจากกด menu composition, add to render queue จะมีหนาตาง render queue 
ขึ้นมาตามรูปใหคลิกที่หมายเลข 3 current setting จะปรากฏหนาตางตามรปูขางลาง 
  

 
  

8. ใหกดหมายเลขหนึ่ง set... จะมหีนาตาง custom time span ขึ้นมาใหเลือกวาจะเริ่ม render ตั้งแตเวลา
อะไรถึงอะไรตามลกูศรชี้ จากนั้นให set output to หมายเลข 4 ในรูปที่ 7 วาจะ render ไปเก็บที่ file อะไร แลวกด  
ปุม render ตามรูปที่ 7 ไดเลย แลวก็ตาม ไปดูผลงานที่ file 
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Effect ทํา Title ใหคอยๆโผลเหมือนเรากําลังวาด  
  

 
  

1. เปดโปรแกรม After effect 5.5 เลอืก create new composition ตามลูกศร 
  

 
  

2.คลิกขวาที่พื้นที่วางๆ บน Project window เลือก Import > file  
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3. ในที่นี้เลือก clip VDO ชื่อ cyclers ที่อยูใน sample folder ของโปรแกรม premiere ถาทํางานกับ 
งาน DV ก็ import เขามา 

 
  
จะเห็นวามี file cyclers เขามาอยูใน project windows ให drag ลงมาใน timeline window 
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4. คลิกขวาที่ track ของ clip cyclers บน timeline เลือก effect > paint > vector paint 
  

 
  

จะไดหนาตาง effect control ขึ้นมาใหเลือกสีของ พูกัน กดเครื่องหมายรูป นาฬิกาที่หนา playback mode 
จะเห็นวาหลัง playback mode จะเปน current frame หมายความวาถาเราวาดรูปลงไปเชนตอนนี้วาดตัว D ภาพก็จะ
ปรากฏอยูเฉพาะ frame เดียว ตาม maker บน timeline 
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5. จากนั้นใหเปลี่ยนจาก current frame เปน Animate stoke จะเห็นวาตัว D ที่วาดเมื่อไวหายไป ใหทําการ
ลาก marker บรเิวณไมบรรทัดดานบนของ timeline เพื่อทาํการ ดูการเปลี่ยนแปลง จะเห็นวาตัวอักษรตัว D เริม่ปรากฏ 
แตตองการใหมันปรากฏเต็มตัวอกัษร ในเวลา 1 วินาทีก็ใหลาก Marker บน timeline มาที่ 1 วินาที ปรากฏวาตัวอักษร 
D ยังไมเต็ม 
  

 
  

ทําตัวอักษรใหเต็มในเวลาที่เรากําหนดก็ ใหลาก playback speed จนตัวอักษร สมบรูณ 
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6. วาดรูปตัว V ใหมจะเห็นวาพอวาดเสร็จตัว V จะหายไปใหเราทําการ Drag marker บน timeline จน
ตัวอักษร V สมบรูณ 
  

 
  

7. วาดตัว C แลวทําเชนเดียวกัน 
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8. วาดตัว T แลวทําเชนเดียวกัน 
  

 
  

9. ลาก Maker บน timeline ไปที่จุดเริม่ตน แลวกด spacebar ดูผลงานทีท่ํา ก็จะเห็นวาตัวอักษรคอยๆ 
วาด ทีละตัว 

 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

249

249 
 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  

ชื่อภาษาอังกฤษ 2D Animation 
รหัสหลักสูตร 0920084210102 

ใบขอมูล 
(ปฏิบตัิ) 

หัวขอวิชา การจัดองคประกอบและ
รวมภาพ 
รหัสวิชา 0922124512 
งานที่ 6 

 

 
  

10. เมื่อพอใจผลงานแลวใหคลิกที่ menu composition > add to render queue จากนั้นกําหนดวาจะ
export เปน file ดวยการกด output module 
  

 
  

11. ทําการกําหนด format file ที่ตองการไดในที่นี้ทําเปน Avi  
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12. กําหนดวาจะ output ไปเก็บไวที่ file ชื่ออะไร 
  

 
  

13. กําหนดเสร็จแลวใหกดปุม render 
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Effect การทําตัวหนังสือใหอยูในกรอบ  
 

 
  

1. เริ่มตน import file Boy.avi เขามาใน Timeline และทาํ Mask ดวยเครื่องมือ Pen tool 
  

 
 

2. วาดเครื่องมือ pen tool ใหเปน ดังรูปคลายๆ ในการเขียนบท สนทนาในหนังสือการตูน จะเห็นวาสวนที่ 
mask จะเปนสีดําคือ เปนสวนทีจ่ะมองทะลุได ในกรณีทีส่วนที่เปนรูปตามลูก ศรไมเปนสีดําใหคลิ๊กขวาที่ขอบ ของ mask 
แลวเลือก inverse mask 
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3. จากนั้นใหสราง layer ขึ้นมาใหม อีกอันหนึ่ง New > solid เปนการ สราง Layer เปนสีทั้ง Layer  
  

 
  

4. ใหเลือกสี ของ Solid layer ที่ชอง color แลวกด OK 
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5. จะเห็นวา solid1Layer จะอยูดาน บน boys.avi layer ใหทําการสลับ Layer 
  

 
  

6. พอสลบัแลวจะไดภาพดังรูป  สวนทีท่ํา mask จะโปรงแสงจนสามารถมองทะลุไปเจอ solid1  
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7. จากนั้นคลิกขวาที่ solid1 Layer เลอืก effect > text >basic text 
  

 
  

8. ใสขอความตามตองการ  
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9. จากนั้นใหกดสัญลักษณ solo ตามลูกศรดานลางซายเพื่อทําการดู เฉพาะ layer solid1 ทําการปรับ ขนาด
ของตัวอักษรใหขนาดพอดกีับกรอบคําพูด แลวก็ยายที่มายังตําแหนงที่ขางในกรอบคําพูด กอนยายตองคลกิ ที่ selection 
tool กอนถึงจะยายตัวอักษรได 
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Effect ระเบิดตัวอักษร 
  

 
  

1. เริ่มจากสราง composition >new แลวตั้งช่ือวา gradient จากนั้นใหคลกิขวาที่ timeline  
เลือก New >solid 

  
 

 
  

2. ตั้งชื่อ solid layer ใหชื่อวา gradient  ขนาดเปน 320*240 pixel 
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3. ตอไปคลิกขวาที่ Gradient layer เปนการใส effect > render > ramp เพื่อทําให composite window 
เปนในลกัษณะ Gradient 
  
 

 
  

4. จะเห็นวาเมื่อใส effect ramp แลวจะมี effect controls ramp ขึ้นมา และหนาตาง composite จะมี
ลักษณะ เปนคอยๆ เขมขึ้นจากลางขึ้นบน อันนี ้จะทําเพื่อเวลาระเบิดจะไดระเบิดจากสวนที่จางกอนแลวคอยระเบิดสวนที่
เขมตามลําดบั แตตองมีการ set คากอน 
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5. หยุดการทํา ทีห่นาตาง composite gradient ทีนี้มาสราง New composition ใหมกดตามเลข หนึง่ ตั้งช่ือ
compositionเปน text จากนั้นมาสราง solid layer ที ่timeline โดยการคลิกขวา ตั้งชื่อวา text แลวคลิกขวาที่ layer 
text >effect > text >basic text 
  

 
  

6. เขียนตัวอักษรที่ตองการ 
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7. จากนั้นก็มาปรับ size ของตัวอักษรใหขนาดเปน 70 เพื่อใหใหญขึ้นเวลาระเบิดจะไดเห็นชัดๆ 
  

 
  

8. ใหทําการสราง composition > new ใหมตั้งชื่อวา shatter แลวทําการ drag composition text  
ลงมาที่ timeline ตามเลข 2 
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9. ที่ composition shatter ใหคลิกขวา ที่ layer text ใส effect > simulation > shatter เพื่อที่จะทําการ
ระเบิดตัวอักษร 
  
 
 

 
  

10. จะเห็นวาที่ window effect control view จะมีการแสดงเปน wireframe+ forces ที่หนาตาง 
composite window จะเปนรปูตารางเพื่อใหการ แสดงผลเร็วข้ึน 
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11. กด space bar จะเห็นวามีการระเบิดขึ้นทีห่นาตาง composite window 
  

 
  

12. ลองเปลี่ยน effect control shatter view เปน render แลวกด space bar ก็จะเห็นการเปลี่ยนแปลง 
ดังรูปมีการระเบิดของตัวอกัษร 
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13. จะเห็นวาการระเบิดออกจะเปนรปู กอนอิฐ ซึ่งสามารถเปลี่ยนรูปรางของชิ้นสวนที่ระเบิดออกเปนไดหลาย
แบบโดยการเลือกที ่shape > pattern 
  
 
 

 
  

14. ที่ คา parameter force1 ก็หมายถึงสวนที่เปนวงกลมใน composite window คือ จะมีการระเบิดเฉพาะ
สวนที่อยูในวงกลมเทานั้น สามารถขยายรัศมีการระเบิดไดที ่force1 > radius ขนาดของวงกลมกจ็ะขยายตามไป 
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15. ที่ shatter composition ให drag gradient composition ลงมาไวใต layer text composition  
ตามเลข 1 จากนั้นเอาเครือ่งหมายรปูตาออกจาก layer gradient ตามเลข 2 เพื่อปดการแสดงผล layer นี้  
ที่ Gradient > gradient layer ใน effect control ใหเลือกเปน gradient ตามเลข 3 ลองกด space bar จะเห็น 
วายังไมมีการเปลี่ยนแปลงตอง set คา shatter threshold กอน ใหเลื่อน timeline ไปที่ 0 วินาที จากนั้นคลิกทีรู่ป
นาฬิกาจับเวลาตามเลข 4 set คา threshold เปน 0 แลวเลื่อนเวลาที่ timeline ไปที่ประมาณ 4 วินาที ปรับคา 
threshold เปน 100 จากนั้นลองกด space bar ดูจะเห็นวาจะคอยมีการระเบิด ตัวอักษรจากขางลางกอนแลวคอยๆ 
ขึ้นไปดานบน 
  

 
  

16. มี parameter ใหปรบัเลนกันอกีมาก เชน ที่คา Physics ของการระเบิด จะมีคา rotation speed  
เปนความเร็วของการหมุนของชิ้นสวน ที่ระเบิดออกมา คา gravity เปนคาแรงโนมถวงที่ทําใหวัตถุตกลงมาเร็ว หรือ 
ชา gravity direction เปนคาทีป่รบัใหวัตถุที่กระจายวิ่งไปทางไหนจะให ว่ิงขึ้นบนลงลาง หรอืไปทางขางบน 
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ขั้นตอนการปฏิบัติงาน  : ใหผูฝก ฝกปฏิบัติงานในหัวขอท่ี 1  
 

1. ฝกปฏิบัติการขั้นตอนการทํางาน กบั Effect ตางๆ 
1.1 ฝกปฏิบัติการทําตัวหนงัสือใหอยูในกรอบ 
1.2 ฝกปฏิบัติการทํา Effect ระเบิดตัวอักษร 
 
 
 
 
 
 

 
 
 
อุปกรณและเครื่องมือ:  1. เครื่อง Scanner  

2. เมาสปากกา    
3. คอมพิวเตอร 
4. โปรแกรม Adobe Effect 
 

 
 
 
 
 
วัสด ุ :                    
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1. ฝกปฏบิัตกิารขัน้ตอนการทํางาน กบั Effect ตางๆ 
1.1 ฝกปฏิบัติการทําตัวหนงัสือใหอยูในกรอบ 

 
ขั้นตอนการทําตัวหนังสือใหอยูในกรอบ 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. import file ที่มีนามสกลุ .avi เริ่มตน import file ที่มีนามสกลุ .avi เขา

มาใน Timeline และทํา Mask ดวย
เครื่องมือ Pen tool 

- 

2. วาดเครื่องมือ pen tool วาดเครื่องมอื pen tool ใหเปนรปูคลายๆ 
ในการเขียนบทสนทนาในหนังสือการตูน จะ
เห็นวาสวนที่ mask จะเปนสีดําคือ เปน
สวนที่จะมองทะลุได  

ในกรณีที่สวนทีเ่ปนรูปตามลูกศร
ไมเปนสีดําใหคลิก๊ขวาที่ขอบ ของ 
mask แลวเลือก inverse mask 

3. สราง layer ขึ้นมาใหม จากนั้นใหสราง layer ขึ้นมาใหม อีก
อันหนึ่ง New > solid เปนการ สราง 
Layer เปนสีทัง้ Layer 

- 

4. เลือกสี ของ Solid layer ใหเลอืกสี ของ Solid layer ที่ชอง color 
แลวกด OK  

- 

5. การสลับ Layer จะเห็นวา solid1Layer จะอยูดาน บน file 
ที่ import เขามาใหทําการสลบั Layer  
พอสลับแลวจะไดภาพดังรปู  สวนที่ทํา 
mask จะโปรงแสงจนสามารถมองทะลุไป
เจอ solid1  

- 

6. ใสขอความตามตองการ จากนั้นคลิกขวาที่ solid1 Layer เลือก 
effect > text >basic text ใสขอความ
ตามตองการ 

- 

7. ปรับขนาดของตัวอักษรใหขนาด
พอดกีับกรอบคําพูด 

กดสัญลักษณ solo เพื่อทําการดูเฉพาะ 
layer solid1 ทําการปรบัขนาดของ
ตัวอักษรใหขนาดพอดกีบักรอบคําพูด แลว
ยายที่มายังตําแหนงขางในกรอบคําพูด  

กอนยายตองคลกิ ที่ selection 
tool กอนถึงจะยายตัวอักษรได 

หมายเหตุ  :      
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1. ฝกปฏบิัตกิารขัน้ตอนการทํางาน กบั Effect ตางๆ 
1.2 ฝกปฏิบัติการทํา Effect ระเบิดตัวอักษร 

 
ขั้นตอนการทํา Effect ระเบิดตัวอักษร 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
1. สราง composition  
ตั้งชื่อวา gradient 

เริ่มจากสราง composition >new  
แลวตั้งชื่อวา gradient จากนั้นใหคลิกขวาที่ 
timeline เลือก New >solid ตั้งชื่อ solid 
layer ใหชื่อวา gradient  ขนาดเปน 
320*240 pixel 

- 

2. ใส effect ให composite 
window เปนในลักษณะ Gradient 

คลิกขวาที่ Gradient layer เปนการใส 
effect > render > ramp เพื่อทําให 
composite window เปนในลกัษณะ 
Gradient 

จะเห็นวาเมื่อใส effect ramp 
แลวจะมี effect controls ramp 
ขึ้นมา และหนาตาง composite 
จะมลีักษณะ เปนคอยๆ เขมขึ้น
จากลางขึ้นบน อันนี ้จะทําเพื่อ
เวลาระเบิดจะไดระเบิดจากสวนที่
จางกอนแลวคอยระเบิดสวนที่เขม
ตามลําดับ แตตองมีการ set คา
กอน 

3. สราง New composition สราง New composition ใหม ตั้งชื่อ
compositionเปน text จากนั้นมาสราง 
solid layer ที ่timeline โดยการคลิกขวา 
ตั้งชื่อวา text แลวคลิกขวาที่ layer text 
>effect > text >basic text 

- 

4. เขียนตัวอักษรที่ตองกา เขียนตัวอักษรที่ตองการ มาปรบั size ของ
ตัวอักษรใหขนาดเปน 70 

ปรับ size ของตัวอักษรใหขนาด
ใหญขึ้นเวลาระเบิดจะไดเห็นชัดๆ 

5. ทําการสราง composition ตั้งชื่อ
วา shatter 

ทําการสราง composition > new ใหมตั้ง
ชื่อวา shatter แลวทําการ drag 
composition text ลงมาที่ timeline 

- 

หมายเหตุ  :      
 
 



เอกสารประกอบการฝึก  หลักสูตรเทคโนโลยีชั้นสูง  สาขา การสร้างภาพเคลื่อนไหวแบบ 2 มิติ

267

267 
 

 

 

หลักสตูรการฝกยกระดับฝมือ 
สาขา การสรางภาพเคลื่อนไหวแบบ 2 มิติ  
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ใบขั้นตอนการปฏบิัติงาน 

หัวขอวิชา การจัดองคประกอบและ
รวมภาพ 
รหัสวิชา 0922124512 
งานที่ 6 

1. ฝกปฏบิัตกิารขัน้ตอนการทํางาน กบั Effect ตางๆ 
1.2 ฝกปฏิบัติการทํา Effect ระเบิดตัวอักษร 

 
ขั้นตอนการทํา Effect ระเบิดตัวอักษร 

ขั้นตอนการปฏิบัติงาน คําอธิบาย ขอควรระวัง 
6. ใส effect เพื่อทีจ่ะทําการระเบิด
ตัวอักษร 

ที่ composition shatter ใหคลิกขวา ที่ 
layer text ใส effect > simulation > 
shatter เพื่อทีจ่ะทําการระเบิดตัวอักษร 

- 

7. เลือก effect ที่จะทําการระเบิด
ตัวอักษร 

window effect control view จะมีการ
แสดงเปน wireframe+ forces ที่หนาตาง 
composite window จะเปนรปูตาราง
เพื่อใหการแสดงผลเร็วข้ึน กด space bar 
จะเห็นวามีการระเบิดขึ้นทีห่นาตาง 
composite window 

- 

8. การเปลี่ยน effect ที่จะทําการ
ระเบิดตัวอักษร 

เปลี่ยน effect control shatter view 
เปน render แลวกด space bar ก็จะเห็น
การเปลี่ยนแปลงการระเบิดของตัวอกัษร 

- 

หมายเหตุ  :      
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รหัสหลักสูตร 0920084210102 

ใบงาน 
 

หัวขอวิชา การจัดองคประกอบและ
รวมภาพ 
รหัสวิชา 0922124512 
งานที่ 6 

 
   วิทยากร/ครูฝกกําหนดใหผูรับการฝกไดฝกใส  Effect ระเบิดตัวอักษร  

 

 
 
 
 
 
ครุภัณฑ/เครื่องมือ/วัสด/ุอุปกรณ  
 

1. เครื่อง Scanner  
2. เมาสปากกา    
3. คอมพิวเตอร 
4. โปรแกรม Adobe Effect 
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